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Declaration of Conformity

Manufacturer’s Name: Fractal Audio Systems, LLC
Manufacturer's Address: 4 Wilder Drive, Plaistow, NH 03865 USA

Declares that the product:
Product name: FM3 Product option: None

Conforms to the following Product Specifications:

Safety: EN60065:2014
EMC: EN55013:2013
EN55020:2007+A11:2011
EN55024:2010
EN61000-3-2:2014
EN61000-3-3:2013

Supplementary Information:
The product herewith complies with the requirements of
the Low Voltage Directive 2006/95/EC
and the EMC Directive 2004/108/EC.

Clifford Chase
President / CEQ
June 22, 2018

EMC/EMI

This equipment has been tested and found to comply with the limits for a Class B Digital device, pursuant
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. There is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

4
4
4

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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Fractal Audio Systems FM3 Owner’s Manual. Contents Copyright © 2019. All Rights Reserved.
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mportant Safety Instructions

WARNING: To reduce the risk of fire or electric shock, do not expose this appliance to rain or
moisture.

CAUTION: To reduce the risk of fire or electric shock, do not remove screws. There are no user
serviceable parts inside. Refer servicing to qualified service personnel.

—_

Obey all warnings on the FM3 chassis and in this User Guide.

Keep away from sources of heat such as ducts, registers or appliances that produce heat.
Do not obstruct or cover over the side or bottom ventilation holes.

Connect only to a standard grounded AC outlet of 100-240V, 47-63 Hz.

Keep the power cord in good condition. Do not kink, bend, or pinch.

If the cord becomes damaged, discard and replace it.

If not using your FM3 for extended periods of time, disconnect from AC power.
Protect the unit from rain and excessive moisture.

Refer servicing to qualified personnel only.

Stop operation of the unit and obtain service if:

- Liquids or excessive moisture enter the unit.

- The unit operates incorrectly or performance is inconsistent or erratic.

- The unit has been dropped and/or the enclosure damaged.

10. Prolonged exposure to high volume levels can cause hearing damage and/or loss.
The use of hearing protection in high volume situations is recommended.

N
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A Manual for Online and Print Use

This manual is intended for use in desktop, tablet, and smart phone readers. It includes clickable links and bookmarks to make navigation
and cross-reference easy. We recommend against printing, because firmware updates tend to make older manual versions fall out of
date. That said, considerations have been taken for those who prefer paper. You are granted permission to print this PDF for personal use
only. A copy center or online printer can print and bind a book for you from the PDF file. Hopefully those with screen readers can forgive
the changes made herein to accommodate the print version: most links also include a page or section numbers, page spreads have extra
margins towards the binding edge, and blank pages have been included to preserve page and chapter flow.



1 INTRODUCTION

1 INTRODUCTION
WELCOME

Thank you for choosing the Fractal Audio Systems FM3, the ultimate all-in-one compact amp modeler, effects
processor, and foot controller for guitarists who demand the best. The FM3 takes some of the most advanced
technologies in our lineup and packs them into a “grab-and-go” format that's ruggedly built to withstand the rigors
of gigging and touring.

With the FM3, you get the same ultra-high-quality signal path and algorithms that you'll find in our flagship Axe-
Fx Ill, plus popular features like scenes, channels, modifiers, grid-based routing, “FC" footswitch layouts, USB
recording/re-amping/playback, setlist/song mode, and much more. The FM3 is even expandable via a FASLINK II
port that can support up to two FC controllers for up to 24 additional footswitches, giving you even more control
over your sound.

What truly sets the FM3 apart is its unique combination of sonic performance, flexibility, and fun. Whether you're
a guitar hero playing in front of thousands of fans or a weekend warrior jamming in your basement, the FM3
delivers the legendary Fractal Audio experience in a backpack-sized unit (with space to spare!). It's easy to use,
with a user-friendly interface and intuitive controls that let you quickly focus on music instead of manuals.

With the introduction of the FM3 Mark Il Turbo, the FM3 is now even more powerful and easy to use than ever.
Boasting a 10+% CPU power boost and larger, easier-to-read footswitch mini-displays, the FM3 Mark Il Turbo
allows you to create even more complex sounds and effects without sacrificing ease of use.

We thank you for choosing the FM3, and encourage you to keep making music.

Fractal Audio Systems
June 2023

|—



1 INTRODUCTION

FEATURE SUMMARY

= Powered by a 3-Core “Griffin" DSP with one ARM and
two SHARC+ cores, plus a GPU. It is the only product
of its kind to feature Fractal Audio’s legendary amp
modeling, cab sims, and stompbox and studio effects.

= FM3 Mark Il Turbo version has 10+% more DSP power than
the original, allowing larger and more intricate presets,
and also has larger, easier-to-read footswitch displays.

= Durable steel chassis with protective endcaps
designed to withstand the rigors of touring.

= Ultra-high-quality signal path for extremely
low THD and noise floor.

» Industry-leading “Cygnus X-2" amp modeling technology
developed for the Axe-Fx Ill reproduces the sound and
feel of real tube amps, with hundreds of models offering
an impressive range of clean tones, elusive “edge of
breakup”, and everything from warm, touch-sensitive
overdrive to face-melting modern distortion.

= Cabinet Simulator block loads up to two impulse
responses for extremely accurate response and dynamic
remixing including visual phase alignment. 2,048
factory cabs include every option from the Axe-Fx IlI
plus all 189 “Legacy” Cabs from the Axe-Fx II/AX8.

= 1,024 User Cab memory locations allow you to load
Cab Packs and other 3rd party IRs. Compatible
formats include, .ir, .syx, and .wav; Sixteen Scratchpad
memories are provided for experimentation.

= As a multi-effects unit, the FM3 includes a superb
selection of state-of-the-art “blocks” based on those from
Axe-Fx I, including 42+ drives, 50+ reverbs, 30+ delays,
compressors, EQs, filter, chorus, flanger, phaser, pitch
shift, rotary, tremolo, synth, wah and many more.

= Input and Output blocks provide incredibly flexible
routing, with setup diagrams included for FRFR, direct
FOH plus “live” power amp and guitar cabs, creating an
“FX Loop” for pedals, simultaneous electric and acoustic/
piezo, the popular “four cable method”, and more.

= 512 Preset memories can each store an entire rig
with its own amp, cab, effects, and much more.

= 12x4 layout grid, with “Zoom Out” option to show the
entire grid on one page, including VU meters!

= Eight nameable “Scenes” per preset eliminate “tap
dancing” and allow for quick sound changes - including
easy “spill-over” of effects like delay and reverb, plus
Scene MIDI messages for complete rig integration.

= “Channels” give each block up to four different sound

settings. One drive block, for example, can provide four totally

different drive pedal sounds with no extra CPU “cost.”

= Easy-to-read, precision full-screen tuner includes
a bar graph and virtual strobe display.

= 4x4 USB audio capabilities allow for recording,
playback, re-amping and more.

N

FM3 features our latest interface and navigation controls,
featuring the same custom color display as the flagship
Axe-Fx Ill, with five knobs with on-screen labels providing
instant access to both turn and push functions.

Dedicated hardware navigation controls for NAV, VALUE and
PAGE provide great ergonomics and efficiency, plus instant
familiarity to those coming from another Fractal Audio product.

Three onboard footswitches use our “FC” system for extreme
flexibility, with nine layouts containing 12 switch definitions
each. A new “Views" feature maximizes the utility of FC Layouts.

Each footswitch has its own LCD display to show the
function of the switch, plus a variable color LED ring
which shows the category and status of the switch.

Every switch can have its own fully-customizable tap and
hold functions. Change presets, banks, scenes, effects,
channels, operate the looper, tuner, tap tempo, and more.

Per-Preset Switches: any preset can cleanly and easily override
any footswitch in any layout, providing incredible flexibility.

Modular Control! Those who wish for more footswitches
can use FASLINK™ to connect one or two FC-6 or FC-12
controllers. These integrate seamlessly with onboard
switches and also offer additional switch/pedal jacks.

Two pedal jacks each allow connecting external switches
or expression pedals like the Fractal Audio EV-1 or EV-2.

Four top panel LED input meters plus two output “clip” LEDs
provide visibility of critical levels. Onscreen animations
show level for every block, input, output, and more.

Input 1 is ultra-low noise, with a 1/4” mono Instrument
input featuring “Secret Sauce IV” for optimized signal
from your guitar or bass. Output 1 is Stereo, with
Balanced XLR jacks, plus a stereo headphone out.

Input 2 is Stereo, with balanced 1/4" inputs.

Output 2 is Stereo, with 1/4” designed for “unity gain”
with the knob “wide open”, and featuring Humbuster™
technology to help combat noise from ground loops.

An independent SPDIF output can transmit a choice of signals.

MIDI IN and combination OUT/THRU ports, backed
by a rich MIDI implementation with extensive MIDI
transmit and remote-control possibilities.

“Client-Server” architecture allows multiple FC series
foot controllers and FM3-Edit to control the FM3 and
update each other seamlessly and instantly.

A connected computer allows the use of FM3-Edit, our
world-class editor for Mac and PC, and Fractal-Bot,
for firmware updates plus backup and restore.

FM3-Edit allows FM3 to load Axe-Fx Il presets, within
the limits of local block and CPU resources.

A built-in backup firmware ROM allows recovery
in the event of complications during an update
without the need for professional service.

The FM3 has upgradeable firmware allowing for
constant improvement and innovation.
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THE MAIN DISPLAY

When the FM3 is powered on, its main display shows a single preset with eight scenes.

Tabs across the top of the Home menu show PAGES that you can select from using the << Page >> buttons.

A mini-tuner in the top bar allows quick tuning without switching to the dedicated Tuner view. [

The ABCDE knobs have dedicated turn and push functions indicated at the bottom of the display.

Turn functions are shown in Blue and Push functions are shown in button-shaped boxes.

TURN PUSH
A | Changes the SCENE (p. 51) Shows the TUNER (p. 93)
B | Zooms home page TEXT (next page) Shows the preset LAYOUT menu (p. 42)
C Shows the CONTROLLERS menu (p._ 73 & Tempo p. 91)
D [ Changes the footswitch VIEW (p. 85) Shows the FC PER-PRESET footswitch functions (p._87)
E [ Changes the footswitch LAYOUT (p.77) | Shows the SETUP MENU ()
<« PAGE »
PRESETS FM3 Home Perform-PP Perform-GBL »
Turn VALUE

SCENES

Turn A

or NAV v [

Turn — ROEELERE
Push— TUNER

A

A nZl Xe 034: FAS Lead 1+2

Classic Ld 1
FXLd1
Octave Ld 1

Phase Ld 1
Classic Ld2
FX Ld2
Octave Ld 2
Phase Ld2

Zoom FC View (1] FC Layout (1)
LAYOUT CONTROLLERS | | FC PER-PRESET SETUP

B C D E

[ J%]



1 INTRODUCTION

HOME PAGE ZOOM VIEW

From the Home page of the Home menu, turn B to toggle the zoomed “Large Fonts” display.

This view is easier to read from a standing position. Most functions of this page are the same whether the
view is normal or zoomed, but changing presets and scenes works differently.

Turn the VALUE knob and then press ENTER to change the preset.
» Presets are shown in “preview” as dim text until you press ENTER.
= NOTE: While you are previewing presets, NAV left/right = -1/+1 preset; and Nav down/up =-10/+10.

Once any preset is loaded, use NAV keys to change scenes.

PRESETS

Turn VALUE Home  Perform-PP Perform-GBL »
and then

e 034 FAS Lead 1+2

bullets above)

Classic Ld 1 Classic Ld2
L FX Ld 1 FX Ld2
‘Nivb Octave Ld 1 Octave Ld 2

Phase Ld 1 Phase Ld2

(¥ Scene Zoom FCView (1]  FC Layout [1)
TUNER LAYOUT CONTROLLERS | | FC PER-PRESET SETUP

H>



1 INTRODUCTION

THE SETUP MENU

Throughout this manual, you will be directed to the SETUP menu of the FM3 for a range of options including
I/0, MIDI, global settings, and more. The SETUP menu includes the following areas:

» The FC Controllers/Onboard Switches menu includes all settings for the onboard switches or a
connected FC controller.

» The FC Setlists/Songs feature organizes a series of presets and scenes in specific order for a live use.
= The Global Settings menu includes options which govern the global behavior of the FM3.

= The /0 menu contains settings for all inputs and outputs, including levels, audio options, and
switches or expression pedals connected directly to the FM3.

= The MIDI/Remote menu contains MIDI settings, plus several pages of remote controller assignments
for the many remote-controlled functions of the FM3.

= The Utilities menu contains readouts, utilities, and a control to adjust screen brightness.

To access and use the SETUP menu:

»
»
»

Press HOME.

Push the “E" soft knob for the SETUP main menu.

Use the NAV buttons to select a sub-menu and press ENTER to make a selection.

Use PAGE and NAV buttons to get around. Use VALUE and knobs A-E to make changes.
You never need to store changes to the SETUP menu. All changes take effect immediately.

Press HOME at any time to return home.

Use these links for instant access to the SETUP menu topics in this manual:

SETUP
— FC Controllers/Onboard Switches p. 95
—— FC Setlists/Songs p. 98
—— Global Settings p. 99
— 1/0 p. 102
—— MIDI/Remote p. 105
L Utilities p. 109

lon



1 INTRODUCTION

QUICK CONNECT GUIDE

Perhaps the best and most flexible way to enjoy the FM3 is through a full-range system such as studio monitors,
a high-quality PA, or FRFR speakers designed specifically for guitar. All of the factory presets are designed for this
type of setup.

The FM3 is incredibly flexible, however, and many other types of setups are supported, including those which
integrate with tube amps, USB recording, 3rd-party outboard equipment, and more.

Find additional setup diagrams in Section 4. %‘:
Basic setup instructions appear below: -
o Begin with all level knobs turned down. L R @
Connect your guitar to the Instrument input OUT 1 [MAIN]

(In 1). See “Setting Levels” (next page).

The FM3 is also well-suited for
bass and other instruments.

i | ouT 1
0 Connect Output 1 to the LINE LEVEL IN 1 [NSTR] Use I I Add

input(s) of your mixer, studio monitors, Out1L Out1R
audio interface, PA system, full-range @ for
speakers, power amp inputs, etc. Mono

for
«  For amono rig, use Out 1 Left.

Stereo
- For optional stereo, connect Out 1 Right. @ @
« Use XLR-to-XLR cables or XLR-to-
TRS cables when connecting to \ /

balanced inputs. Use XLR-to-1/4"
(TS) cables for unbalanced inputs. [ @0%%%|) [ecce

' ‘.l .l ': ': ': l _

0 @

9 Slowly turn up the front panel OUT 1 knob and adjust
the level on your monitors as desired. FRFR speakers, Studio Monitors

Explore factory presets by turning the VALUE wheel. Audio Interface or Mixer

(then press Enter if you're using the Zoom view) ouT1

Select Scenes within a preset by using NAV Up/Down. The front Out 1 knob adjusts the
level of what you hear in this setup.

FRFR = "Full Range, Flat Response"

FRFR stands for “Full-Range, Flat Response,” used to describe a system which aims to reproduce the entire
audio spectrum without any tonal coloration. In comparison, most traditional guitar speakers have limited
range -- they cannot reproduce extended lows and highs -- and are not at all “flat” -- meaning some frequencies
are markedly louder or quieter. Full-range flat response studio monitors, high-quality PA speakers, and FRFR
speakers designed specifically for guitar should be able to reproduce anything you send to them. Of course,
even these vary, depending on which brand and model you choose.

oy



1 INTRODUCTION

SETTING LEVELS

Setting proper levels is critical, but easy, with abundant meters to inform you about levels on the FM3.

INPUT LEVELS

The FM3 comes ready-to-use for the typical guitar with passive pickups. To check levels,
connect a guitar to INPUT 1. Choose your loudest pickup setting and set all the guitar
controls to “wide open.” Play loud, open chords to push the levels as you watch the

IN 1 [INSTRUMENT] meter LEDs. It's OK to tickle the red LED once in a while, but if actual
clipping occurs, you must pad the input as follows:

» Open the SETUP: 1/0: Audio menu page.

» Navigate to the INPUT 1 PAD parameter. Turn the VALUE knob clockwise to increase this setting.
The possible values are 0dB, 6dB, 12dB, and 18dB. Be aware that as you increase this setting you
also increase the noise floor, so set it as close to 0 as possible for the best signal-to-noise ratio.

Input 2 can be adjusted with its own Input 2 Pad parameter on the same menu page.

Input Pad adjustments do not affect gain levels or what you hear. As you pad the input of the A/D

You can also monitor all levels on the Meters page of the Home menu (shown below).
0 converter, the output is boosted by the same amount. This eliminates clipping but ensures unity gain.

OUTPUT LEVELS

Output levels are easy to monitor by paging to the
Meters page of the Home menu. Should your output
levels be too high, the OUT 1 CLIP or OUT 2 CLIP LEDs
on the front panel will light. This is an indication of
imminent clipping, and unlike FM3 inputs, FM3 outputs
should NOT “tickle the red”. To lower output levels,
adjust the top panel knobs or adjust the

level of your presets. * DUT1CLP
(See Section 7: 7 Leveling Presets.) i DUTZ2CLIP

Output 1 is ready to be connected to consumer

line level inputs (-10 dbV). If you are connecting to =l
professional-grade equipment operating at +4dBu, set The Meters page of the Home menu shows all I/0 levels.
the nominal output levels as follows:

» Open SETUP: I/0: Audio

» Adjust Output 1: Output Level to +4dBu.

Learn more about the I/0 Menu on p. 102

Output 2 has both LINE LEVEL and UNITY gain settings.
» Open SETUP: 1/0: Audio to set

Output 2 Type to the desired mode.

» InLINE LEVEL mode, Out 2 has -10 and +4
settings as described above for Out 1.

» For UNITY GAIN operation, set the top The Layout menu also has a Meters view showing block levels.
panel OUT 2 knob fully clockwise.

i RYIRIR T

P50 %
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HUMBUSTER™ CABLES

For OUTPUT 1, use XLR-to-XLR or XLR-to-1/4" TRS cables when connecting to balanced inputs.
Use XLR-to-1/4" (TS) cables when connecting to unbalanced inputs.

For OUTPUT 2, standard 1/4" (guitar) cables may be used, but there is a better option. Humbuster™ cables can
significantly reduce unwanted hum due to ground loops. A Humbuster cable has one TRS end (like a balanced
cable) and one TS end (like a guitar cable). The TRS end connects to the FM3. The TS end connects to your amp
or other device. Do NOT connect TRS-to-TRS cables or TRS-to-XLR cables to Output 2.

Humbuster cables are available from http:/www.fractalaudio.com/cables. You can make your own by following
the diagram below. Be sure to use high-quality connectors and shielded cable.

TIP  SLEEVE TR T SLEEVE TIP

I
RING S S

MONO VS. STEREO

Ve The FM3 comes pre-configured for stereo but you can connect it in mono with no issues. If you
9 are NOT running in stereo, you may find that certain presets or settings produce unexpected
"%  results. For example, a panner sounds like a tremolo when one channel is missing. A ping-pong

“../ delay may ping but never pong. Stereo enhancers or certain types of modulation may not be
apparent at all. Tone may change completely if amps or cabs have been hard panned. Here is
an overview of several scenarios, with recommended settings for each.

A

» Stereo: No special settings required.

» Half-Stereo: Leaving the FM3 in its default stereo configuration but connecting only
one (Left) output results in a “half-stereo” setup. This works fine, aside from the
exceptions mentioned above (ping-pong, panning, etc). No special settings required.

» Dual Mono: If you want to force your rig to mono, dual mono is a good choice. Sonically, this
is identical to half-stereo, with the same limitations, except that mono signal is produced
at both the left and right jacks so you can connect to two monitors. To switch to dual
mono, open SETUP: I/0: Audio and set Mode for the desired output to “COPY L->R".

» Summed Mono: In this setup, left and right channels are added together resulting in an identical
mono signal at both left and right outputs. This has the advantage of not discarding half of
the sound, but summing has its own issues. For example, short delays or phase differences
between channels can result in strange artifacts or even cancellation. To switch to summed
mono, open SETUP: I/0: Audio and set Mode for the desired output to “SUM L+R".

On the FM3, a flexible block-based 1/0 system makes it easy to use different outputs with different
settings. See the “The Fractal Audio Blocks Guide” for more on Input and Output Blocks.

All options of the SETUP: 1/0 menu are detailed in “The /0 Menu" on p. 102.

8
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PRESETS

Once you have connected your FM3 you can begin to audition the factory preset sounds. Remember that aside
from a few templates, the factory presets are designed for use with full-range speakers/studio monitors, or
headphones. (See Section 4 for details on various other types of setups.)

The FM3 contains 512 preset memory locations. Each preset is like a fully independent rig with its own amp, cab,
effects, settings, controllers, and more. When you consider everything that is possible with Scenes and Channels,
a single preset can cover an entire song, or even a whole show.

Changing presets is covered on p. 3. Here’s a review:

In the normal (non Zoom) home view mode, turn VALUE or use NAV left and right. Use NAV up down to select
Scenes.

In the Zoom view mode, turn value to enter Preset Preview Mode. Use VALUE or NAV Keys to pre-select the
desired preset and then press ENTER to load the preset and return to normal preset mode, in which NAV Keys
select Scenes.

UPDATING PRESETS VS. UPDATING FIRMWARE

The FM3 has upgradeable firmware, allowing it to receive new features and capabilities over time. From time to
time, new firmware updates can add new amp types. When this happens, the new amps will not automatically
appear as new factory presets. (With over 300 amp types available, not every type even has a dedicated preset or
scene!) However, auditioning new amps is easy. Simply open an existing preset that is close in sound to the new
amp you want to try. For example, if there’s a new “Plexi” type, open a Plexi preset. If the new amp is modern and
high-gain, open a modern high-gain preset that you like. Then, change the amp type to the new one and dial it in
as desired. (Editing presets is covered in more detail in Chapter 4).

It's also worth noting that sometimes, after significant firmware changes, the FM3 factory presets may be updated
by Fractal Audio and made available for download. New presets are not part of a firmware update and must be
installed separately. This is not an automatic process, but it is very easy. Download the updated presets from the
FM3 downloads page of our web site and use Fractal-Bot to send them to your device.

NOTE: Fractal-Bot will warn you, but be aware that installing updated preset banks overwrite presets in your FM3.
Therefore, it's important to back up any personal creations or edits before updating the factory presets to newer
versions.
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1 INTRODUCTION

FOOTSWITCH LAYOUTS

The foot switching features of the FM3 are based on those of our popular FC controllers. The central concept is
the footswitch Layout. A layout is a set of 12 footswitch definitions. You can change the layout to load a different
sets of definitions, thus changing what the footswitches do.

The FM3 provides eight layouts in total, plus one special “Master” layout (covered below). Layouts have both
numbers and names to make them easier to manage. All layouts and switches can be completely customized.

There are multiple ways to change the layout on the FM3. One way is to turn knob E from the Home page of the
Home menu. You wouldn't be able to do this easily while playing, however, so we created the Master Layout Menu
which allows you to change layouts with your feet.

THE MASTER LAYOUT MENU

Here’s how to use the Master Layout Menu (“MLM”").
This section assumes that your FM3 has the default factory footswitch layouts loaded.

o Press and hold footswitch 2 in any normal layout
to enter the Master Layout Menu (“"MLM").

0 TAP any footswitch of the MLM to select a new

O e 0O layout and exit the MLM.
PRESS
L (aw’) - o
HOLD € While you're in the MLM, hold the left or right switches to step through
three different “views” — each with its own menu choices shown below.
The default factory layouts are detailed on p. 78

LAYOUT 1: LAYOUT 3: LAYOUT 4: LAYOUT 6: LAYOUT 7: N
PRESETS EFFECTS CHANNELS PER-PRESET| | PERFORM

LAYOUT 5:
LOOPER

LAYOUT 8:
UTILITIES

/ PRESS PRESS
AND AND
HOLD - HOLD

MLM 1

Learn more in Section 10: Layouts & Switches




1 INTRODUCTION

FOOTSWITCHES

The FM3 has three built-in footswitches, each with its own mini-display and vari-color LED ring. Footswitches
can be used to change presets, select scenes, toggle effects, and much more. This page introduces the basic
concepts of footswitches. Section 10: Layouts & Switches covers this subject in more detail.

SWITCHING PRESETS

Let's begin with how to explore the factory presets using the footswitches.

When the FM3 starts up, it automatically loads the PRESETS footswitch layout. In this layout, each of the three
footswitches loads a preset. Preset names appear in the mini-displays. The current preset will have a bright ring
and the others will be dim.

A “bank” is a group of three presets. To change to the next bank of three presets, press and hold the right
footswitch. To change to the previous bank, press and hold the left footswitch.

The FM3 boots up to the “PRESETS" footswitch layout.
In this layout, three footswitches select three different presets.

Deluxe Verb| | Plexi 50w FAS Modern

Press and hold the left switch Press and hold the right switch
to show the previous bank of three presets. to show the next bank of three presets.

You can use the MANAGE PRESETS feature of FM3-Edit to drag and drop presets of the FM3 into any order
you wish. Put your favorites in groups of three so you'll have what you need without a lot of bank changes!

FOOTSWITCH FUNCTIONS

The FM3 contains 8+1 distinct layouts, with each footswitch in every layout having independent Tap and Hold

nou

functions. FC functions are organized into categories such as “Presets,” “Scenes,” or “Effects.”
Learn more in Section 10: Layouts & Switches.

LED RING COLORS

Footswitch functions are grouped into categories, each with its own default LED ring color. You can modify the
default colors on the Ring Colors page, which is located under the FC Controllers/Onboard Switches menu in the
SETUP section. Additionally, you can change the color of individual switches. See “Edit a Switch” on p. 86.

MINI DISPLAYS

As the switch is pressed down, even for a brief “tap” action, the label temporarily switches to display the Hold
function. Once the switch is released, the label reverts back to showing the Tap function.

See “The Footswitch Functions Guide” for more information on setting up or changing the labels for any switch.
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1 INTRODUCTION

EXPRESSION PEDALS

This section is for pedals connected to the local “Pedal” jacks of the FM3.
For pedals connected to an FC Series controller, see your FC Owner’s Manual.

Each of the two Pedal jacks of the FM3 support one expression pedal (or 1 to 2 switches).

EXPRESION
PEDAL

TRS

TRS Cable

TRS

PEDAL JACK

uuuuuuuuuuuuuuuuuuuuu

oooo

FM3 | O -

oooo

FAQ:

TIP SLEEVE

TO CONNECT & CALIBRATE AN EXPRESSION PEDAL...

Expression pedals should have a linear resistance taper and must have a maximum
resistance in the range of 10-100kQ. Expression pedals must be used with Tip-Ring-
Sleeve (TRS) cables.

Connect your expression pedal to one of the FM3 Pedal jacks with a TRS cable, then
follow these instructions:

1. From the Home page, open SETUP: 1/0: Pedal.

2. For pedal jack 1, set Pedal 1 Setup to “PEDAL 1 (EXP/SW TIP)"
(or use Pedal 2 Setup if that's the jack you're connecting to)

3. Navigate down to the Calibrate function for your pedal and press the ENTER.
4. Follow the on-screen instructions to perform calibration. Press HOME to finish.

= Be sure to see the next page for instructions on assigning your new pedal.
= |f something doesn’t work, check a different pedal or cable!

FRACTAL AUDIO EV PEDALS

The Fractal Audio Systems EV series of
expression pedals are perfect for use with all
Fractal Audio Systems products. The EV-1 is

a full-sized expression pedal. The EV-2 is a
compact version. These pedals feature rugged
cast metal casings, a high quality 100kQ
potentiometer, and built-in analog volume
pedal capability.

Learn more at https:/www.fractalaudio.com

WHAT IS TRS? “TRS" is an abbreviation for TIP-RING-SLEEVE and describes
the configuration of a 1/4" end plug or jack with three connectors. Standard guitar
cables are “TS” (Tip-Sleeve) as they don’t have the ring needed for a third contact.
Expression pedals necessitate TRS cables because the full control voltage is sent

| | through one contact (the tip), while a lower voltage is returned through another (the
CJ]:. ring), enabling the host device to detect and utilize the pedal’s position. The third

RING

contact (sleeve) is connected to the ground.

12
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1 INTRODUCTION

GLOBAL EXPRESSION SETUP

FM3 Pedal Jack 1 can be assigned as the “External 1 Controller” for use with factory presets as a Wah, etc.
Follow the instructions below.

1. From the Home page, open SETUP: MIDI/Remote and change to the External page.

2. NAV down to External Control 1.

3. Turn the A or VALUE knob to select PEDAL 1 (EXP/SW TIP)

4. Press EXIT when finished.
You can test the pedal using Factory presets in the range 000-064.

External 1 can also easily be assigned as Volume, Whammy, or almost anything else on a per-preset basis.
Learn more about assigning pedals and switches to sound parameters in Section 9: Modifiers.

GLOBAL VOLUME SETUP

The FM3 allows global remote control of the volume at any input or output via a pedal or MIDI CC of your choice.
To set up a pedal for global volume, follow the instructions below. Be careful that you don't accidentally assign
the same pedal to both Volume and an External Controller as described above!

First you'll need to decide which global volume option you prefer:
* Input volume affects gain/distortion and the behavior of level-dependent blocks like the compressor or gate.

=  Qutput volume does not affect gain or level-dependent blocks, but
scales everything you hear including effect tails.

To set Global Volume:
1. From the Home page, open SETUP: MIDI/Remote: Other.
2. NAV to the entry for whichever volume you want to control: Input 1 or 2, or Output 1 or 2.
3. Turn the A or VALUE knob to assign a controller to your selected entry.

= Select “PEDAL 1 (EXP/SW TIP)” for the onboard Pedal jack (or #2 if you are using that one)
4. Test and EXIT when finished.

Learn more about the MIDI/Remote menu options on p. 105



1 INTRODUCTION

EXTERNAL SWITCHES

This section is for switches connected to the local “Pedal” jacks of the FM3.
For switches connected to an FC Series controller, see your FC Owner's Manual.

Each of the two Pedal jacks of the FM3 can support one or two switches instead of one expression pedal. This
requires a simple setting change. Any make-break switch type may be used with the FM3 in this way. Connect
switches in any of the ways illustrated below:

SINGLE SWITCH SWITCH SWITCH “DUAL’
(TIP) (TIP) (RING) SWITCH
(o] [o_e]
TS TS TRS
2
£
S =
[~}
S 2 o
= = n
3 o =
@
2
TS TRS TRS
PEDAL JACK PEDAL JACK PEDAL JACK
i n . Some "Dual”
i opeo Do0o switches work
sfwg?io’g%e FM3 DOD DDDS DOD DEDDD over a single
‘tj”;:%i‘z;" 00000 8 ¢ i 00000 ¢ ¢ TRS cable.
— — —/ — —
EXTERNAL SWITCH SETTINGS SWITCH ASSIGNMENT
External switches require a simple setup: Since each jack supports TWO
» Page to the Pedal page of the 1/0 menu under SETUP. d|ffgrent SW'tCh.eS’ you ”. find multlple
options for assignment in the modifier
» Set Pedal 1 Setup to “ONE SWITCH" or “TWO SWITCHES" source menu and the various MIDI/
depending on what you have connected Remote menu pages.

(or use Pedal 2 Setup if that's the jack you're connecting to).

» Next, navigate down to the SWITCH SETTINGS section
and select the TYPE and POLARITY for each of your

Pedal 1 (EXP/SW TIP) is switch 1 tip.
Pedal 1 (SW RING) is switch 1 ring.

switches. See p. 104 for more on this setting. Pedal 2 (EXP/SW TIP) is switch 2 tip.
» Press HOME to finish. Pedal 2 (SW RING) is switch 2 ring.

Even more powerful, however, is the STAND IN SWITCH feature, which allows them to perform the same

@ External Switches can be used with many per-preset and global options found in the MIDI/REMOTE MENU.
functions as the onboard switches.
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1 INTRODUCTION

USB AUDIO

USB provides the FM3 with a host of great audio features. With 4x4 channels, you can play backing tracks, record
processed audio or DI signals, re-amp in real-time, and more.

See Section 3: USB for full details on the USB capabilities of the FM3.

FRACTAL-BOT & FM3-EDIT

In addition to providing audio capabilities, USB allows you to use our
companion software applications Fractal-Bot and FM3-Edit.

Fractal-Bot is a small, simple program used to update the FM3 when new
firmware is released. It includes tools to backup or restore presets and other
custom settings and can be used to install downloaded presets or cabs.

FM3-Edit is a full-featured software editor/librarian for the FM3. If you are

comfortable with audio software or plug-ins, you will probably enjoy using

this program. FM3-Edit offers great ease of use and convenience, plus some “power-user” routines that aren't
possible on the unit itself (e.g. Performance Page editor, Block Library, Scene Swap). It also provides great tools
for managing presets and banks, installing Cab Packs, and more.

You can download FM3-Edit for Mac or Windows at https:/www.fractalaudio.com/fm3-edit

FJYEY=s")
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1 INTRODUCTION

INTRO TO THE LAYOUT GRID

The Grid is the heart of every preset in the FM3, providing a versatile matrix of rows and columns with endless
possibilities. In contrast to traditional gear setups, where you are limited by budget, space, weight, and equipment
capabilities, the FM3 however, provides a vast and ever-expanding virtual inventory of amps, cabs, effects, and
more. This allows you to create a unique rig within each preset, tailored to your preferences.

To create a preset, you will select virtual gear pieces called “blocks” from the inventory and place them into the
layout grid. Each block represents a different component such as a wah pedal, amp, or reverb unit. Blocks are
connected together using virtual cables. You can split, merge, or create parallel paths as needed. Passive shunts
act like cables, carrying signal through empty grid spaces. Special input and output blocks connect to the various
jacks and USB signals of the FM3. Here is an illustrated overview of the concept:

(=]

]

3
L

Y Passed
from | N1 WAH } AMP CAB out1| toout1 :
INSTR Jacks

O ] ]

:' ............................................ The Layout Grid ............................................

Let's review what's happening above. Signal flow begins at the Input 1 block on the left. It is connected by a cable
to the Wah block, which in turn connects to a shunt. The shunt has no effect on the sound and is shown only to
introduce the idea of how it can be used to carry signal from one block to another. The shunt is connected to

an Amp block (we might set its type to “Plexi T00W High"), which in turn feeds a Cab (one of the many “4x12"
options, perhaps). This is connected to a Reverb and then to an Output block. In this limited example, many grid
spaces are empty, and only some of the columns are shown. In reality, the size of a preset is limited only by the
grid structure, block inventory, and total processing power (“CPU"). The FM3 can create presets large enough to
cover a song, a set, or even an entire show.

@ The layout “Z0O0M” feature shows the whole grid at once. Look for the ZOOM button on Layout menu pages.
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1 INTRODUCTION

INTRO TO SCENES AND CHANNELS

Imagine a professional rackmount system rig like the ones used by guitar heroes for decades. In such arig, the
various components — pedals, guitar amp, rack units — are usually connected to a central switching unit so they
can be switched in groups without “tap dancing.” Some components may also have settings that the switcher can
change, like the channel of an amp, or the MIDI program of a delay unit. As described on the previous page, an
FM3 preset is like a rig: it consists of “blocks” (amp, cab, effects) all connected together in a certain way.

In the traditional rig, you can set up and save different combinations and channels: Clean, Rhythm, Lead, etc.
Scenes on the FM3 allow you to easily create these saved combinations within a preset. Scenes don't rewire
the rig or change what gear it contains. Instead, they switch blocks on or off, and set which “Channel” each
component is set to. Each preset contains eight scenes and like presets, FM3 Scenes also have their own names.

Scenes can also offer an advantage over presets in terms of sound changes. When you change scenes, the FM3
doesn’t need to reload the entire “rig.” Instead, it just sets the blocks and channels as needed for the new scene.
This is not only faster, but also allows easy “spillover” of delay and reverb tails.

Channels on the FM3 make blocks extremely flexible. Each channel contains a fully independent set of
parameters for the entire block. For example, Channel A of a Drive block might be a clean boost, B could be an
overdrive, C could be a distortion, and D could be a Fuzz. That's four completely different drive sounds from just
block. This can be used to conserve CPU power when compared to single-use blocks used one at a time.

SCENES AND CHANNELS: A VISUAL EXAMPLE

[ IN1 cMp|i—{DRV [{—AMP[i—{cAB [s—{cHo ;LY [;—ouT 1]

Here is our preset. The Input 1 block feeds a Compressor, which is connected to a Drive, then an Amp and Cab,
then Chorus, Delay, and finally the Output 1 block.

[ IN1 —{eMP[i— v —{aMP[i—{cAB [{—{cHoli—

SCENE 1 - “Clean”: For scene 1, the Drive and Delay blocks are bypassed. We dial in the Compressor, Amp,
Cab, and Chorus for a classic clean tone. Notice that the amp says “1A”. This means we are using Amp 1, set
to channel A. Let's imagine it as the “ODS-100 Clean” model. We name this scene “Clean”.

—{DRV [{H—AMP[E—{cAB [J—0| — 0UT1

SCENE 2 - “Crunch”: To create scene 2, we bypass the Compressor, Chorus, and Delay and engage the Drive.
The Channel of the Amp block is changed from “A” to “B”, which we dial in as a “Euro Blue” model. Remember,
each channel has a totally independent set of settings, so we can dial in every amp parameter exactly as we
want it: Drive, Treble, Mid, Bass, Master, and many more. We then dial in Channel “A” on the drive block with a
good “screamer” sound by selecting the “TS808 OD" type. Let’s name this scene “Crunch”.

[ IN1 —cMpPE—{pRrv[i—AMP[E—{cAB i —{oy |i—out 1]

SCENE 3 - “Lead”: Here's our soaring lead. The Chorus is bypassed. We've changed the compressor to
Channel “B” and dialed it in for sustain. The amp is the same as the “Crunch” scene but the Drive changes to
“B”, which we'll make a “Ruckus LED". The Delay is on channel “B” set for ping-pong echoes with higher mix
and feedback. We name this scene “Lead".

Learn more about these topics in Section 5: Presets and Section 6: Scenes & Channels.
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1 INTRODUCTION

GRID EDITING: QUICK START

Learn more about the layout grid in Section 5. Meanwhile, here’s a very quick primer:
» From the Home page, press LAYOUT (knob B) or ENTER to show the

grid (that is, the “Edit” page of the Layout menu).
» Use the NAV buttons to move the cursor around the grid.

» To change any block, turn the VALUE knob to cycle through the list of available blocks.
When you find the block you want, press ENTER to confirm, or press EXIT to cancel changes.

» On the grid, “push” functions of the B, C, and D knobs allow you to Delete a block (leaving a hole), toggle a
block’s Bypass state, or create/remove a connector Cable between any two blocks in adjacent columns.

» To save any preset changes, press STORE, ENTER, ENTER.

BLOCK EDITING: QUICK START

Learn more about editing blocks in Section 5: Presets. Meanwhile, here’s a very quick primer:

» Open the layout grid (see above), select the desired block, and press EDIT to open its menu.
» Use the PAGE buttons to navigate block edit menu pages.

» Many blocks have a TYPE page, which allows you to dial in multiple settings with one knob.
Examples include setting an Amp to “USA Lead+" vs. “Tweed 5F1", or a Reverb to “Cavern” or “Large Spring”.

» UsetheA,B,C,D,and E knobs to edit on-screen parameters. From
any block’s Edit menu, press EXIT to return to the grid.

» To save any changes, press STORE, ENTER, ENTER.
» The stylized diagram below shows a typical edit menu page with annotations:

Block Name and Number Menu Pages (Tabs)  1/0 Meters
. Block Type  Current Scene/Channel Global Block Tuner :
Drive1 : : Expert : Mix All
Current 7808 0D Scene:1 ' Channel: A GIbENONE C=——1 ==
Parameter
Value BOX oooveeeefere < ......................... 5.00 >
Current
Parameter --------f-oeeeeen @ @ @ @ A ye”OW dot
Highlighted : S S shows Modifier
Drive Tone Mix Level capability
Inactive Row
isdimmed [
(NAV Up/Down
to change rows)
Push Functions -....+(" CHANNEL- ) (_ CHANNEL+ ) (_ BYPASS ) (_ RESET ) (_ MODIFIER )
(A—E) : : ; ; :
Chanzge the Toggle the block  Reset the Add a Modifier
block’s Channel between Bypassed entire block  to the selected
1 or+1 and Engaged. to defaults parameter
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1 INTRODUCTION

THE FRACTAL AUDIO BLOCKS GUIDE

The FM3 is derived from our top-of-the-line rackmount processor, the highly acclaimed Axe-Fx lll. Both the

FM3 and the Axe-Fx IlI, as well as our larger and more powerful floor unit, the FM9, utilize presets created

from blocks, with many shared parameters and settings among the three devices. A comprehensive manual is
available to cover these blocks in depth. This manual serves not only as a reference but also provides background
information, tips, and additional resources to help you make the most of your Axe-Fx lll, FM3, or FM9.

The Fractal Audio Blocks Guide can be downloaded from https://www.fractalaudio.com/fas-bg

ﬁHAETaL
AU BEYBTEMSME

BLOCKS GUIDE

Comokete Beference for
Blocks and Parameters
Axe-Fx |

FM3

FM3

el 4 PPl W20

AXE-FXII GIME) G
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1 INTRODUCTION

THE FOOTSWITCH FUNCTIONS GUIDE

Section 10: Layouts & Switches covers the basics of using footswitches on the FM3, but there’s more to
explore.

In brief, FM3 footswitches can perform one action when you TAP them and another action when you press and
HOLD them. These actions are called functions. the list of available functions is shared between the FM3, FM9,
FC-12, FC-6. Because these functions are shared across multiple devices, they are detailed in a separate manual.
the Fractal Audio Footswitch Functions Guide.

Find this guide at https://www.fractalaudio.com/fas-ffg

ﬁ RACTAL
AUDIO BYSTEMB

FOOTSWITCH
FUNCTIONS o
GUIDE

® &

o Bl PR, PR3 FC-12, R FC:

s Gl 2
TismeDm k- i i @ "\'@ @
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https://www.fractalaudio.com/fas-ffg

2 HARDWARE OVERVIEW

2 HARDWARE OVERVIEW

THE TOP PANEL

© oo ©000
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HOME EDIT
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0 Chassis — The FM3 features a robust steel chassis with protective end caps for added durability. Equipped
with two high-strength handles, the unit is easy to handle and transport.

0 Color Display — A large custom-made 800x480 color display is optimized for readability even in difficult
conditions, with greater brightness and contrast than “off-the-shelf” displays.

0 Output Level Knobs 1 & 2 — These knobs independently adjust the volume levels for the corresponding rear
panel output jacks. Note that Output 2 offers two “Type” settings: the default “UNITY GAIN" and optional
“LINE LEVEL" setting. (In UNITY GAIN mode, unity gain is achieved by turning the knob fully clockwise.)

0 A, B, C, D, and E knobs — Five versatile rotary push-knobs perform different functions based on the page
shown in the main display. Turn functions are typically shown in blue, while push functions appear in boxes like
buttons. Vertical menu pages display on-screen labels (A through E) for easy operation.

o HOME Button — This button shows the Home menu—a convenient starting point for loading or editing
presets, accessing the tuner, controllers, metering, global setup options, performance pages, and more.
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2 HARDWARE OVERVIEW

0 EDIT Button — This button opens the Edit menu for blocks on the Layout grid. Tap consecutively to cycle
through all blocks in the current preset (top-to-bottom, left-to-right), or double-tap to cycle in the opposite
direction. See “Presets” on p. 41 for more on editing presets.

o STORE Button — Enters the Store menu where you can save presets and enter names for presets or scenes.
See “Saving Changes” on p. 49.

TEMPO Button — Tap this button once to show the Tempo page of the Controllers menu, or tap 2+ times to
set a new tempo. After setting the tempo, press EXIT to go back to back to wherever you were. Learn more in
Section 11: Tempo. Press and hold the Tempo button as a shortcut to access the tuner.

VALUE Knob — The VALUE knob performs different functions on different menu pages. In the Home menu,
it selects presets. In Layout (grid) pages, it is used to add or modify blocks on the grid. In Edit menus, it
changes parameter values, selects from lists, and more.

@ NAV Buttons — The four NAV buttons serve different functions depending on the menu page, typically
selecting between various on-screen parameters, areas, and options and moving the “focus” of the VALUE
knob, as indicated by a highlight. They also perform additional tasks as needed.

m ENTER and EXIT Buttons — The ENTER button executes commands, commits changes, accesses sub-menus,
and more. EXIT works for cancel, escape, and various other functions.

@ PAGE LEFT and PAGE RIGHT — These step through menu pages, shown as “tabs” at the top of the display.

Meter Bridge — LED meters show the levels at inputs 1, 2L and 2R. The red LED indicates -6dB. As directed in
the Introduction (p. 7) a Pad setting is provided for adjustment if needed.
TIP: You can also find on-screen meters on the Meters pages of the Home menu and the Layout.

@ Status LEDs — Five LEDs indicate important information. Tempo flashes to show the current Tempo. The
Edited lights whenever the current preset has been altered but not saved. MIDI In lights while MIDI data is
being received. OUT 1 CLIP and OUT 2 CLIP light to show that your preset levels are too high.

See “Preventing Output Clipping” on p. 65 if this happens.

@ Footswitches — The switches of the FM3 use our proprietary Solid State Switching (SSS™) technology,
featuring extremely smooth, quiet, action, and no mechanical contacts to fail. Each footswitch can be
assigned your choice of one “Tap” and/or one press-and-hold (“Hold”) function. These can be different on
every “Layout,” and there are eight different layouts, plus one special layout called the “Master Layout Menu.”
The basics of footswitch use are covered in the Introduction on p. 11, and detailed fully in Section 10.

Three Footswitches.. Plus 6, or 12, or More!

The FM3 has three onboard switches, making it the perfect compact all-in-one way to enjoy Fractal Audio’s
legendary amp models, speaker cab simulation, and effects. If you need additional footswitches, however,
you can also connect up to two FC controllers, each with six or twelve additional switches with all of the same
fully-integrated capabilities as the onboard switches. External FCs also allow you to add more expression
pedals or switch controllers.

If you just need a few extra switches, each of the onboard PEDAL jacks of the FM3 can be used for one or two
external switches instead of an expression pedal if you choose, as shown on p. 14
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2 HARDWARE OVERVIEW

THE REAR PANEL
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Input 1 [Instrument] (mono) — (1) 1/4" Jack (unbalanced) — Connect your instrument to this jack, intended
specifically for use with electric/acoustic/bass guitars, and other similar instruments. The FM3 uses our
proprietary “Secret Sauce IV” circuitry from our Axe-Fx products.

Output 1 L+R (stereo) — (2) XLR-Male (balanced) — Use the XLR jacks to connect to the balanced inputs of
FRFR speakers, mixers, studio monitors, etc. Use the ground lift switch if necessary to reduce 60-cycle hum.

TIP: Balanced audio connections are resistant to noise and interference. Use cables balanced at both
ends when connecting to the balanced inputs of other devices (whether XLR or TRS). When connecting to
unbalanced 1/4" inputs, use cables with an XLR-F on one end and an unbalanced 1/4" TS on the other.

@ Headphones Output — 1/4" Stereo Jack — Connect headphones here to monitor the signal at Out 1.

Input 2/FX Return L+R — (2) 1/4" Jacks (balanced) — Connect balanced or unbalanced line level signals
here. Input 2 can be used as an FX Return when inserting outboard gear, or as an auxiliary input for use with
stereo line level sources such as mixers, synthesizers, backing track players, and more.

TIP: Balanced audio connections are resistant to noise and interference. Use cables balanced at both

ends when connecting to the balanced outputs of other devices (whether XLR or TRS). When connecting to
unbalanced 1/4" outputs, use regular patch cables.

@ Output 2 L+R - (Stereo) — (2) 1/4" Jacks (Humbuster™) — Use these 1/4" unbalanced outputs with standard
guitar cables to connect to the inputs of other devices. Optional Humbuster™ technology can significantly
reduce hum from ground loops. This requires special cables; learn more on p. 8.

Do not use TRS-to-TRS cables, even when connecting to balanced devices.
By default, Output 2 is set for “UNITY GAIN", allowing applications such as the popular “Four-Cable Method”

and other scenarios. Set the OUT 2 Level knob fully clockwise for unity gain.

= Qutput 2 also offers an optional setting for “LINE LEVEL", used when you connect to devices such as studio
monitors, FRFR speakers, etc. Refer to specific setups in Section 4 for details.

» Qutput 2 can also be set to replicate the signal from Out 1 or In 1 without the need to modify your presets.
» Find additional details about these and other options in “The [/0 Menu"” on p. 102
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Pedal Inputs — (2) 1/4" TRS Jack — These are used to connect external expression pedals or switches to
control various functions of the FM3. See “Expression Pedals” on p. 12 and “External Switches” on p. 14.

FASLINK Il Connector — This allows you to connect the FM3 to one or two FC-6 or FC-12 foot controllers.
FASLINK™ uses a standard XLR cable for 2-way communication and also powers the first FC without an
external “wall wart” adapter. (See your FC Owner’s Manual for more on daisy chaining and other options.)

NOTE: The FASLINK Il port on the FM3 is designed for our FC Series of foot controllers and is NOT compatible
with the FASLINK port on our MFC-101 MIDI foot controller. Connecting an FM3 to an MFC-101 via FASLINK
should not cause any damage, but it will not work.

USB — The FM3 is equipped with 4x4 USB audio capabilities when connected to a compatible Mac or PC,
allowing its use with a DAW or other audio applications. However, the FM3 is not a USB MIDI device. It utilizes
“COMM over USB" channels for Fractal-Bot and FM3-Edit, but it will not appear as a MIDI device in a DAW or
other MIDI programs. For more information about the USB features of the FM3, refer to See Section 3: USB.

- The FM3 has two USB ports. The USB type “A” is not used.
Use the USB type B port for connecting to a computer.

—USB——

MIDI Ports — The MIDI IN port of the FM3 allows you to control various MIDI functions including preset and
scene selection, effect bypass, channel changes, parameter changes, and more. The MIDI out port offers
various features and functions. See “Sending and Receiving MIDI” on p. 134 for more information.

@ SPDIF Out — Digital Output — This transmits a digital output signal at a fixed rate of 48k. The SPDIF out can

transmit your choice of signals as per the setting of the SPDIF Out Source parameter.
See “The I/0 Menu” on p. 102 for more on the relevant parameters.

Power Switch — This turns the power on or off. The FM3 features pop suppression, but it is still advisable to
turn down or mute connected devices when powering on or off.

AC Power Receptacle — Insert the supplied power cable and connect the other end to a grounded AC power
receptacle. The FM3 features a universal power supply, allowing for worldwide use without requiring a
transformer when used with the appropriate power cable for the local region.
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3 USB
COMPUTER INTEGRATION

With a USB connection to a computer, the FM3 provides 4x4 audio interface capabilities, including computer
audio playback, recording, and re-amping in a DAW or other audio applications. Windows operating systems
require two separate USB-Serial/Audio Drivers, while Mac operating systems do not require a driver.

The FM3 is NOT a USB MIDI Device. It uses “COMM over USB” channels for Fractal-Bot and FM3-Edit, but will not
appear as a MIDI device in a DAW or other MIDI program.

- - The FM3 has two USB ports. The type “A” port is not used.

Use the USB type “B” port to connect to a host computer.

USB

WINDOWS MINIMUM REQUIREMENTS

Two separate USB-Serial/Audio Drivers are required for Windows operating systems.

0S: Windows 7 SP1 or newer (all versions compatible with x86 or x64).
CPU: Intel Core 2 @1.6 GHz or better, or AMD equivalent.

Memory: 1GB minimum.

USB: USB 2.0 support required.

Driver: Two different drivers are required for use under Windows.

The Windows drivers can be downloaded at http://www.fractalaudio.com/support

Step-by-step instructions are included with the installer.

MAC MINIMUM REQUIREMENTS

0S: 0S X 10.9 or later required for USB audio. An issue in older OS X versions causes audio pops.
Note: Older Mac OS versions may work for MIDI-over-USB (Fractal-Bot, FM3-Edit, etc.).

CPU: Intel Processor.

Memory: 512MB minimum.

USB: USB 2.0 support required.

Driver: No driver is required for Mac 0S.

Important: If you are using a USB-C to USB adapter on a newer Apple computer, plug the USB-C adapter into a
the port on your Mac first, allow it several seconds to “wake up” and then connect a USB cable and FM3
into the adapter.


http://www.fractalaudio.com/support
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USB AUDIO

The USB Recording and playback capabilities of the FM3 are illustrated below. The numbered red boxes in the top
section represent USB inputs on the computer, and the numbered green boxes in the top section represent USB

outputs on the computer.

In the following diagram, parameters shown in purple are found in SETUP: 1/0: Audio

- @ @ OUT 1 L+R Record Processed Audio
. Record Processed Audio
T e
IN l[INSTR] SOURCE" -or-
d @ @ IN 1 Record a DI for re-amping
m 2 -or-
. IN2L+R Record an external stereo source without processing.
(2) ﬁ OUT 1 L+R
. nura -or- Play Computer Audio at the desired output.
PLAYBACK OUT 2L+R
DEST." R
- IN1Block  Route Computer Audio to the grid for re-amping or processing.
L ouT1 R -or-
(3)(4) 0 @@ ouT1LR
S um -or- Play Computer Audio at the desired output.
PLAYBACK OUT 2 L+R

DEST."

R

OPTION: USB INPUT MONITORING ONLY

It is possible to record and play back USB audio without also hearing “local” processed audio from the Out 1 block by

changing SETUP:1/0: Audio: Output 1 Mode to “MUTE”

The following diagram shows how signal is routed during normal use and when this special option is used.

Output 1 Mode: STEREO

R TR

RECORD 1&2 PLAYBACK 1&2
USB

OUTPUT 1

A2 4

vv

-: Output 1 Mode: MUTE

v
(1) 2
RECORD 1&2 PLAYBACK 1&2
USB

OUTPUT 1
L
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BASIC PLAYBACK

The specific steps for recording in your OS or DAW will vary based on your setup, but the basic idea is to select
the FM3 as your audio interface, make any application-specific settings, and begin playback.

On Mac 0S, no driver is needed.

= Connect the FM3 to an available USB port.

= Open System Preferences: Sound and select the FM3 under “Output”.

= System Audio such as iTunes playback, should now appear at FM3 Output 1 Left and Output 1 Right.
On Windows you must install two separate driver files first.

» Find FM3 USB Audio Setup and FM3 USB Serial Driver Setup at:
https://www.fractalaudio.com/fm3-downloads/

= Once the drivers are installed, open Sound Settings under System Settings and select the FM3.
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Whichever OS you are using, confirm that the FM3 is receiving audio during playback by viewing the Meters page
of the Home menu, where you should see meter activity on USB IN 1L and 1R. If you turn up the OUT 1 LEVEL
knob, you will also see meter activity on ANALOG OUT 1L and 1R and hear audio at the connected speakers.

BASIC RECORDING

The specific steps for recording in your OS or DAW will vary based on your setup, but the basic idea is to select
the FM3 as your audio interface, set the project sample rate to 48k, create a track, assign the desired input, and
begin recording.


https://www.fractalaudio.com/fm3-downloads/
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USB RE-AMPING

The FM3 USB Audio capabilities are perfect for “re-amping,” a method in which the raw, unprocessed DI output of
a guitar is recorded and then re-processed later through the amp, cab, and effects of your choice.

Re-amping has many benefits. First, it allows you to record when inspiration strikes, capturing a DI instead of
obsessing over the final tone. Later, you - or a mix engineer — can redesign the sound as your track’s production
advances. Punches and edits made on the DI track are also made virtually inaudible by the re-amping process.

The FM3 allows you to dial in new tones while simultaneously listening to the track for context.

STEP 1: RECORDING

The following tutorial assumes that you have connected Output 1 L/R to monitors or headphones. The details
may vary from one DAW to another, but this guide should be easy to adapt to your own environment.

In your DAW, select the FM3 as the main audio interface. Set the main outputs to FM3 Outputs 1+2.
Create a new project in the DAW, and set its sample rate to 48kHz.

OPTIONAL: Record or insert any backing tracks and test their playback at FM3 Output 1.

Connect your guitar to the Instrument input of the FM3 and select any preset desired.

Now record the DI:

= Create a mono track. Name this track something like “Guitar DI”. Set its input to FM3 Input 3.
This will record the signal at the Instrument jack with no processing.

= Arm this Guitar DI track for recording, making sure that Software/Input Monitoring is NOT enabled.

= Hit RECORD and roll the track. You will hear the processed guitar but record the DI.
Note: You can simultaneously record processed guitar on a different track at the same time if you want!

= Be aware: while a processed track will show “hot” levels, the level of a DI track will appear to be very low.
This is NORMAL! You are recording the raw signal exactly as it comes out of your guitar.

= YOU HAVE NOW RECORDED YOUR DI!
STEP 2: RE-AMPING

Before re-amping, we must first check some settings on the FM3. Press HOME and open SETUP. Navigate to the
1/0 menu, and change Input 1 Source to “USB (CHANNELS 3/4)". (Remember to change this back when you finish
re-amping!) Also make sure that you have not changed USB 3,4 Playback from its default setting of “INPUT 1".

6. Change the output of your “DI”" track to FM3 Output 3.

7. NOTE: You may wish to turn down the volume of the studio monitors before testing playback as follows:
Solo the DI track, then rewind and hit PLAY. You should hear the DI being processed by your FM3 preset.

8. Now prepare to record the processed output of the re-amp:

= (Create a stereo track. Name it something like “Guitar Re-Amp 1".

= Set its inputs to FM3 Inputs 1+2.

= Arm your re-amping track for recording, making sure that Software/Input Monitoring is NOT enabled.
9. Rewind, hit RECORD, and roll the track. The output of the preset is recorded!

aRwb=

Again, the method described here is basic, but it should serve as a guide to get you started.
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4 SETTING UP

Before setting up, turn down all level knobs and power off all connected devices. Power on your speakers or monitors
last, if possible, even though the FM3 has pop suppression on startup. Use a basic AC surge/spike protector to
protect your equipment.

INPUTS

» Setting Input Levels is important. See “Setting Levels” on p. 7.

» The Input 1/Instrument jack features “Secret Sauce IV” to lower the noise floor, but
you can also safely connect guitars and other instruments to Input 2.

» Input 2 is balanced. Use balanced 1/4" TRS cables if possible when connecting to balanced outputs.

OUTPUT 1

» Output 1 defaults to -10 dBV, a low level “consumer” format. Change the Out 1 Output Level to +4 dBu
when connecting to pro audio equipment designed for +4 dBu. Find this setting under SETUP: 1/0: Audio.

» The FX Return of a guitar amp is generally -10 dBV. However, different amps may have different input
sensitivity levels. Check with your amp’s manufacturer if you're not sure.
» Use XLR-F to XLR-M cables or XLR-F to TRS-M cables when connecting Out 1 to balanced inputs.
» Use the FM3's ground lift switch if required to combat the hum caused by ground loops.
» Use XLR-F to 1/4” TS-M cables when connecting Out 1 to unbalanced 1/4" inputs.

OUTPUT 2

» Output 2 is a pair of unbalanced 1/4" jacks with Humbuster™ capability.

» Use Fractal Audio Humbuster™ cables whenever possible to combat the hum of ground loops. (See p. 8.)
If Humbuster cables are not available, use regular 1/4” patch cables. Do NOT use TRS-to-TRS cables.

» Output 2 has two options, controlled by the Output Type parameter in SETUP: 1/0: Audio.
= Use the LINE LEVEL setting when connecting Out 2 to line inputs such on powered speakers, mixers, etc.

When set to Line Level, Output 2 defaults to -10 dBV, a low level “consumer” format. Change the Out 2
Output Level to +4 dBu when connecting to pro audio equipment designed for +4 dBu.

The Output 2 Copy setting can be used to copy the signal at Out 1. See p. 103.

= Use the UNITY GAIN setting when connecting to the inputs of instrument level devices such as effect
pedals, the guitar input of a tube amp, etc. For unity gain, set the Out 2 Level knob fully clockwise.

The optional Out 2 Boost/Pad setting can help optimize the noise floor in some cases. (See .)

MONO/STEREO

» Any setup can easily be adapted for mono or stereo. See “Mono vs. Stereo” on p. 8 for an introduction.

FC CONTROLLERS

» Any setup shown here also works perfectly with one or more FC-6 or FC-12 foot controllers connected.

COMPUTER

» Any setup shown here also works perfectly with a laptop connected to run FM3-
Edit and Fractal-Bot. See Section 3: USB for more details.

29
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FRFR/DIRECT

Global Settings: Default
Presets: Factory or Custom

This setup takes full advantage of the ability of the FM3 to recreate all aspects of an “end-to-end” guitar chain, with
amps, cabs, effects, and more. It is the most versatile and popular setup, offering great flexibility.

Factory presets can be used without modification. Global and 1/0 settings on the FM3 can be left at defaults, but
if the inputs of your speakers/mixer are designed for +4 you should change the global Out 1 Output Level.

Connect Output 1 directly to a flat response (“FRFR") speaker or a high-quality PA speaker. This setup also works
for studio monitors, headphones, etc. Adjust overall levels using the front panel OUT 1 knob.

If you don't have XLR cables or need to use Output 2 instead, change the following in SETUP: I/0 Audio:

= Qutput 2 Copy set to “OUTPUT 1”. Note that this won't work if there's an Output 2 block in your preset.)
* Qutput 2 Type set to “LINE LEVEL" with Output Level set to +4 or -10 depending on your speakers, etc.

CONNECTIONS

» Connect your guitar to
Input 1 (Instrument ).

» Connect Output 1 to
the input(s) of your
FRFR system. Use Left
for mono or Left and
Right for stereo.

FASLINK 11
Port (Male)

# FC-6

» If you're using a mixer,
be sure to connect the (P #ene
FM3 to line level inputs
rather than mic level
inputs. Also, “zero out”

55
0P ime

ssssss
o

FASLINK Il

Port (Female) Optional
all other channel settings . OUTPUT " Optional See notes above FC-12 or FC-6
to begin_ Contact your : 1R » for Stereo if you need to use Out 2

mixer’s manufacturer if

you have any questions.
FRFR

SPEAKERS,
STUDIO
MONITORS,
ETC.

EEEEEEE
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BASIC RECORDING SETUP

Global Settings: Default
Presets: Factory or Custom

Adding a computer to an FRFR/Direct Setup (previous
page) allows easy recording, playback, and re-amping
over USB. Your DAW or application must be set to use
48 kHz, the fixed internal rate of the FM3. FM3-Edit and
Fractal-Bot can share the USB connection.

The top panel OUT 1 knob works as the master level
control for the FM3 and computer audio playback. For
additional playback level control, adjust your computer
or use USB 1/2 Level in SETUP: 1/0: USB on the FM3.

The recorded levels of processed guitar from the FM3
are determined by the levels inside your preset. The Out
1 knob will not affect USB recording levels.

Section 3: USB details FM3 USB audio.

For USB to work under Windows, you must install
the USB Driver available on our web site. STUDIO MONITORS ~ COMPUTER

THIRD-PARTY
AUDIO INTERFACE

The FM3 can also be used to add world-class guitar
processing and effects to an existing studio setup with
any third-party audio interface. Reasons for doing this
include needing to use sample rates other than 48k, -

using additional i/o channels, built in mic pres, etc. Oorsy 0[O
" el u
» Connect your computer, audio interface, and J—p=
speakers as instructed by their manufacturers.

nnnnnn

SPDIF out
can be
used
instead.

» Connect your guitar to FM3 Input 1 (Instrument).

» Connect FM3 Output 1 L+R to a stereo line
level input pair on your audio interface as

» The analog outs of the FM3 are of such quality
that using digital i/o isn’t generally necessary to
achieve excellent results. You may, however, use
the FM3's SPDIF output to connect to a 3rd party
interface. To do this, change SETUP: 10: Audio:
SPDIF Out Source to “OUTPUT 1", and set your
interface to derive clock from its SPDIF Input,
which should lock to the FM3.

» Optional: connect the FM3 to the computer
via USB to enable FM3-Edit and Fractal-Bot.

COMPUTER

STUDIO MONITORS



https://www.fractalaudio.com/fm3-downloads/
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NEUTRAL POWER AMP & SPEAKERS

Global Settings: Modified (see below)
Presets: Factory or Custom, with possible tweaks (see below)

This popular setup uses FM3 amp modeling with a neutral power amp connected to a traditional guitar speaker.

A “NEUTRAL’ POWER AMP... CONNECTIONS

This setup relies on a sonically “neutral” power > Connect your guitar to Input 1 Instrument.

amp. This will typically be a solid-state amp designed » Connect Output 1L to the input

specifically for guitar amp modelers or a pro audio amp of your power amp, which will typically be XLR.
designed for FRFR applications. (In comparison, the You can also use an XLR to 1/4" cable if needed.
power section of most tube amps is not neutral and will » Connect the power amp to a speaker

contribute measurably to the tonal coloration and feel.) as directed by the manufacturer.

POWER AMP MODELING ENABLED

If a neutral power amp does not provide shape tone
and dynamics like a traditional guitar amp power
section, the FM3 must model these qualities in this
setup. Therefore, we leave SETUP: Global: Config:
Power Amp Modeling set to “ON". This has several
benefits. First, since the power sections of different
amps can sound so diverse, modeling provides an
accurate experience as you switch between amp types.
The power amp of a “Deluxe,” for example, is going to
sound VERY different from that of a “Recto.” At the same
time, a modeled power amp allows us to dial in various
parameters as desired to shape its tone and feel.

OTHER AMP BLOCK SETTINGS

There are other amp block settings that require consider-
ation. On the Speaker page of the Amp block, set Speak-
er Drive, Speaker Compression and Thump to zero or

as desired. Set the LF Resonant Frequency to match the
resonance of your connected cabinet (if known.) Finally,

on the Advanced page of the amp block, set the Output

Mode to “SS PWR AMP + CAB". GUITAR
SPEAKER
CAB MODELING DISABLED CABINET
Since using speaker sims into real speakers would be (L
redundant, it's necessary to disable cab modeling in
this setup. To do this, change the Cabinet Modeling
setting to ‘BYPASSED’ under SETUP: Global Settings:
Config. Another option is to remove or manually bypass

the Cab block in all presets that will be used.

ey
E=E=x,

(OELETN :/ ¢
SO 1®
NO® Seree o

..........
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TRADITIONAL GUITAR POWER AMP & SPEAKERS

Global Settings: Modified (see below)

Presets: Factory or Custom, with possible tweaks (see below)

This setup utilizes preamp modeling from the FM3 with a ‘non-neutral’ guitar power amp,such as the power
section of a combo or head, or a standalone power amp — connected in either case to a traditional guitar speaker.

A “GUITAR AMP” POWER AMP...

This setup uses the typically “non-neutral” power
section of a guitar amp, or a dedicated power amp
designed for use with a guitar preamp. Such an amp
contributes its own coloration and dynamics.

POWER AMP MODELING DISABLED

When a connected power amp has its own pronounced
tone and dynamics, modeling these same characteristics
would will be redundant, so we disable Power Amp
Modeling as follows:

» Navigate to SETUP: Global Settings: Config.
» Change Power Amp Modeling to “OFF".

» OR Set “Power Amp Modeling” to OFF on the Power
Amp page of the amp block of every preset used.

NOTE: Some guitar power amps are closer to neutral,
and some players may prefer to leave power amp
modeling ON. Try it both ways and see what you prefer.

OTHER AMP BLOCK SETTINGS

There are other amp block settings that require consider-
ation. On the Speaker page of the Amp block, set Speak-
er Drive, Speaker Compression and Thump to zero or

as desired. Set the LF Resonant Frequency to match the
resonance of your connected cabinet (if known.) Finally,
on the Advanced page of the amp block, set the Output
Mode to “SS PWR AMP + CAB".

CONNECTIONS

» Connect your guitar to FM3 Input 1 Instrument.

» While it is possible to use Output 1, Output 2 is
generally recommended for this application.
To use Out 2 as a copy of Out 1 without the need
to build special presets, change the following
Output 2 settings in SETUP: 1/0 Audio:

= Qutput 2 Copy set to “OUTPUT 1". Note that

this won't work if there’s an Qutput 2 block in
your preset.)

» Output 2 Type set to “LINE LEVEL" with Output
Level set to +4 or -10 depending on your amp.

= Alternatively, you can replace the Out 1 block
with Out 2 in all presets used.

= Humbuster™ Cables are recommended to
combat the noise of potential ground loops.

» Connect your power amp to a guitar speaker
cabinet as directed by the manufacturer.
(If it's a combo, the speaker is already connected.)

FM3

|
o e o @

FASUNKN —

ESES,

__________

Optional for Stereo
to a second amp

CAB MODELING DISABLED - ~
USi”ﬁ’(Speakerljit;“S ":;0 rsa' NI _S— |50 00 Amplifier

speakers would be redundant, H C20 600 H ,,,,, 7

so it is necessary to disable cab """"""??% ???m@ 8o NOOOID

modeling in this setup. To do this,
change Cabinet Modeling setting
to ‘BYPASSED’ under SETUP:
Global Settings: Config.

Another option is to remove or manually bypass
the Cab block in all presets that will be used.

You can also use a standalone
power amp designed for use
with a guitar preamp.
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FRONT-OF-HOUSE + PERSONAL FRFR MONITOR

Global Settings: “Output 2 Copy” set to OUTPUT 1
Presets: Factory or Custom, full amp and cab modeling.

This setup sends identical signals to the front-of-house PA and your personal FRFR monitor, with separate level
controls for each. Normal presets with full amp and cab modeling are used.

CONNECTIONS

» Connect your guitar to FM3
Input 1 (Instrument).

» Connect Output 1 to the front-
of house system. Ideally, use
XLR cables to balanced Ins.

= Adjust FOH levels using the OUT
1 knob. Set it and forget it...
make a mix engineer happy!

= |f you are working with a sound
technician, be sure to tell them
that you are outputting a line
level input — NOT a microphone
level signal. They should use a
balanced line input without a mic
preamp.

= Also tell them you are sending
a fully processed “mix-ready”
sound, and that — at least to start
— they should “zero” the channel
with no EQ or processing.

» Output 2 feeds your FRFR
monitor. Adjust levels using
the OUT 2 knob as desired.

» Ensure that signal is present at
out 2 by setting SETUP: 1/0 Audio:
Output 2 Copy to “OUTPUT 1”.
(Note that this won't work if there's
an Output 2 block in your preset.)

= Set Output 2 Type set to “LINE
LEVEL” with Output Level set
to +4 or -10 depending on your
monitor.

» TIP: Remember that both OUT1 and
OUT2 have their own independent
global equalizers, which can be
useful, for instance, if you are
unhappy with the tone of the monitor
and want to leave the PA. alone.

....................

: OUTPUT : Optional
. ! for Stereo

....................

Optional
for Stereo

@)
000
2000

FHH
LLn -
HH

FRONT-OF-HOUSE
MIXER/PA

PERSONAL FRFR MONITOR

Of course it’s also possible to use
OUT 1 to monitors and OUT 2 to FOH.
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FRONT-OF-HOUSE + GUITAR SPEAKER BACKLINE

Global Settings: Modified (see below); Presets: Custom

In this setup, custom presets simultaneously send two different signals to Out 1 and Out 2. The first is a “direct” signal
for front-of-house, complete with speaker simulation. The second feeds a power amp — without speaker simulation —
into real guitar speakers for an authentic backline experience.

As shown below, this is achieved using specially designed presets, with an Out 2 block prior to the cab block.

Output 1: Front of House - The signal with speaker
sims is sent via Output 1 to a full-range PA system. [ IN1_|{ WAH | DRV | AMP | cHO H DLY |{ cAB |{ouT1]

This provides all the benefits of going direct, with oUT2
versatile, consistent tone at very controllable volume

levels. Set output levels using the OUT 1 knob and leave them alone after soundcheck. Remember, when using a
mixer, select line level inputs and avoid channel settings that might undesirably color or process the sound.

Note: Notice that the Cab block is placed after the “post” FX. If a stereo signal is required at Output 1, the cab block
must also be set for stereo use. Learn more about the Cab block in the Blocks Guide.

Output 2: Backline - The signal without cab simulation feeds a power amp and traditional guitar cab. This
provides a familiar playing experience with great natural sustain/feedback, and stage level (“moving air"). You
should use a neutral power amp (see p. 32) since power amp modeling needs to be active for Out 1, and it
cannot be both on and off at the same time. The Out 2 global EQ can also be used if you need to compensate for
the tone of a non-neutral power amp.

....................

: OUTPUT | optional
: 1 for Stereo

Optional
for Stereo

FRONT-OF-HOUSE

MIXER/PA GUITAR
SPEAKER

SPKR CABINET

CONNECTIONS

» Connect your guitar to Input 1 (Instrument).

Check the following in SETUP: 1/0 Audio:

» Output 2 Copy set to “NONE".

> Connect Output 1 to front-of-house. = Output 2 Type set to “LINE LEVEL" with Output
Inform the sound technician that the FM3 Level set to +4 or -10 depending on your amp

outputs a direct, line-level signal.
P _ g » Humbuster™ cables are recommended for
» Connect Output 2 to the input of your power amp, output 2 to combat hum from ground loops.

which should ideally be very “neutral” (see p. 32). Connect your amp to a speaker cab

as directed by the manufacturer.
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FX PROCESSOR ONLY (“PRE")

Global Settings: Modified (see below)
Presets: Custom

In this setup, the FM3 is used as a virtual pedalboard, providing access to a vast collection of industry-leading
effects. It is placed between your guitar and amp like a traditional pedalboard. You'll need custom presets, but

as with all FM3 setups, you are free to create at will. Presets should typically NOT contain Amp or Cab blocks for
this setup, and should be created with an understanding of how effects sound in front of your amp’s preamp and
any distortion it creates. (You may wish to look into the term “pedal platform amp” for more on this subject.) FM3
Output 2 is used in this setup, because it is designed for unity gain. A sample preset layout is shown below:

[ N1 H cmp H{wan | prv | by H Rev |Houtz)

CONNECTIONS

» Connect your guitar to FM3
Input 1 Instrument.

» Connect Output 2 L to the input of your amp.
A Humbuster™ cable is recommended.

» In SETUP: I/0: Audio, set the Output Type
parameter for Out 2 to “UNITY GAIN”

» To extend this configuration for optional
stereo, connect Output 2 R to the input of a
second amplifier.

* You can in fact use the FM3 to select
between two different amps by changing
channels on the Out 2 block. Sample : OUTPUT !
settings might be: : :

- Channel A: Balance Center (Both Amps) Optional for

- Channel B: Balance Left (Left Amp) Stereo

- Channel C: Balance Right (Right Amp) -

- Channel D: (Not used) 50 DODOOD JJT

(See “Scenes & Channels” on p. 51 for .

more info.) EL M COmBo GUITAR
» Set the FM3 OUT 2 knob fully clockwise AMP

for unity gain if desired, and adjust
your amp as you normally would.

- |

TIP: OPTIMIZE FOR LOW NOISE

The Out 2 Boost/Pad function in SETUP: I/0: Audio can help lower the noise floor when Qut 2 Type is set to
“UNITY GAIN". Adjust Boost/Pad as high as possible without lighting red clipping LED on the top panel output 2
level meter. The volume won't change but you should hear the noise floor drop at higher settings.




4 SETTING UP

FX PROCESSOR ONLY (“POST")

Global Settings: Modified (see below)
Presets: Custom

The FM3 can be used as a multi-FX processor in the FX loop of an amp, providing access to a vast collection of
industry leading effects for those not be not ready to make the jump to modeling.

Input 2 is used in this setup to accommodate your amp’s line level FX send. Output 2 is used in this setup.

Custom presets for this setup must have NO Amp or Cab blocks, and must contain only those effects that sound
good to you after the distortion stage of your preamp. An example is shown below:

CONNECTIONS " 2J1 EQ J{cHo }{owvi{owv2}{ Rev -jourz]

» Connect your guitar to your amp's
instrument input as you normally would.

» Connect the FX Send of your amp to FM3 Input 2 L.

» Adjust Input 2 Pad if necessary
in SETUP: 1/0: Audio

» For the setup shown here, set Input 2 Mode
to “LEFT ONLY” under SETUP: 1/0: Audio.

» Connect Out 2 L to the FX Return of your amp.
A Humbuster™ cable is recommended.

= |f your amp’s loop is wired in series, the FM3
OUT 2 knob will control the overall volume.

= You will typically want to set the Out 2 Output N NSTR
Type to “LINE LEVEL". Consult your amp’s 8o 000OIS & | N
manual and set Out 2 Output Level to +4 or -10

as required. It is also possible to set Out 2 type ;- -:
to “UNITY GAIN" if desired.
* In a series FX loop setup, the FM3 OUT 2 level Q Q
knob will control the overall volume of your amp SPEAKER
= To extend this configuration for optional stereo, CABINET
connect Out 2 R to the return of a second amp.
PARALLEL FX LOOP? Q Q

If your amp’s FX loop is parallel, your FM3 presets must  \G -
be further customized so that no dry signal passes

through the FM3. This generally limits the effects you

can use, how they must be arranged, what their mix

setting must be, and more. If your amp is switchable,

the “Series” setting is probably easier to use.

TIP: OPTIMIZE FOR LOW NOISE

The Out 2 Boost/Pad function in SETUP: 1/0: Audio can help lower the noise floor when Qut 2 Type is set to
“UNITY GAIN". Adjust Boost/Pad as high as possible without lighting red clipping LED on the top panel output 2
level meter. The volume won't change but you should hear the noise floor drop at higher settings.

: OUTPUT : Connect to FX RTN
2R . of a second amp for
""""" optional stereo.

AMP

Q(adque
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4 SETTING UP

FOUR-CABLE METHOD (“4CM")

Global Settings: Custom; Presets: Custom

The Four-Cable Method setup (“4CM”) inserts the FM3 at two different points in your signal path. First, the FM3
adds “pre-FX” like Drive between your guitar and amp. Next, it adds “post fx”" like Reverb in your amp’s FX loop.

4CM requires special presets with extra I/0 and NO Amp or Cab blocks. An illustration appears below.
“Pre-Fx” “Post-Fx"

pmcogmopmoogm g ooguogm

From your To Amp From Amp To Amp
Guitar Front IN FX Send FX Rtn.

Note OUT2 block is not connected to IN2 block

PRE-FX SIDE

» Connect your guitar to FM3 Input 1 (Instrument).

» Connect Output 2 L to the front input of your amp.

= |n SETUP: I/0: Audio, set the Output Type for Out 2 to
“UNITY GAIN"

= Set the front panel OUT 2 knob fully clockwise.
= A Humbuster™ cable is strongly recommended.
= See also “EX Processor Only (“Pre”)” on p. 36

nnnnnnnnnnnnn

(G 7= T
_‘O©¢ i >©D

ssssss

J

..........

TIP: OPTIMIZE FOR LOW NOISE Rl bl 1 e A
The Out 2 Boost/Pad function in SETUP: 1/0: Audio can help Optional

lower the noise floor in this setup. Adjust Boost/Pad as high for Stereo. FX FX

as possible without lighting red clip LED on the top panel Out RETURN ) {__SEND

2 level meter. The volume won't change but you should hear
the noise floor drop at higher settings. Guitar Amplifier
Am
POST-FX SIDE Pl e° 0000gn ¢
» Connect your amp’s FX Send to Input 2 L.

» |n SETUP: I/0: Audio, set Input 2 Mode to “LEFT ONLY"
and adjust Input 2 Pad if necessary.
» Connect Output 1L to the FX Return of your amp.
= Use an XLR-F to 1/4"-M cable (TS, not TRS!).

= Set the front panel OUT 1 knob as desired for

appropriate volume.
= To extend this setup for optional stereo, connect
Output 1 R to the FX Return of a second amplifier.
NOTE: Before committing to the complex 4CM, consider

trying “Traditional Guitar Power Amp & Speakers” on p. 33 \L 1)




4 SETTING UP

INSERTING OUTBOARD GEAR

Global Settings: Check Out 2 Mono/Stereo Settings; Presets: Custom

Any setup that uses only Input 1 and Output 1 leaves Input 2 and Output 2 available as an insert for outboard
gear. Custom presets are required for this setup with Out 2 and In 2 blocks:

SEND RETURN

Notice that the Out 2 block IS connected to the In 2 block. In fact, In 2 can be used to bypass the entire loop,
allowing signal pass when the outboard gear is not in use.

NOTE: Don't jump to the conclusion that an insert is always the best way to use 3rd party gear. You can achieve

great results by connecting other devices in series. Place stompboxes between your guitar and FM3 In 1, and/or
connect the outputs of the FM3 to other processors, loopers, etc. One advantage of using an insert, however, is

that outboard gear can be inserted or bypassed by an FM3 preset, scene, or footswitch, or recorded via USB.

SEND SIDE

» Connect your guitar to FM3 Input 1 (Instrument).
» Connect Out 1 to your speakers or amp as usual.

» Connect Out 2 L to the input of your outboard device.
A Humbuster™ cable is strongly recommended but
you can also use a standard patch cable.

Do not use TRS-to-TRS cables.

= For instrument level insert gear (many pedals):

* |n SETUP: I/0: Audio, set the Output Type
for Out 2 to “UNITY GAIN”

= Set the front panel OUT 2 knob fully clockwise.

= The Out 2 Boost/Pad function can help lower the
noise floor in this setup. See “TIP", previous page.

= For line level insert gear (most rack gear):
* |n SETUP: I/0: Audio, set the Output Type

To Amp,
for Out 2 to “LINE LEVEL" and set Output s:eakm;s'
Level to -10 or +4 based on the input as usual
sensitivity of your outhoard device. : : INPUT
= Set the front panel OUT 2 knob as desired to 2R
achieve optimal level on your outboard device. Optional " OUTPUT
for Stereo . 2R
RETURN SIDE PEDRLY TAIE ) | | eeeeeeet
Optional
» Connect the output of your outboard for Stereo
device to Input 2 L as a “return.”
» Use Input 2 R for optional stereo.
» Adjust levels on your outboard device or pad OUTBOARD GEAR
Input 2 of the FM3 under SETUP: 1/0: Audio. (PREAMP, PROCESSOR, PEDAL, ETC.)

The FM3 can send MIDI to control 3rd party devices. Connect a MIDI cable from the MIDI Out of
the FM3 to the MIDI IN of the connected device. Then program the required MIDI messages as
detailed in “Sending and Receiving MIDI” on p. 134
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4 SETTING UP

TWO GUITARS AT ONCE

Global Settings: See below; Presets: Custom

This setup demonstrates how the FM3 can be used to simultaneously process an electric guitar and an acoustic
guitar at the same time. It also works for guitars equipped with dual output from magnetic and piezo pickups.
NOTE: While this setup could also be used for two electric guitars, or a guitar and a bass, for example, the FM3
only allows the use of one Amp and Cab block pair, so processing options for the second instrument are limited.
(The FM9 and Axe-Fx Ill each allow two Amp and Cab block pairs per preset, offering greater versatility.)

Electric

Both guitar share the

Acoustic Reverb in this example.

CONNECTIONS
» Connect your electric guitar to
FM3 Input 1 (Instrument).

» Connect your acoustic guitar (or the piezo
side of your electric) to FM3 Input 2 L.

» In SETUP: I/0: Audio:
= Set Input 2 Mode to “LEFT ONLY”
= Adjust Input 2 Pad if necessary.
» Connect FM3 Output 1 to your PA, mixer, or 15§ Do T
monitors as you would in any other “direct” setup. S — =3
» Create a preset as shown above where IN 1 is the = A
electric guitar and IN 2 is the acoustic/piezo.

= Compressor and EQ blocks are a great way to
add level and tone controls to your acoustic or
piezo signal.

» Note that in the example here, the two chains
are sharing a reverb block, which sounds
great and is also economical. It is also
possible to share many other blocks.

» If you wanted the acoustic to go to its own output,
you could route the second set of block to the
Out 2 block instead of merging into Out 1.

P.A. or FRFR MONITOR
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9 PRESETS

OVERVIEW

» The FM3 contains 512 preset memory locations.
Each preset is like a full rig with its own amp, cab, effects, and more.

» When the FM3 is manufactured, the first 384 memory locations are loaded with Factory
Presets, but any preset memory location can be edited or completely overwritten.

» If you want to restore the factory presets (or install the newer versions that are released ocassionally),
you can download them from hitps:/www.fractalaudio.com and install them using Fractal-Bot.

» Every preset has its own name that you can change when you store it.
» Presets are built on a “Grid” by inserting, connecting, and dialing in “Blocks.”

» Blocks contain “Channels.” See “Intro to Scenes and Channels” on p. 17.

» Compared to the Axe-Fx Ill, the FM3 will have smaller presets, but a single preset
can still potentially cover an entire song, or even an entire gig.

» Please review “Intro to the Layout Grid” on p. 16 for an introductory overview of this section.

» Presets also contain 8 Scenes. Scenes are covered in Section 6 of this manual.

LOADING PRESETS

Different areas of the FM3 provide different ways to load presets:

= See p. 3 and p. 4 of the Introduction to this manual for how to load presets from the Home page.
= A presets Directory is also included.

o From the home page, page right to the “Presets” tab.

o Use the NAV buttons to select a preset and press ENTER.

o Presets are sorted in numerical order. To sort alphabetically, press SORT A-Z (Push-knob E).
» Foot Switches - FM3 footswitches provide a range of options for loading presets.

= MIDI - MIDI Bank and Program Change messages may be used to select presets using the industry-standard
“Controller 0 + PC" method. See “MIDI Reference Tables” on p. 136
Custom Mapping is also supported, see “Program Change Mapping” on p. 56.

FM3 Home Perform-PP Perform-GBL »

034: FAS Lead 1+2

Classic Ld 1
FXLld1l

Octave Ld 1 The Home Page of the Home menu provides

Phase Ld 1 an easy way to load and review presets.
Classic Ld2

FX Ld2
Octave Ld 2
Phase Ld2
(> Scene Zoom FCView [1)  FC Layout [1)
TUNER LAYOUT CONTROLLERS | | FC PER-PRESET SETUP
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5 PRESETS

THE LAYOUT GRID

The grid is a 12x4 framework for constructing presets. Consider grid rectangles as slots where blocks are
inserted and connected to create a signal processing path. Each grid space and every cable is stereo, eliminating
the need for separate left and right paths. However, be aware that some blocks may collapse the signal to mono.

Access the grid from the Home page by pressing the ENTER button or the LAYOUT Push-knob.

In the default view, the FM3 display shows only a 6x4 section of the 12x4 grid. Navigate to off-screen areas using
the E knobs, or the NAV buttons. A bottom scrollbar indicates where you are in the overall left-to-right layout. To
show the entire grid at once, zoom out with the ZOOM button (Push-knob A).

Meters  Tools Layout cPu m 40% Meters  Tools

(> Scene: 1 Channel Block Level Row Column (3 Scene: 1 Channel Block Level Row Column
Z00M BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS
The grid normally shows four rows and six columns. Zoom out to show the entire grid at once.
You can scroll left or right with navigation controls. This also reveals VU meters for leveling scenes and presets.

WORKING WITH BLOCKS

As explained in “Intro to the Layout Grid” on p. 16, FM3 presets are using blocks pulled from a large inventory
of amps, cabs, stompboxes, studio effects, mixers, and more. To navigate around the grid you must move the
cursor — a yellow rectangle controlled by the NAV buttons or the D or E knobs.

TO INSERT A BLOCK...

» NAV to move the cursor to the desired grid location.

» Turn the VALUE wheel to step through the list of blocks.

» Press ENTER to confirm or EXIT to cancel changes.

» Asyou insert blocks, they are removed from the list, but every preset has the entire inventory to begin with.

TO CHANGE OR REMOVE AN EXISTING BLOCK...

» To CHANGE a block, select it and turn VALUE to the desired type.
» To REMOVE a block, select it and turn VALUE until “None” is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

TIP: A shortcut makes it easy to remove an existing block or convert it to a shunt. Select
[ DELETE ] the block and press the DELETE button (Push-knob B). A deleted block is replaced by a
shunt. Delete a shunt to leave an empty space.
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5 PRESETS

TO BYPASS OR ENGAGE A BLOCK ON THE GRID...

» Use NAV buttons to select the block.
» Press the BYPASS button (Push-knob C). Bypassed blocks are dimmed or “grayed out” on the grid.

RESETTING A BLOCK/CHANNEL

Blocks on the FM3 remember their last used settings, even as you place them on the grid. You may want a fresh
start before or after making changes. RESET takes only two button presses and can be performed at any time.

» Ifitisn't already open for editing, select the desired block on the grid and press EDIT.
[ RESET ] » Press the RESET button (Push-knob C). You are prompted to reset the current channel.
» Press ENTER to confirm. You can reset other channels in a block as they are used.

SHUNTS

A shunt is a sonically transparent block—like a cable which carries signal from one point to another. Like grid
spaces, a shunt is stereo; you don't need two for left/right. You can use shunts to span empty space in any preset.

TO INSERT A SHUNT...

» NAV to the desired grid location and turn VALUE until “SHUNT" is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

INPUTS AND OUTPUTS

Input and Output blocks are required to get input signals to the grid or pass signal to output jacks. All factory
presets use Input 1 and Output 1. Other setups may require different Input and Output blocks.
See Section 4 on “Setups” for examples. See “The Fractal Audio Blocks Guide” for more information.

BLOCK DISPLAY TYPES

The color display of the FM3 shows different grid block states as follows. Several examples appear below. Notice
that the selected block has a bold yellow outline and the bypassed block is grayed out.

Input Bypassed Selected Normal Shunt Output
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MOVING BLOCKS, ROWS, AND COLUMNS

A special “Tools” page in the Layout menu contains various utilities to MOVE individual blocks or entire rows
or columns UP, DOWN, LEFT, or RIGHT. When a block or a grid row or column is moved, it swaps places with the
item in the space it is moved to. This may result in certain connector cables being modified or removed, so be
sure to look over how the elements of your preset are connected before moving things around.

» Open the Tools page of the Layout menu.

» Select a function with the FUNCTION knob (A):
Move Block/Column/Row, Left/Right/Up/Down, Copy Channel,
Copy/Swap Scene, Global Block Link/Unlink/Load/Unlink All

» Use the NAV buttons to select the Block, Row, or Column you wish to move.
» Press ENTER to execute the move.

CONNECTOR CABLES

Just like physical gear, the blocks in the FM3 need to be connected together for signal to flow. This is done using
virtual cables, which run from one grid block to another. With even one cable missing, your preset may be totally
silent! Like shunts, connectors are stereo and totally transparent.

TO CREATE A CONNECTOR CABLE...

» On the grid, navigate to the block where you wish the cable to BEGIN. You can't start from an EMPTY space!

» Press the CABLE button (Push-knob D), or ENTER. The selected block and its neighbor to the right will flash.

» If you wish to connect to a different ROW, use NAV up or nav down to
select the desired destination. You can't skip columns!

» Press ENTER to make the connection. To cancel, press EXIT instead.

o Be sure to select a destination that is not already connected to the block
you started from, or you will REMOVE that cable (see below).

TO REMOVE A CABLE CONNECTOR...

Cables are removed in much the same way as they are created.

» On the grid, NAV to the block where the cable begins.

» Press the CABLE button (Push-knob D), or ENTER. The selected block and its neighbor to the right will flash.
» NAV to select the “other end” of the cable you wish to remove. You can't skip columns!
» Press ENTER and the cable will be removed. To cancel, press EXIT instead.

SHORTCUT: To connect across multiple empty grid columns with a series of shunts and cables,
select any block that is followed by a series of empty spaces, then press-and-hold the ENTER
button. The intervening spaces will be automatically filled with shunts and connected with cables.
Careful: any existing cables encountered along the way will be REMOVED!

_ in/stereo out. The grid allows up to four full stereo paths, and you do NOT need to create parallel grid
'n¢ =&  paths for stereo! Some blocks internally process audio in mono (such as Amp or Drive) but even these
“._/ generally have Input Select and Output Balance parameters.

9 Remember, on the FM3 grid, each component is STEREOQ. Shunts, cables, and many blocks are stereo
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THE RULES OF FM3 CABLES

» No cable = No sound. Even one missing link will break the chain.

» Signal flows from LEFT to RIGHT.

» A cable MUST originate from a BLOCK or a SHUNT. You cannot start from an EMPTY location.

» If you try to connect to an EMPTY location, a SHUNT will be created there.
» You can ONLY connect to blocks in the next column to the right.

The diagram below illustrates the above:
The % is the block where we will begin.
The v shows valid possible destinations.

The © symbol shows destinations that are illegal/unavailable.

alelelE
M@
NYWYE
alelelE

Any columns farther left or right would also be illegal/unavailable.

If the Y were in a different ROW, every v would still be in the same place.

» You may freely SPLIT or MERGE up to four ways at any point. This is sonically transparent and there is zero
risk of signal degradation or phase problems. CROSSING is also possible. Here are some examples:

Split Merge Cross Complex

,_
-

i
.
s

_ J/\ J

ol
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BLOCK INVENTORY

For a complete guide to all blocks and parameters, see “The Fractal Audio Blocks Guide”
The following table contains an overview of every block. Each preset has the entire inventory to choose from.

Block Description Types Channels Count
AMP Amp Here it is... All of our amp models in one block! 300+ 4 1
CAB Cab Speaker cab simulation with UltraRes™ and DynaCab™ Technologies 2237+ 4 1
CHO Chorus Create classic mono and stereo modulation effects including vibrato. 17 4 2
CMP Compressor Control dynamics and add sustain. 13 4 2
DLY  Delay Up to 8 seconds of delay, with types for analog, digital, tape, and more. 25 4 2
DRV  Drive Type including boost, overdrive, distortion, fuzz, and many more. 63+ 4 2
ENH Enhancer Classic and modern modes to create and control spatialization. 3 4 2
FLT  Filter Includes low pass, high pass, band pass, and many other types. 15 4 4
FLG  Flanger Various types cover everything from subtle modulation to extreme jet. 31 4 2
FOR  Formant Create dynamic vowel sounds with this multi-mode formant filter. 1 4 2
GTE  Gate/Expander Useful for everything from subtle control to extreme effects. 1 4 2
GEQ Graphic EQ A variety of modes allow easy, flexible tone sculpting. 15 4 2
IN Input Injects the signal from physical inputs onto the grid. 1 4 2
LPR  Looper A powerful looper with great remote control options. 1 1 1
MGT Megatap This 40-tap delay creates fantastic sonic patterns. 1 2 1
MIX  Mixer Allows you to mix up to six stereo signals. 1 4 4
MTD  Multi-Delay A variety of special delays including diffuser, quad-tap, and more. 34 4 1
MBC Multiband Comp  Three-band compressor that is great for mastering or dynamic EQ. 1 4 1
MUX  Multiplexer This input selector routes one of many inputs to an output. 1 4 2
OUT  Output Transmits signal to the corresponding physical output jacks. 1 4 2
PEQ Parametric EQ The 5-band parametric equalizer allows precise control of tone. 1 4 2
PHA  Phaser A variety of vintage and cutting edge phaser effects, including ‘vibe. 16 4 2
PIT  Pitch Shift Includes capo, detune, harmonizer (intelligent/custom), whammy, and more. 16 4 1
PLX  Plex Delay Up to eight delay lines and pitch shifters interacting in a matrix. Gorgeous! 44 4 1
RES  Resonator Resonant comb filters in parallel. Create chords and more. 1 2 2
RTN  Return Receives signal from the Feedback Send block. 1 1 2
REV  Reverb World-class recreations of vintage springs, rooms, halls, and more. 54 4 1
RNG Ring Mod The extremely flexible ring modulator provides for a range of cool effects. 1 2 1
ROT  Rotary Simulates a classic rotary speaker with multiple microphones. 1 4 2
MIDI  Scene MIDI The Scene MIDI block transmits MIDI messages whenever a Scene loads. 1 1 1
SND  Send Transmits signal to the Feedback Return block. 1 1 2
SYN  Synth A 3-voice monophonic synth that tracks what you play. 1 4 1
TTD  Ten-Tap Delay Set the time, pan, and spacing of one to ten separate echoes. 2 4 1
TRM  Tremolo Creates classic trem, plus auto-pan or extreme psycho acoustic effects. 4 4 2
VOL Volume/Pan Simple volume block also offers channel input/output tools. 1 4 2
WAH Wah The essential wah, with multiple types based on classic originals. 8 4 2

Each preset also includes a Controllers block that is not placed on the grid.
Certain blocks found on the Axe-Fx lll do not appear on the FM3.
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EXAMPLE PRESET GRIDS

These FM3-Edit screen captures show how blocks are combined to form presets.

Ex 1: Bare bones! Amp and Cab. No effects.

Ex 2: Here some effects are added before the amp and after the cab.

[T |efmrE{  |Flargei
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EDITING EFFECT BLOCKS

Blocks are fully programmable, allowing you to dial in every setting as desired. The Edit menu for every block
contains one or more pages, each with multiple parameters which control various functions. Here's a quick guide
covering how to access and work with the different types of Edit menu pages.

OPENING AN EDIT MENU
» On the Layout grid, select the desired block and press EDIT.

» From anywhere on the FM3, just press EDIT to jump right to the Edit menu for the currently selected block.

CHANGING PAGES

» Most Edit menus have multiple pages, shown as “tabs”
at the top of the menu (red arrows, right).The color of
the tabs matches the color of the block on the grid.

» Tap the PAGE buttons to page left or right.

EDITING "KNOB" PAGES

» Most Edit menu pages show up to five knobs,
switches or selectors. To make changes, use the
five physical knobs below the display (green arrows,
right) or the NAV buttons and VALUE knob.

» You will hear all changes in real time.

» If a menu page has two rows of knobs, use
NAV UP/DOWN to switch between them.

EDITING “MENU" PAGES

» Some pages have vertical lists of parameters.

» Use the NAV UP/DOWN buttons to step through
the list or NAV LEFT/RIGHT buttons to jump.

» The A knob and the VALUE knob operate
the selected parameter.

» B, C,D, and E knobs control other parameters in
the list, as shown by blue labels on the list.

OTHER PAGE TYPES

» Some blocks have special Edit menus, with parameters
arranged in rows and columns. Some of these include
interactive meters or graphs. Use NAV and VALUE or
AB,C,D,E knobs to move around and make changes.

» For TYPE pages, such as Amp Type, just NAV through
the list to make a selection and turn the page or press
EXIT when finished. Selections take effect instantly.
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Chorus 1

Type [ Basic)] Expert Mix

Analog Stereo Scene:1 Channel: A =
—C 50.0 % D —
=0 © O O
Number Tempo Rate Depth Delay
Voices Time

(CHANNEL - ) ( CHANNEL + ) (__ BYPASS ) (_ RESET ) (_ MODIFIER )

Chorus 1

Type Basic [Expert] Mix

Analog Stereo Scene:1 Channel: A =
B High Cut 8000 Hz
C LFO Phase 90.0 deg
D LFO Type TRIANGLE
E Auto Depth Low
Phase Reverse NONE
Drive 3.33
Width 50.0 %
LFO2 Rate 0.050 Hz
LFO2 Depth 0.0%
Stereo Spread ® 100.0 %

(CCHANNEL - ) ( CHANNEL + ) (__BYPASS ) (_ RESET ) (_ MODIFIER )

Multiband Compressor 1

[Config) Mix

Scene:1 Channel: A

=

Detector
Mute

Fast RMS
OFF

Low Mid High
Crossover Freq  500.0 Hz 10000 Hz
Threshold -80 db -20 db -10db
Ratio 1.000 20.00 2.000
Attack 10.00 ms 10.00 ms 10.00 ms
Release 10.00 ms 1000 ms 500 ms
Level -20.0dB -6.00dB

Peak

RMS+Peak

LOW MID  HI

& Nav

Value

Value

Value

(_CHANNEL - ) ( CHANNEL + ) (__BYPASS ) (_ RESET ) (_ MODIFIER )
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SAVING CHANGES

After editing a preset, you may want to save the results.
Every preset in the FM3 can be modified. There are no permanent presets.

When you change the current preset in any way, the front panel "EDITED" LED lights until you STORE or load a new
preset.

TO STORE A PRESET...
» Press STORE to show the STORE page.

» Turn the VALUE wheel or B knob if you wish to save to a different location.

» Press ENTER to display “Do you want to overwrite the Preset?”
» Press ENTER again to confirm, or EXIT to cancel.

» The message “SAVED!" is shown when saving is complete.

TO CHANGE THE PRESET NAME...

The FM3 has 512 preset memory locations. You can edit the name of any preset while storing.
» Press STORE to show the STORE page.
» NAV down once to the PRESET line.

o Turn the B knob to move the cursor.

The C knob selects UPPER CASE letters.

o The D knob selects lower case letters.

The E knob selects numbers.

The VALUE knob selects ALL characters, including symbols.
o You can use up to 31 characters in a preset name.

» You can also NAV to any Scene name to edit it in the same way.

o

o

[m]

» Press ENTER to Store, then press ENTER again to confirm.
» The message “SAVED!" is displayed and the new location (if any) is loaded.

Scene naming is a powerful capability. Aside from stating what a specific scene is
intended for, the names of unused scenes can be used for short notes or reminders.
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PRESET CPU LIMITS

The CPU of the FM3 is used mainly for sound processing. A preset with nothing but an Amp and Cab is less
demanding than a preset with a Wah, Drive, Amp, Cab, Delay and Reverb.

You can check the current CPU level at any time by viewing the mini CPU meter at the top of the layout grid.

The maximum allowable load is approximately 80%. There are safeguards to prevent you from pushing the FM3
too far. Should CPU levels rise above the allowable limit, the FM3 will disable sound processing and flash the
warning, “CPU LIMIT - Muted”. This allows you to remove blocks or change settings to solve the problem.

Another safeguard is that the FM3 will prevent you from inserting a block that would push the CPU over the limit.
If this happens, you can make changes to reduce the current CPU load and try again. You might remove an effect
that is less important. Adjusting certain parameters can also help.

Here are a few of the common block parameters whose settings have a notable effect on CPU usage:

o Amp: Output Comp: Set to "0" for the least CPU usage.

o Cab: Mute: Using two IRs demands more CPU than using one.
Set the mic Preamp Type to NONE and set Room Level to 0%.

o Reverb: Quality and Echo Density. Lower = less CPU.

o Compressor: Set Type to one of the "PEDAL" options to use less CPU.
o Phaser: Stages. Lower = less CPU.

o Filter: Order and Q. Lower = less CPU.

o Multitap Delay: Type. Different types have different CPU requirements.
o Plex Delay: Number of Delays affects CPU usage.

o Synth: Turn extra voice type parameters OFF to conserve CPU

o Modifiers also affect CPU usage.

TIP: The Fractal Audio Wiki keeps a list of CPU saving ideas.

CPU & USB

On the FM3, CPU usage does not increase when USB is connected.
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6 SCENES & CHANNELS

Before reading this section, please review “Intro to Scenes and Channels” on p. 17.

A Scene can be thought of as a preset within a preset. Scenes can turn blocks on or off, change block Channels, and
more. Scenes don't need to be created—they’re already there, ready to be set as desired. To save any changes to
any scene, you must save the entire preset. There are many benefits to using scenes. By switching multiple blocks,
they eliminate the need to “tap dance” on switches. They also offer the easiest way to ensure perfect “spillover”
of effects like delay and reverb. Scenes can also change overall volume levels, send MIDI messages, and more.
Each Scene also has a name.

WHAT SCENES INCLUDE...

< = Each Scene has its own Name.
- » Each Scene sets the Bypass state of every block in the current preset.

>
Y = Each Scene sets the Channel of every block in the current preset.

= Each Scene has its own levels via the Scene Level settings in every Output block.

= Each scene has its own settings for four Scene Controllers.
See Section 9: Modifiers

= Scenes can use the Scene MIDI block to send MIDI messages.
See p. 56 for an introduction.

= Scenes interact with special footswitch functions called Control Switches
See “Sending and Receiving MIDI" on p. 134
or “The Footswitch Functions Guide” on p. 20

DON'T set a parameter (e.g., Amp Treble to “6”), then switch to a new scene and then change the value of that
parameter (e.g., from “6” to “10”). The change will affect all scenes that use the currently selected channel.

DO dial in a block (e.g., the Amp) however you want it. Then, change the Scene and set that block to a different
channel. Now you can change any and all settings for that block/channel without affecting channels used by
other scenes. (This concept is illustrated on p. 17.)

FAQ. WHY NOT JUST CHANGE PRESETS? Preset changes give you total
® flexibility. You can change anything and everything in every preset, but there are also
drawbacks. Synchronizing multiple presets can be tedious, it takes care to get levels and spillover just right,
and while preset changes are fast, Scene changes are even faster and can be seamless.
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SELECTING SCENES

Different areas of the FM3 provide different ways to select a Scene.
= On the Home page - Use the NAV UP/DOWN buttons or turn knob A. The current scene is highlighted.
(Scene Selection is different in ZOOM mode; see p. 4)
= On the GRID - Turn the Scene knob A. The current scene is shown above the knob.
= Foot Control - The onboard switches of the FM3, or those on a connected FC Controller offer a
range of “Scene” options including automatic scene selection by Song Sections in a set list.
= MIDI - MIDI can be used to change the scene. See “Selecting Scenes & Channels Remotely” on p. 55.

THE DEFAULT SCENE

When a new preset is loaded, it automatically starts on whichever Scene was selected when the preset was last
saved. To set the default scene for any preset, simply select the desired Scene and then save the preset.

If you'd rather override this behavior, you can change the setting in SETUP: Global Settings: Config. Instead of the
default “AS SAVED,” choose any desired scene number, and that scene will be loaded for all presets when they are
loaded.

SETLISTS/SONGS/SECTIONS AND SCENES

The Setlists/Songs feature allows you to create structured lists of presets and scenes to load in a specific order
when you play live. This can be particularly helpful when organizing your sounds for a live performance, as it
enables you to seamlessly transition between different parts of your set without having to manually search for
and select individual presets and scenes.

To learn more about this feature and how to utilize it, please see "Setlists & Songs” on p. 126
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CHANGING CHANNELS

The Channel feature is almost self explanatory. Most blocks have some number of channels (typically four), and
for each channel you can set every parameter of that block to any setting. It's like having multiple blocks in one.
For example, Channel A of a Drive block might be a “clean boost”, B could be a “screamer”, and so on.

While Scenes can't change individual parameter values, they CAN change the channel, and each channel has its
own parameter values.

Different areas of the FM3 provide different ways to change block channels:
= On the GRID - Select the desired block and turn the Channel knob
(B). The current Channel is shown above the knob.

= While EDITING a BLOCK - Press the MORE button (Push-knob E) to show the Scene/Channel strip.
Use the CHANNEL-/+ buttons (Push-knobs C & D) to select a channel.
The current channel is shown near the top center of every page in the Edit menu.

= Foot Control - The onboard switches of the FM3, or those on a connected
FC Controller offer a range of dedicated “Channel” options.

= MIDI - MIDI and other controllers such as a connected external footswitch can be used
to change the Channel. See “Selecting Scenes & Channels Remotely” on p. 55.

SETTING UP CHANNELS

Whenever you edit a block, you are already programming at least one Channel (usually Channel A). Programming
additional channels is easy: simply select the desired channel as described above, set the various parameters to
their new values, and then save the preset.

TO COPY ONE CHANNEL TO ANOTHER...

The Tools page of the Layout menu (“grid”) provides a utility to copy one Channel to another. This works within a
single block only; you can’t copy a Channel from one block to another, or from one preset to another.

Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY CHANNEL" is shown on the display.

Use the D knob to select the scene you want to copy from. Channel letters are shown above the knobs.
Use the E knob to select the location you want to copy to.

Press ENTER or the on-screen EXECUTE button (Push-knob C) to complete the copy.

Test your preset and remember to STORE to make the changes permanent.

Skl wbd=

While you can’t copy channels across blocks or presets on the FM3 itself, you can do this in FM3-
Edit. You can also save the settings for any channel to the Block Library on your computer for
instant recall whenever you need them.
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SETTING UP SCENES

Setting Up scenes is easy. Here are step-by-step instructions:

TO SET UP OR EDIT ANY SCENE...

1. Load the desired preset and select the desired Scene.

2. Bypass or engage each block as desired.
= On the Layout (grid) or while editing any block, use the BYPASS button (Push-knob C).
= Oruse any assigned footswitch or remote controller to bypass/engage the block.

3. Set the Channel for each block as described on the previous page.

4. Test and save your preset. On the STORE page, NAV to any new scenes and name them.

Always test ALL scenes in your preset—even those you think you might not use.

Ensure that there are no unpleasant volume jumps or other surprises in case of accidental mis-steps later.

A good practice for professional environments is to set any un-used scenes to whatever settings would cause the
least trouble if they were recalled accidentally.

COPYING SCENES

The FM3 Layout Tools menu (allows you to copy/paste or swap scenes within a single preset. FM3-Edit also has
these and other functions.

TO COPY A SCENE WITHIN ONE PRESET...

The Tools page of the Layout menu contains a way to copy scenes within a single preset.

Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY SCENE" is shown on the display.

Use the D knob to select the scene you want to copy from. Scene numbers are shown above the knob.

Use the E knob to select the location you want to copy to. You can also choose to copy one scene to “ALL".
Press ENTER or the on-screen EXECUTE button (Push-knob C) and the copy operation is completed.

Test your preset and remember to STORE to make the changes permanent.

> oo s w N

second tool in the same section allows you to SWAP scenes within a preset.

COPYING SCENES BETWEEN PRESETS?

Neither the FM3 nor FM3-Edit can copy a Scene from one preset to another. This is because there is no way to
ensure that the scene would work in the preset you're copying to (it would need to have all of the same blocks and
settings.) You can copy certain parts of the sound of a given scene by copying blocks or channels, but this isn’t
the same thing as copying a scene.
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SELECTING SCENES & CHANNELS REMOTELY

Scenes and Channels can be selected using MIDI or Global Controllers. Several options are provided.

SCENE INCREMENT AND DECREMENT

The Scene Increment and Decrement functions allow you to step up or down through scenes one at a time. You
must first assign each function its own CC# or pedal/switch option in the MIDI/Remote menu under SETUP. The

function is triggered by any value of the controller.

SCENE SELECT

The Scene Select option uses the value of a MIDI controller to select specific Scenes. You must
first assign a CC# to Scene Select in the MIDI/Remote menu under SETUP.

The scene is set by the value of the controller (not the controller number itself... see FAQ below).
Values begin at 0, while Scenes are numbered from 1, so “Value + 1 = Scene number”
(see table 1, right). The series continues, repeating scenes 1-8 across CC values up to 127'.

EXAMPLE: Imagine you want MIDI to select scene 3. Open the MIDI/Remote menu and assign
your desired CC# to “Scene Select”. Let's use CC#34 in this example. To load Scene 3, send
CC#34 with a value of “2" to the FM3 (Scene 3: 3-1=2)

CHANNEL SELECT

This uses the value of a controller to select a specific Channel. Each block has its own dedicated
setting for channel select, found across the listings on the Channel page of the MIDI/Remote
menu under SETUP.

The Channel is set by the value of the controller (not the controller number itself... see FAQ
below). Values begin at 0, which is Channel A, and it continues from there. (See table 2, right).

As with Scene Select (above) the series continues, repeating Channels A-D across values to 127.

1 In mathematical terms, that's Scene# = [(CC Value mod 8) +1]

TABLE 1

CC Values & Scenes
0 =Scene 1
1 = Scene 2
2 = Scene 3
3 =Scene 4
4 =Scene 5
5=Scene 6
6 = Scene 7
7 =Scene 8

TABLE 2

CC Values & Channels
0 = Channel A
1 = Channel B
2 = Channel C
3 =Channel D

o MIDI CC Number and CC Value... What's the difference?
FAQ. MIDI Control Change messages —aka “CCs"— have a number (0-127) and a value (0-127).
The number is like an “ID” which is used to distinguish one CC from another and set its
function in a receiving device. A simple example might be a MIDI expression pedal that sends CC#7 which is
interpreted as “Volume” on the receiving end. The FM3 lets you designate CCs for various controllable items in

several lists found in the MIDI/Remote menu under SETUP.

Once a CC# is set to control a function, the value of that CC tells the function what to do. Some functions—like
Volume— interpret data across a continuous range from 0-127. Other functions—like Bypass—simply toggle

OFF for a low value and toggle ON for a high one. Other functions might be triggered by any value.

Different types of physical controllers transmit values in different ways. A pedal that rocks continuously from
heel-to-toe sends a stream of continuous values from 0-127. A switch sends a single value for OFF (typically

0) and another for ON (typically 127). Other MIDI controllers offer other options.

As described above, both the CC number and its value are the key to selecting Scenes and Channels via MIDI.

55
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PROGRAM CHANGE MAPPING

Another way to select Scenes via MIDI is using PC Mapping, which allows a single incoming MIDI Program
Change (PC) message to select your choice of both Preset and Scene. This is a popular option in cases where
a connected MIDI foot controller lacks the sophistication to transmit the MIDI messages required for scene
selection.

The PC Mapping parameter on the General page of the MIDI/Remote menu under SETUP must be enabled for
custom mapping to be in effect. With this option set to “ON”, an internal table re-maps each incoming MIDI
Program Change message so it can load your choice of preset and scene. The map is limited to 128 entries so
MIDI BANK SELECT messages are ignored while PC Mapping is enabled.

With PC Mapping option set to “OFF”, MIDI Program Changes load presets on a 1:1 basis and Bank Select
commands are processed as usual as per .

BUILDING THE MAP
The mapping table is on the Mapping page of the MIDI/Remote menu under SETUP.

To use it, follow this simple process:
1. NAV to the row for whichever Program Change message you want to re-map.

2. Use the B knob to set the desired value for Map to Preset.
This is the preset that will load when the selected Program Change message is received.

3. Use the C knob to set the desired value for Map to Scene. You can choose a scene by its number, or select
“AS SAVED" to load the default scene saved in your preset. (See p. 52 for more on Default Scene).

4. Repeat steps 2 through 4 for any remaining Program Change messages you wish to remap.
5. EXIT when finished. You do not need to store settings in the SETUP menu.

The custom map parameters remain intact but not active when if you switch PC Mapping Off.

TRANSMITTING MIDI WITH SCENES

The Scene MIDI Block allows each scene can to transmit up to eight MIDI messages.
Learn more in “The Fractal Audio Blocks Guide” on p. 19.
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SCENE LEVELS

Each of the Output blocks includes eight parameters that allow you to cut or boost the level for any scene. Using
these adjustments is a quick way to balance or boost scene levels when other level options are not available.

SCENES, CHANNELS & MODIFIERS

The Modifier system of the FM3 provides extensive automation and remote control options.

Modifiers are detailed in Section 9 on p. 67 but here is a summary of important information about Scenes,
Channels, and modifiers.

SCENE CONTROLLERS

Remember that parameter settings cannot be changed by a scene. Of course, you can change the Channel, but this
is not quite the same thing (it’s also possible that all of your channels are already in use). The Scene Controller
system bridges the gap between these worlds, providing a way for individual parameters or groups of parameters
to have different values in different scenes.

See “Tutorial: Scene Controllers” on p. 76.

CHANNELS & MODIFIERS

By default, any modifiers are shared across all Channels of a block. This is a great convenience in most cases,
avoiding the need to apply the same modifier multiple times as you change channels.

In some cases, you may notice that if you change an effect Type from one channel to the next, certain parameters
are either not present at all, or appear with different names. For example, in the Delay block, the Mono Tape delay
has a parameter called “Head 2 Ratio”, while this same parameter is called “L/R Time Ratio” in the Dual Delay. A
modifier on one will affect both.

The option is also provided to limit a modifier to ONE channel (“A” vs. “All”, for example).
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SCENE REVERT

Scene changes typically persist until you either save them or discard them by loading a different preset. However,
changes made via footswitches or MIDI can behave differently, depending on a global setting called Scene
Revert.

With Scene Revert turned ON, scene changes are discarded as soon as you load a new Scene via footswitches or
MIDI message.

Here are two examples so you can compare how Scene changes work with Scene Revert OFF vs. ON:

Ex 1: SCENE REVERT OFF (default) Ex 2: SCENE REVERT ON

1. You load SCENE 1. DRIVE 1 is OFF. 1. You load SCENE 1. DRIVE 1 is OFF.

2. You turn DRIVE 1 ON with a footswitch. 2. Youturn DRIVE 1 ON with a Footswitch.

3. You change to SCENE 2 with a footswitch. 3. You change to SCENE 2 with a footswitch.
4. You change to SCENE 1 with a footswitch. 4. You change to SCENE 1 with a footswitch.
5. Drive will still be ON, as you last left it. 5. Drive will be OFF as you last saved it.

TO ENABLE/DISABLE SCENE REVERT...

1. Page to the General page of the MIDI/Remote menu under SETUP.
2. NAV to SCENE REVERT and set it “ON" or “OFF" as desired.

3. EXIT to finish. (You do not need to STORE changes in SETUP.)

IMPORTANT: Scene Revert does NOT apply to scene changes from FM3-Edit or the front panel.
This means you won't need to save every single change when using these methods to modify scenes.
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SCENE IGNORE

Scenes are incredibly useful as they allow you to control your entire preset centrally, eliminating the need to “tap
dance” across multiple footswitches when you want to make a total change in your sound. However, they can also
be a double-edged sword, as changing the scene takes control of every block in the preset, setting their bypass
states and channels to pre-saved values. What if you want some parts of your “pedalboard” to be independent of
scenes? Imagine, for example, if your effects were programmed in scenes but your amp channels were controlled
manually.

Firmware 5.03 introduced Scene Ignore, a feature designed to allow more flexible switching. All of the blocks in
your preset with Scene Ignore enabled will operate independently, outside the usual automatic control by scenes.
Scene Ignore can be turned on or off per block, giving you the best of both worlds within any preset. A block with
Scene Ignore ON can still be bypassed/engaged or change channels using a footswitch or any other means of
“manual” control. It functions like an independent pedal or amp.

EXAMPLE

Imagine a tube amp used with a drive pedal, along with a separate “switching system” for wet effects. The amp
will have its own set of footswitches for channels, such as Clean, Crunch, and Lead. The drive pedal can be
stomped on or off. The wet effects system has its own “presets”, like Dry, Light FX (chorus and a little reverb), and
Full FX (Chorus, Delay, and a lot of Reverb). It would be easy to replicate these devices in the FM3, but without
Scene Ignore, the three groups could only be switched together across the eight Scenes. You'd want to change
the amp channel, and the drive and effects would change to the corresponding settings. Enter Scene Ignore!

By setting the Amp and the Drive to Scene Ignore and leaving the effects under the control of scenes, you get
independent “mix and match” switching with a total of eighteen different combinations.

While Scene ignore can work well on any number of footswitches, the illustration below shows an FC-12. Three
different are shown, representing the effects (controlled by Scenes) the Amp block (set to Scene Ignore and
controlled by three different Effect: Channel switches) and a Drive effect, set to Scene Ignore and controlled by
a single footswitch. In this way, the setup operates exactly like an analog amp with a channels footswitch, an
analog drive pedal (stomp on/stomp off) and a programmable effects rack with its own “presets.”

FRACTAL AUD IO SYSTEMS
FC-12 FOOT COMTROLLER

Effect Scenes

( Dry
17\
O

O

Light FX
AN

Full FX
AN 25
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Drive 1
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SCENE IGNORE IS PER-CHANNEL

For blocks that support Scene Ignore, the feature is controlled by the Scene Ignore on/off switch. Since this is a
parameter like any other, Scene Ignore is in fact a per-channel setting.

This allows for a hybrid approach where some channels are set to respond to scene changes while others ignore
them. To better understand this concept, think of the block as a radio receiver. When you select a channel with
Scene Ignore on, the “radio” is switched off, and the block no longer listens to scenes or any changes they could
transmit. The “radio” cannot even be switched back on by a scene, regardless of other settings. However, if you
manually change the block back to a channel where Scene Ignore is OFF, it can once again begin to “listen” to
scenes.

Example: In a Drive block, Scene Ignore is turned OFF for Channels A, B, and C. These channels work in the
classic manner, allowing you to program scenes to control bypass and change the channel. Meanwhile, Channel D
has Scene Ignore turned ON. If any scene selects Channel D (or if you switch to D using a footswitch or any other
means), the block will stop responding to further scene commands. IIf you manually switch the block back to A, B,
or C where Scene Ignore is OFF, it will again begin to “listen” to scene instructions.

f you want a mixed scenario with Scene Ignore sometimes ON and sometimes OFF, you'll need a footswitch or
some other method to change the channel of your block back to one where Scene Ignore is OFF, or else it will
remain stuck in its “Scene Ignore: ON” state.

Extending the example above, imagine that our Drive block is controlled by a footswitch. TAP is set to Bypass, and
HOLD is set to Toggle between Channels A and D. Toggle to A for scene control. Toggle to D for manual control.

TIP: If you always want full scene independence, a good safeguard is to turn Scene Ignore to ON in every channel.
Similarly, if you want a block to be controlled only by scenes, make sure that Scene Ignore is OFF for every one of
that block’s channels. If not, one of them may be selected by a scene and cause that block to stop responding to

subsequent scene changes.
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7 LEVELING PRESETS

This section is divided into two parts. The first is about balancing levels across multiple presets, scenes,
channels, and more. The second part, beginning on p. 65 is about prevent output clipping in general.

Musicians face an almost universal challenge of getting levels “right.” Audiences, bandmates, and live sound
technicians expect a degree of consistency when you present your sound during a performance. Fractal Audio
products give you excellent control over your levels, but even with the right tools, you still need the knowledge

of how to approach this problem. Volume is only a part of the equation, and tone must also be taken into
consideration. Without this understanding, you might think you have things right, only to find yourself lost in a mix

or suddenly too loud. Here are some points to consider.

WHAT TO KNOW...

Human hearing is variable. This due to a phenomenon
called the Fletcher-Munson effect, as represented

by equal-loudness contour curves.In short, when

the volume changes, the tone seems to change too.

At lower volumes, low and high frequencies seem
relatively quieter. As volume increases, bass and treble
frequencies become more prominent.

WHAT TO DO

Adjust at high volume levels as if you were at a
performance. Be on the lookout for tones that are too
boomy or too bright when you turn them up, and adjust
accordingly. Conversely, recognize that changes in
tone can be perceived as changes in volume: “Mids”
can help guitars stand out a mix.

Context is king. When you're in a mix, your tone
can sound vastly different than it does in isolation.
Competing frequencies from other instruments can
impact how your level and tone are perceived.

Check your levels in context of a band or track, and
make adjustments based on what you hear. Also,
beware of constant change: while you have the ability
to create unique sounds for each song, it's usually
better to start with a set of core tones that work well
across your entire set and branch out from there.

Speakers matter... and they vary tremendously.
Different sound systems, even those that claim to be
“flat”, emphasize different frequencies, which alters
tone and perceived volume for a listener. Speakers
also have different directivity, so where you stand
changes what you hear.

Set levels on the same system you will perform with,
or use the best and most accurate speakers you

can find. Be prepared to make adjustments on other
systems. If someone else is mixing, walk around with a
wireless or long cable to see how you sound. Listen to
reference material such as a favorite recording.

Rooms have a sound. Room acoustics play a role

in your tone and levels. The position of the listener
matters, and certain characteristics can change when
an audience occupies the space. Even with high-quality
studio monitors and effective acoustic treatment, most
rooms still have significant dips and peaks in their
frequency response.

Be prepared to make adjustments based on the
acoustics of the room you're playing in to ensure your
sound translates well in the space. Recognize that
acoustical irregularities can influence tone sculpting.
Again, listen to reference material if possible, like they
do when playing a CD to dial in a concert PA.

Gain kills. Excessive gain can muddy your sound and
compress its dynamic range, resulting in a uniform and
less expressive tone that is difficult to distinguish.

Find the right balance. Gain, overdrive, distortion—call
it what you will—it can be great, but handle with care...
and understand that lowering gain can improve your
tone, increase dynamics, and add clarity and punch.

TIP: Throw a Tone Party. Get your bandmates or some local musicians together for a hangout,
offering pizza and beverages as a thank-you for their time while you fine-tune your tones. Prepare
sounds and experiment with different amp models, effects, and settings, then focus on a few core
tones as a foundation. Check out our forum for additional tips and to learn from other musicians.
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A RULE OF THUMB

There are various ways to adjust levels, and they can yield similar results. However, a simple and effective rule of
thumb is to use the Level parameter of the Amp block to make adjustments.

Amp Type Input EQ  Output EQ
Plexi 100W High Scene:1 Chan:A | —
—C 50.0% D ———
Gain Bass Mid Treble Presence
@ You can find the Level control easily
@ - via the front panel on the TONE page
Input . .
Trim Level of the amp block, or in the editor.
(_CHANNEL - ) (CHANNEL + ) (__BYPASS ) (_ RESET ) (_ MODIFIER ) l

A method detailed on the next page outlines a process for adjusting levels across Presets, Scenes, and
Channels. This process includes a shortcut to the amp level, which can be accessed directly from the Layout
menu, streamlining your adjustments.

EXCEPTIONS TO THE RULE

» If you are using Drive in the Preamp section of the Cab, adjust that block instead of the amp.

» When any level-dependent or dynamic effect like a compressor, gate, or ducking effect is
positioned after the amp, it's necessary to adjust the level of that particular block (or one that
follows it) instead of the amp. If not, you'll need to modify any “threshold” parameters that depend
on input levelsif you want to maintain the desired response from blocks after the amp.

» This also applies to any nonlinear effects, such as drive, that might occasionally be placed after the
amp. In these instances, adjust the Level for these specific blocks instead of the amp to maintain
the desired tone and balance -- OR, check your drive settings by ear after adjusting the amp.
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A METHOD FOR LEVELING

The Layout Grid provides an ideal setting for leveling presets, scenes, and channels. From the Home page, press
ENTER to open the layout menu. When you press ZOOM (push knob A), you'll see VU meters for Out 1 and Out 2
at the top of the display. These scale from -20 to +10 dB with a red line at 0 (this is internally, not a dBu reading).

To set levels, play your guitar and watch the VU meters. Edit ) Meters Tools
Adjust the output level of the Amp block by selecting " '
it on the mini grid and turning the Block Level knob (C)
until the level hovers at or below the red line. Different
types of playing and various amp models and settings
will affect the meter differently. Play chords and “chugs”
as their bassy content may push the meters harder. It's
okay to push “into the red” when you do this.

This view also allows you to change Scenes (knob A) or |
change the Channel of the selected block (knob B), so [ A Row Column

. . b . | Z00M J BYPASS DELETE CABLE CONTROLLERS
you can compare and adjust everything within a single e
page. When comparing the levels of different presets/
scenes/channels, play the same type of material while
watching the meters.

The zoomed out Layout Grid shows VU meters at the top.

Note that you can access the level of any block from this view. This makes it easy to deal with presets that may
need a special approach (see Exceptions to the Rule, previous page.)

Remember that meters alone are not sufficient: you must rely on your ears. Listen and adjust accordingly.

LEAD/LOUD SOUNDS

Now that you have a method for normalizing the level across Presets, Scenes, and Channels, you might need to
know how to adjust some sounds to be louder, like a boosted lead. A good approach is to start by setting the
louder sound appropriately using the meters, and then adjust the other sounds to be quieter. This ensures that you
will have plenty of headroom to avoid clipping. It's completely fine for certain tones to read lower on the meters:
Fractal Audio products have an extremely low noise floor and are not prone to the issues that plague analog gear
operating at lower than optimal levels.

CLEAN/SEMI-CLEAN VS. DIRTY SOUNDS

Clean and semi-clean sounds are more dynamic and potentially less compressed than their distorted
counterparts. This means they may require special attention when setting levels. The spiky transients of a clean
sound can cause clipping as you turn up to match more compressed, driven sounds, so to achieve a balanced
mix, you might also need to lower the level of other sounds to suit what you decide is best for your clean tones.

Make it easier to adjust levels by using the Looper block to “play” while you operate the level controls.
Place the looper between the input and your first block.
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BYPASS AND LEVEL

Block bypass settings play a role in managing preset levels. Here are some tips for dialing in effects to keep
levels under control as you bypass or engage blocks:

»

Some effects specifically boost or cut levels. Other times, you want the volume to stay very much the
same as an effect is dialed in. In either case, there’s an easy method you can use to make correct settings.
First, with an effect engaged, set its Mix so the blend of wet and dry sounds just right to you. Then,
Bypass the effect, turning it on and off while you adjust the level until the desired volume is achieved
when the effect is on or off. You can also use a footswitch if one is configured to control the effect.

When placed in series, time-based effects like delay and reverb are usually best with their Bypass Mode set
to “MUTE FX IN”. This ensures that the dry level remains constant when you engage or bypass the block.
Because this setting masks possible changes to your dry level, you should use the Meters page of the Layout
menu to ensure that the level is roughly the same before and after these effects when they are bypassed.

Parallel effects should have Bypass Mode set to “MUTE", “MUTE IN”, or “MUTE
OUT” to avoid increasing the dry signal level when the effect is bypassed.

Pitch and certain other effects require special consideration. Depending on the particular type and settings,
you may wish to treat them like a time-based effect with Bypass Mode set to “MUTE FX IN", or you try a totally
different approach with one of the other settings such as “THRU". Try it and see what works best for you.

The various Bypass Modes are detailed in “The Fractal Audio Blocks Guide”.
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PREVENTING OUTPUT CLIPPING

The method on p. 63 describes how to balance multiple presets but serves as a starting point to ensure that no
single preset clips the outputs of the FM3.

The meters on the layout grid's Zoom view (also shown when you edit an Output block) accurately display the
internal levels of your presets. Generally, you should adjust the output level of your presets until the level hovers
around the red line.

After signal is registered on these meters, the level can be adjusted using the top panel OUT 1 or OUT 2 knobs
before being passed to the output jacks. While the FM3 does not have a top panel output LED meter bridge, it

does have two CLIP warning LEDs. These illuminate when the signal exceeds -1 Decibels relative to full scale

(dBFS). Analog output levels can also be metered on the Meters page of the Home menu.

In general, if your internal levels are in the ideal range, you won't clip the outputs. This is true regardless of the
various /0 settings. If the Out 1 or Out 2 CLIP LEDs do light however, check these things:

= Check preset levels, bearing in mind the points mentioned on p. 63.
= Lower the top panel Out 1 or Out 2 knobs if possible/practical.

= Finally, check the one “gotcha” that hasn’t been discussed yet. The Global EQs (p. 99) affect
signal levels between the grid and the outputs. If your EQ settings are causing an excessive
boost, you can easily clip the outputs when other options all appear to be set reasonably.

F AQ. WHERE SHOULD I SET THE TOP PANEL OUT KNOBS?

® There is no one-size-fits-all answer to this question, but some general guidelines apply.
The setting for Out1 will depend on what you have it connected to. Always begin with the level knobs
turned all the way down when testing a new setup, increasing it gradually until the desired output level is
achieved. The “typical” range for most setups is probably somewhere between “9 o'clock” and “3 o'clock”.
If your connected downstream device has meters, these can help you to adjust the FM3. Remember also
that Out 1 has settings for +4 dBu and -10 dBV, which should be set according to the input sensitivity of your
downstream device. Note that this setting will not affect metering or clipping on the FM3.

Output 2, on the other hand, has settings for LINE LEVEL or UNITY GAIN types. You need to choose the
correct one for your setup (as described in Section 4). The notes for OUT 1 apply to OUT 2 in LINE
LEVEL mode, but special consideration is required for UNITY GAIN setups. The points in this chapter still
apply, with the exception that you would not set internal levels using the Out 2 meter, but based on the
special design of your unity gain presets, with the Out 2 knob turned fully clockwise.
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The FM3, the FM9, and our flagship rackmount processor, the Axe-Fx Ill, all share a common foundation. These
devices utilize presets constructed from blocks, most of which are identical or very similar in terms of parameters
and settings across the three devices.

A comprehensive manual dedicated to these blocks is available, offering more than just reference material. It
delves into background information, provides helpful tips, and includes additional resources to ensure you fully
harness the capabilities of your Fractal Audio product.

The Fractal Audio Blocks Guide can be downloaded from https://www.fractalaudio.com/fas-bg

Srracra

BLOCKS GUIDE
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plocks and Parametarg
Axe-Fu il

FM9
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9 MODIFIERS

Modifiers are among the most exciting features on the FM3, offering real-time remote control or automation

of sound parameters. They enable many possibilities, such as using an expression pedal to operate a wah or
whammy, employing an LFO (Low Frequency Oscillator) for auto-sweeping a filter, or utilizing MIDI to adjust
effects, control volume, and more. While easy to use, modifiers provide an incredible depth for those who enjoy
creative freedom and like to push the limits of sound design.

CREATING A MODIFIER

The process of creating a modifier starts at the parameter you want to control. Parameters that support
modifiers are marked with a yellow circular symbol (illustrated below). When a modifier is already assigned, the
circle appears solid yellow, like an LED that's turned ON. This symbol is visible regardless of whether the target
parameter is on a knob page, a text page, or any other type of menu.

() ()

Balance
The open circle The filled circle  Here, a switch This parameter
meansyoucanadda  means amodifieris  instead of aknob  has no option for a
modifier here. already present. allows a modifier. modifier.
TO CREATE A MODIFIER...

» Select any parameter that supports a modifier. E
» Press the ENTER button or press the MODIFIER button (Push-knob E) to show the Modifier menu.

» The Modifier Source page will appear. Select the SOURCE you want to use to control the
parameter — for example, “PEDAL 1”. Learn more about Sources on p. 69.

» Next, press PAGE RIGHT to switch to the Modify page (you must select a source first!)

» Set the parameters as desired. Learn more about Modifier parameters on p. 70. If nothing else, check
that MIN and MAX are set to the lowest and highest values you want to hear as the source changes.

» Press EXIT to leave the modifier menu. You will notice that the dot is now solid.

» Modifiers will animate on-screen knobs, faders switches and graphs.
For text-only menu parameters, a bar graph shows the value of the source.

» You must STORE the preset to save any modifier changes.

TO EDIT OR REMOVE A MODIFIER...

» To edit an existing modifier, use the same process as creating a modifier.
» To remove a modifier, change its SOURCE to “NONE".
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MODIFIER TUTORIAL: WAH PEDAL

Below you will find a basic step-by-step tutorial on setting up the modifier for a Wah pedal.
For this example, let's assume:

= A Wah block is already in your preset.
= You have an Expression pedal ready (see “Expression Pedals” on p. 12).

Here are the steps:
1. On the Layout Grid, NAV to your Wah block and press EDIT to show its menu. @
Page to the Config page of the Wah block’s Edit menu.

Wah
Notice the yellow modifier dot symbol beneath the on-screen Wah Control parameter. ISslal{fs]

Press ENTER or MODIFIER (Push-knob E) to show the Modifier menu.

On the Source page, change the SOURCE to your pedal. Depending on how your pedal is connected this
might be “Pedal 1 (Exp/Sw Tip)” (the on-board expression jack of the FM3), or it might be one of the
“External Controllers” (p._75), or it might be one of the “FC” pedal options.

2
3
4. NAV to select that parameter (or just give its knob a twiddle). It will be highlighted (blue) when selected.
5
6

7. Test! The Wah should work when you move the pedal. You'll also see the dot move on the graph. If it
doesn’t work, check your source or make sure the pedal is properly connected and calibrated.

8. Save the preset by pressing STORE, ENTER, ENTER.

The Wah in this example is controlled by an expression pedal. An expression pedal can be used to control other
parameters like whammy control, rotary rate, delay feedback, and many more.

There are also many different sources we could use instead of a pedal. Try an LFO for a modulating auto-wah, or
an Envelope Follower for some funky Mu-Tron action. MIDI opens up a world of controller options.

MODIFIER TIPS AND TRICKS

= The same source can be assigned to multiple modifiers at the same time. For example, one pedal
might adjust Chorus Rate and Chorus Depth at the same time — even in different ways.

= The modifiers for a given block will normally be shared across all of the channels of
that block, but you can also limit a modifier so it applies only to any one channel, your
choice. Change the “Channel” setting inside the Modifier menu to do so.

= Modifiers use a very small amount of CPU power while you use them
Test any presets which seem close to the edge.

= Scenes cannot change block parameters, but Scene Controllers can. Four different knobs can be used
with modifiers to change the value of desired parameters. See the tutorial on p. 70 for more on this.

= Any block that can be bypassed also has a Bypass parameter that allows you to assign a modifier. (The
modifier is placed on Bypass and not Bypass Mode as it was on some previous Fractal Audio products.)

= Internal Controllers are used as modifier sources, but these also have many parameters of
their own which can be controlled by a modifier. For example, one LFO can control the rate or
depth of another one. An Envelope can turn the Sequencer on or off. A Scene Controller can
cause an LFO to start or stop. The potential for creative effect processing is immense!

68
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MODIFIER SOURCES OVERVIEW

There are in fact over 60 different choices to use for modifier sources. Learn about them in this overview.

INTERNAL CONTROLLERS LFO 1 LFO 2 ADSR 1 ADSR 2

A A

Internal controllers are built into the FM3 and can be directly |\ /N\/\| /NN [/R——| |

assigned to control any parameter that accepts a modifier.
These internal controllers have a dedicated menu for easy
access.

Sequencer Pitch Envelope Scene Ctrl

To access the Controllers menu, press the CONTROLLERS 860506 T = |] 8888
button found on the Home page (Push-knob C) or Layout =
menu (E), or press the TEMPO button once.

Although it doesn’t appear as a block on the layout grid, all Internal Controllers belong to a “Controllers block.”
With four channels at your disposal, you can utilize up to four different sets of Controller values within a
single preset. These controllers include Tempo, two LFOs (Low Frequency Oscillators), two ADSRs (envelope
generators), a Sequencer, an Envelope Follower, a Pitch Follower, five Manual Controllers, four Scene
Controllers, and six Control Switches. See p. 73 for more on internal controllers.

ONBOARD & FC PEDALS & SWITCHES 2 AL
The onboard Pedal jacks of the FM3 and the Pedal or SW|tch

jacks of a connected FC series controller can be assigne

directly as modifier sources. In comparison to previous . . . .
products, it is no longer necessary to assign these to an

External Controller first (though this is still possible). PEDAL

On the FM3, you will find two options per pedal jack: one for
Expression or Switch Tip and another for Switch Ring.

EXTERNAL CONTROLLERS

External Controllers are like Internal Controllers in that they can be assigned to control any parameter that allows
a modifier, providing dynamic control over various aspects of your sound. External Controllers are unlike Internal
Controllers in that they function as intermediary modifier sources. Rather than having settings or a value of their
own, they connect external MIDI, physical pedals, switches, or other hardware, to parameters within the FM3.
Each of the 16 external controllers has a unique global setting that determines what controls it. You can set an
External Controller to be controlled by:

= Any MIDI Control Change (CC#) message.
*  One of the onboard Expression (Pedal/Switch) jacks.
=  One of the Pedal or Switch jacks on a connected FC series controller.

Learn more about External controllers on p. 75.

Internal Controller or Onboard Exp Jack External Controller
Source Parameter Something external Source Parameter
(e.g. "LFO 17) (e.g. MIDI CC#16) (e.g. “External 17)

As modifier sources, internal controllers directly control parameters,
while external controllers serve as intermediaries, connecting external devices or MIDI streams to parameters.

69
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MODIFIER PARAMETERS

The default modifier settings are linear. You change the source and the parameter follows in direct relationship.
Modifier parameters allow you to change this relationship. You might tune the taper of a pedal, or make it work in
reverse. Maybe you want the parameter attached to a footswitch to glide instead of snap. Here is an overview of
the additional parameters you can use to create these effects and many more. Find these options on the Modify
page when you set up any modifier.

Min and Max determine the range of parameter change. These are extremely important parameters.

EXAMPLE: The modifier for a pedal controlling Delay Feedback has Min at “10%" and Max at “50%". The
feedback sweeps only from 10% to 50 as the pedal is moved, even though this parameter’s actual range is
from -100% to +100%.

Start, Mid, End, Slope, Scale, and Offset are used to create custom curves which re-map the relationship
between the modifier source and the value of the target parameter. On the Modify page, a graph shows the
relationship between the source (x-axis) and the parameter (y-axis). A dot on the graph tracks the source.

The default settings (first graph below) create a 1:1 linear relationship (the blue line) between source and
parameter. As the source changes, the parameter tracks it directly.

The second two graphs below show examples of the kinds of non-linear curves you can create using Slope, Scale,
and Offset. The pages which follow contain more examples.

Parameter —»

Sourée—»

Attack and Release: These values apply “damping” to slow the rate at which the target parameter value chases
the source. Attack determines the rate of change as the source is increased, and Release controls the rate as it
decreases. At low settings, these add just a little smoothing. Try settings of about 5 ms to “relax” a pedal or to
ease the edges of a square LFO to eliminate clicks and pops. Higher settings can cause sound changes to be
extremely slow and lazy.

Auto-Engage works with Off Value to create effects which turn ON or OFF automatically whenever the source
controller is moved. This is typically used with a Wah pedal so you don't need a toe switch. (Follow the example
on p. 68 and set AUTO-ENGAGE to “SLOW POS" to try it out!) Find additional information on Auto-Engage on p._
12.

PC Reset sets the value of an external source when a preset first loads. This allows you to override the actual
position of an external controller until it is moved or updated. Here's how it works: after applying the modifier,
exit to the parameter again on its Edit page. Notice that the value of that parameter can be edited as usual. If PC
Reset is ON, the value you set and then save will be used from preset load until the source is changed (i.e. the
pedal has been moved).

Update Rate controls how often the modifier is refreshed. The setting of slow is actually very fast, and fine for
the vast majority of applications. The faster settings require additional CPU but provide even smoother sound
performance when ultra fast changes are required (while using a fast LFO for instance). Check this setting if you
think you hear “zipper noise” while a modifier is in use.
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UNDERSTANDING MODIFIER MIN AND MAX

MIN and MAX set the range of a modifier. This lets you fine-tune modifiers in very cool ways. In the example
below, imagine a volume pedal with different settings. Using the principles on this page, you should be able to
achieve a wide range of modifier control scenarios.

Mid: 50.0%  End: 100.0%

- x Max: 10.0
: The pedal “start” (heel position) sets the volume to

. Min: 0.00; silent. The pedal “end” (toe down position)

has the volume at Max: 10 or all the way up.

As you rock the pedal forward, the dot follows the line.

It moves up as it goes and the volume does too.

Here is your basic “vanilla” volume pedal.

Start: 0.0%
‘ Min: 0.0

Max: 10.0

Now, something different: a “boost” pedal with Min set
to 8 and Max still at 10. In the heel position, the volume
will go only as low as 8, instead of 0 as in the previous
example.

Here is a different twist: Min is at 10.0 — the loudest
setting, while Max is at 0.0 — silent.

It looks the same, but this is a reverse volume pedal!

Min: 10.0

USING “MID” TO CREATE BASIC CURVES

Let's imagine a modifier on the feedback of a delay to demonstrate changes to response curves. By now you
should be familiar with the default settings, so let’s skip right to the curved version:

Mid: 25.0% End: 100.0%
\ h Max: 100% As we adjust Mid, the graph shows the curve. At 25%,
5 5 x Max: ° the response is “tapered” so that with the pedal half
| way forward, Feedback is only 25% between Min and
Max.

This type of curve provides gradual control of feedback
: across the lower end of the range, and then a more
v Min: 0% rapid change towards the top.

Start: 0.0%
<€
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ADVANCED MODIFIER CURVES AND SHAPES

You can also adjust Start, End, and Slope (which introduces an “S” or “backwards S” shape). The numbers
beneath each example below show the settings for Start, Mid, End and Slope. With a bit of experimentation, you
will learn to achieve desired modifier effects quickly. Try dialing in the shapes below for practice:

0,75100 50 100,50,0 50 0,100,0 50  0,50,100 0 050,100 100 0,25100 10

Scale and Offset also re-map modifier response. Scale adds vertical exaggeration or compression, while Offset
moves the entire curve up or down on the Y-axis. Segments outside the graph boundaries will be clipped and
replaced by line segments. The examples below show some interesting possible applications.

: : : : 1
5 5 START:  0.0% START:  0.0% START:  47.2%
cereernsseeifflenssnnnnnnns ............. MID: 50% ............. ............. MID: 50% .............. ........... .| mID: 0%
5 5 END:  100% END:  100% END:  60.6%
........................................ SCALE: 2.0 oo | SCALES 0.0 ) Ef..|| SCALE: 10.0
OFFSET: 100% OFFSET: 0% OFFSET: -100%

AUTO-ENGAGE TURNS EFFECTS ON/OFF AUTOMATICALLY

If you have used a Wah pedal with no toe-switch, you will instantly understand the principle of “auto engage.” This
type of Wah turns on automatically when you rock it forward it and then bypasses when you pull it back. That's the
idea behind Auto-Engage.

Auto-Engage engages or bypasses a block when the Source of a modifier changes. Once you try it, we believe you
will quickly find that this capability comfortably eliminates the need for expression pedal “toe” switches.

Set it up using two parameters on the Modify page:

Auto-Engage - Determines whether or not the block will automatically engage or bypass. FAST, MEDIUM and
SLOW settings determine how quickly the effect turns ON/OFF once Auto-Engage is triggered. Use SLOW settings
to “relax” auto-engage, so your effect doesn't switch off too suddenly while you're still using it.

= The three POSITION (“POS") options trigger the effect based on OFF VALUE (see below).

= The three SPEED (“SPD") options engage the effect when the controller is moved quickly.

= Set to “OFF” to disable Auto-Engage.

Off Value - Sets the position threshold that the source must cross for auto-engage to occur. When Off Value is
set below 50%, the effect is bypassed when the controller goes below that value. If Off Value is set to 50% or
higher, the effect is bypassed when the controller goes above that value.

For “heel down = bypassed”, set to 5%. For “toe down = bypassed”, try 95%.

MODIFIERS AND CHANNELS

A modifier is normally shared across all of the channels of the block where it exists. However, you can also limit it
to operating on just a single channel—your choice—using the Channel parameter in the modifier menu.

12




INTERNAL CONTROLLERS

Internal Controllers can be programmed per-preset for use as modifier sources. To access these parameters,
push the CONTROLLERS button on the Home page (Push-knob D) or press TEMPO.

9 MODIFIERS

TEMPO Tempo appears in the Controllers menu. For more information, see Section 11: Tempo.

LFO1 + LFO2 LFO
A Low Frequency Oscillator (“LFQ")

generates control signals in the form of a

variety of periodic wave shapes. Examples of LFOs
in use include the pulse of a tremolo, the back and

forth sweep of a phaser, or the random filter in Ship
Ahoy by Frank Zappa.

Type sets the waveform or shape. You can set the
Rate or lock the LFO to the current Tempo. You can
vary the overall Depth and Duty, or symmetry. The
Run parameter starts and stops the LFO. This can be
used to keep it from drifting out of time.

Each LFO outputs “A” and “B” signals, each of which
is an independent modifier source on the list. You
can change the Phase of output B with respect to A.

Quantize changes smooth waveforms into stepped
ones. Try it on the “TRI” waveform for example.

SEQUENCER

The Step-Sequencer generates control patterns by

looping through 2-32 “stages.” You set the
Value for each stage, the Number of stag-

Sequencer

QOO000
0000660

es, and the Rate or Tempo. The Run switch

allows you to start or stop the sequence.
Damping slurs the change between steps.

ENVELOPE FOLLOWER

This converts input level to a control signal, respond-

ing variably to your playing dynamics. The

Envelope
Follower

C—1

classic application is a touch-wah, where
the frequency of the wah varies based on

how hard you pick. You can set Attack and

Release times independently, set the trigger Thresh-
old, and adjust the Gain at the trigger signal input,
which can be set to Input 1 or Input 2.

ADSR

ADSR1 + ADSR2

The two ADSR sources are envelope S
generators with Attack, Decay, Sustain

and Release parameters (thus “ADSR”). The ADSR
is triggered whenever the signal level exceeds its
Threshold measured at the selected input (1 or 2).
The envelope has three self-explanatory modes
(Once, Loop, and Sustain) and can optionally be set
to Retrigger every time the threshold is exceeded.

In comparison to the Envelope Follower, the ADSR
envelope generator always creates the same control
signal, but only triggers when you play hard enough.

PITCH DETECTOR

Pitch
Detector

The Pitch Detector analyzes the pitch of

: RERANRN
your playing and outputs a low value for
low notes and a high value for high notes.
SCENE CONTROLLERS ry—
The four Scene Controllers provide a way 8888
to change sound settings from one Scene

to another. Think of each Scene Controller

as a “virtual knob” whose setting can programmed
with a different value in every Scene. By assigning
this knob as a modifier source, you can create “per-
scene” parameters.

For example, you might assign Scene Controller 1 to
Input Drive in the Amp block with a value of 10% in
Scene 1, 50% in Scene 2, 75% in Scene 3, and so on.

As with any source, a scene controller can be
assigned to multiple parameters at the same time,
each with its own modifier settings.

A Scene Controllers tutorial appears on p. 76.
For more on Scenes, see Section 6 on p. 51.

See also Manual Controllers and Control Switches, next page.

way to copy/paste Controller channels.

13

The Internal Controllers menu offers four channels for four sets of independent settings for ALL of
the items listed above: four tempos per preset, four sequencer settings, etc. When you change the
channel, ALL of the controllers switch to the new channel and the new settings. FM3-Edit provides a
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MANUAL CONTROLLERS

The five Manual Controllers are virtual knobs with no function other than to serve as modifier sources. A Manual
controller makes it possible, for instance, to create a “super control” where one knob operates multiple sound
functions at the same time. For example, you might assign delay mix, reverb time and chorus depth parameters
— all at the same time — to the “Manual 1" modifier source. Now, when you adjust Manual 1, all of the above
parameters will change simultaneously as desired. Another good use for Manual Controllers is to simulate an
expression pedal when you do not have one handy.

In this tutorial, we will set up a Manual Controller to adjust the Feedback and Mix of a delay block. Load factory
preset 022 Super Verb.

1. The first step in using a Manual Controller is to assign it as a Modifier Source to the parameter of your
choice. Enter the Layout grid of the preset, navigate to the Delay block, and press EDIT.

Use the PAGE buttons to locate the Config page of the Delay block.

NAV to the Feedback parameter and notice the open yellow modifier “ring” beneath the knob.

With the Feedback parameter highlighted, press ENTER to display the Modifier menu.

On the Source page, select Manual 1.

Page right to the Modify page. Set Min to 0% and the Max to 50%

Press EXIT to return to the Delay menu. Notice that the open modifier symbol is now a solid yellow dot.

NAV down to the Mix parameter and press press ENTER to display the Modifier menu.

© o N o g bk W D>

On the Source page, select Manual 1.

10. Page right to the Modify page. Set Min to 5% and the Max to 75%

11. Now let's try the Manual Controller. Press HOME to show the home page.
12. Press the CONTROLLERS button (Push-knob C).

13. Use the PAGE buttons to locate the Manual page of the Controllers menu.

14. Turn knob A to adjust Manual 1 and listen to your delay settings change. As the knob approaches 100%, the
Delay mix increases (louder echoes) and the Feedback increases (more repeats).

15. Press STORE, ENTER, ENTER to save your work. Not only will all of the modifier settings be saved, but the
position of the Manual knob as well.

CONTROL SWITCHES

The six Control Switch sources are used with the onboard footswitches or an FC controller. For more information,
please refer to “The Footswitch Functions Guide” on p. 20.
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METRONOME

A metronome is included for convenience. The Metronome is not technically a controller, but its settings are
accessed through the Tempo page of the Controllers menu. To enable the metronome press the Tempo button
and adjust the level for the desired output(s). Note: the metronome levels persist across presets and are reset to
OFF at power on.

EXTERNAL CONTROLLERS

External Controllers are modifier sources that are in turn controlled themselves via external MIDI or a connected
expression pedal or switch. For example, if the source of a modifier on a Wah effect is set to “External 1" and
External 1 is set to “MIDI CC#16"; a connected MIDI expression pedal transmitting CC#16 then operates the Wah.

The global assignments for External Controllers are set on the External Control page of the MIDI/Remote menu
under SETUP. You can assign a MIDI CC#, an on-board Expression pedal or switch, or a Pedal or Switch on a
connected FC series controller. Choosing an External Controller as the source of your modifier is the same as
assigning any other source (see “To Create a Modifier...” on p. 67). To change which CC# or pedal/switch
operates an External Controller:

1. Open the MIDI/Remote menu in SETUP and page to External Ctrl.

2. Use NAV to select the External Controller you want to change (ex: “External Control 17).
3. Use VALUE to change the assignment. You can also select “NONE" to disable the selected controller.
4. EXIT when finished.

EXTERNAL CONTROLLER INITIAL VALUES

External Controllers assigned to MIDI are given a value of “0” until some MIDI data is received to change them.
You can imagine how a missing or broken MIDI controller might therefore present a big problem...

The External Controller Initial Value parameters can change the startup value for a controller to 100%. Then,
when the FM3 is powered on, any modifiers assigned to the missing controller will be all the way up instead of all
the way down. To change the initial value for an External Controller:

» Page to the General page of the MIDI/Remote menu under SETUP.

» Use NAV to select to whichever controller you want to change (ex: “External Control 1”).
» Use VALUE to change the setting.

» EXIT when finished.

MODIFIERS LIST

The last page of the Controllers menu lists all of the modifiers in the current preset. You can jump to edit each
modifier from this list by pressing ENTER.

As you'll gather from looking at the list, the maximum number of modifiers per preset is 24.
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TUTORIAL: SCENE CONTROLLERS

In this tutorial, we will set up a Scene Controller to adjust the Input Drive of an Amp block. While it is easy enough
to achieve different amp sounds within a preset simply by switching the channel, this example provides an
excellent and easy way to understand how Scene Controllers work.

We will begin with the Wrecker Rocket preset (#030), though ANY preset with an amp block could be used. For
this example, we chose an amp model where the Drive parameter setting will be more pronounced.

Load the factory preset “#030 Wrecker Rocket.”

1.

o oA w N

11.

12.

13.

14.

15.

16.
17.
18.

19.

The first step in using a Scene Controller is to assign it as a Modifier Source to the parameter of your choice.
Enter the Layout grid of the preset, navigate to the Amp block, and press EDIT.

Use the PAGE buttons to locate the Tone page of the Amp block.

NAV to the Input Drive parameter and notice the open yellow modifier “ring” beneath the knob.
With the Input Drive parameter highlighted, press ENTER to display the Modifier menu.

On the Source page, use the NAV buttons to select Scene Controller 1.

For this tutorial, you don’t need any custom settings on the Modify page, so press EXIT to return to the Amp
menu. Notice that the open yellow modifier symbol is now a solid yellow dot.

Now let's set the values for our Scene Controller; press HOME to show the home page.
Press the CONTROLLERS button (Push-knob E).
Use the PAGE buttons to locate the Scene Ctrl page of the Controllers menu.

. Reading down, the Controller 1 column shows eight different values. These will set the value for our target

parameter in each of the eight scenes. You can dial in these values now...

...but it’s better if you change scenes as you dial things in! Press the MORE 1 of 2 button (Push-knob E) to
reveal the Scene +/- and Channel +/- functions for the five push knobs.

Notice the that the current scene is shown above the table at the top of the page. If this isn’t “Scene 1", use
the Scene +/- buttons now to select Scene 1.

Dial in the Scene Controller 1 value for Scene 1. Let's set it to about 20% for a “cleanish breakup” type of
sound. Use your ears!

Use the Scene + button (Push-knob B) to switch to Scene 2.

NAV Down to select the Scene 2 row in the Controller 1 column. Dial in the Scene Controller 1 value for
Scene 2. Let's set it to about 45% for more crunch. Again, use your ears.

Using the process in the previous step, set the value for Scene 3 to 75% and Scene 4 to 100% (or as desired).
Press HOME to return to the Home page. Test your first four scenes using the NAV UP/DOWN buttons.

Press STORE, ENTER, ENTER to save your work. If desired, enter Scene Names as outlined in “Saving
Changes” on p. 49.

Feel free to assign other Scene Controllers to other parameters in your preset as desired.

TIP: Most people find that FM3-Edit makes this process even easier, with all scenes and scene controller changes
just one or two mouse clicks away. Find the Scene Controllers in FM3-Edit under the “CONTROLLERS” section
below the main FM3-Edit logo.
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LAYOUTS

The FM3 organizes footswitch operation through Layouts.

A layout consists of up to 12 footswitch definitions, each with one Tap function and one Hold function. A
foiotswitch definition also determines the color of the switch’s LED ring and the content of messages shown in
the mini display for Tap and Hold functions.

Switching between layouts is key to the the versatility the FM3. While there are various ways to switch layouts, the
built-in Master Layout Menu (MLM) is particularly powerful, providing easy access to all of the available layouts.

The ability to define different layouts allows you to create flexible setups with a range of footswitch capabilities.
For instance, one layout could be used for selecting Presets, another for Scenes, and yet another for switching
Effects on or off. To help keep things organized, layouts have their own names.

The FM3 offers eight customizable layouts, plus one special layout called the Master Layout Menu. Assuming you
are using the factory default settings, you can display the Master Layout Menu by pressing and holding the middle
footswitch. For an introduction to its use, see “The Master Layout Menu” on p. 10.

While not performing, you can easily change the layout on the FM3 itself by turning the FC Layout knob on the
Home page (Knob E). The number of the current layout is shown in parentheses.

It is important to note that the onboard layouts are shared by the FM3 itself and any connected FC Controllers.
Different devices operate independently, so the FM3, for example, might be on a Presets layout which a connected
FC-6 is on a Scenes layout. An advanced capability called “Layout Links” , however, allows a footswitch on one
device to change the layout on another. (This feature is key to the operation of a popular setup called the OMG9,
consisting of an FM3 and an FC-6.)
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FACTORY DEFAULT LAYOUTS

Factory default settings for the FM3 include various pre-defined layouts: one for selecting presets, one for
changing scenes, one for effects, one for the looper, and so on. These are illustrated on the following page.

The Factory default layouts are designed to be simple. The idea was that they should require almost no
explanation, so someone using the FM3 for the first time could easily understand its capabilities. In fact there is
no such thing as an ideal layout—no “one-size-fits-all” solution. Those who desire to make changes will find it is
very easy to change any switch on any layout to perform any function.

RESETTING THE FACTORY LAYOUTS

The FM3 includes a utility to reset the FM3 Factory Layouts. You can do this any time you want to erase any and
all changes you've made to the layouts, whether because you get stuck or simply want a fresh start. To do this:

» Open SETUP: FC Controllers/Onboard Switches
» Page to the RESET page

» Select the desired option (future firmware versions may allow more than one
choice) and press ENTER to Load FM3 Factory Default Layouts.

» Press ENTER again to confirm.
» Press HOME to exit.

WARNING! When you perform Reset System Parameters under SETUP: Utilities,
this clears all of the layouts too.



FM3 FACTORY LAYOUTS

1. PRESETS
( TAP:P1 I TAP:P2 I TAP:P3 J
Hotp: Bank-1)  Howo:mum | wow: Bank+1
2:SCENES
( AP:-S1 I TAP:S2 I 7AP:S3 J
Hop: View -1)  Hoto:MM |Hovo: View +1

Three Views cycle through the remaining scenes: [4,5,6] then [7,8]
The unused switch contains a TUNER.

3:EFFECTS

ap:Drive 1 | 7ar: Delay 1 {ap: Reverb 1
Hotp: View -1]  Howo: M JHowp: View +1

Four Views cycle through three effects each:

[Chorus 1, Flanger 1, Rotary 1] [Pitch 1, MultiDly 1, Plex 1] [Comp?1, Phaser 1, TremPan1]

4:CHANNELS
.
AP AMP 1A | 1ap-AMP 1B | 1a».AMP 1C
HoLp: View -1} Howo:miv - AHovo: View +1
The Views cycle through channel switches for four different effects:
Amp 1, Drive 1, Drive 2, Delay 1

5:LOOPER

tap:Record |1ar:Play/Stop]| Ttar:Undo
Howp: View -1]  Hotp:mim — JHowo: View +1

A second View contains tap functions: ONCE, REVERSE, and HALF SPEED.

6:PER PRESET

Tar:PP1Tap | tar:PP2Tap | tar:PP3Tap
Hotp: View -1]  Hoto:Mim— JHoup: View +1

Four Views cycle through 12 total Per-Preset Tap “Placeholder” functions.

Per-Preset Hold functions are not supported in this layout.

7:PERFORM
(] nn)

8:UTILITIES
ERENES
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Layout 1: Presets is designed for switching presets. It shows
three presets at once, with press and hold functions for BANK
UP and BANK DOWN on the left and right switches.

Hold the middle switch for the Master Layout Menu (MLM).

Layout 2: Scenes shows scenes 1, 2, 3, with hold functions
on the left and right switches to change the “View” to show
scenes 4, 5,6 or 7, 8, and Tuner.

Hold the middle switch for the Master Layout Menu.

Layout 3: Effects is used to engage or bypass effects. The
defaults are Drive 1, Delay 1, Reverb 1, with hold functions on
the left and right switches changing the View to reveal other
effects as shown.

Hold the middle switch for the Master Layout Menu.

Layout 4: Channels is used to change the channel on
designated blocks. The default is AMP 1 (A, B, C) with hold
functions on the left and right switches changing the View to
reveal other effects as shown.

Hold the middle switch for the Master Layout Menu.

Layout 5: Looper offers essential Looper controls.
Hold the middle switch for the Master Layout Menu.

Layout 6: Per-Preset shows the first three per-preset switches
(“placeholders”) with hold functions on the left and right
switches changing the View to reveal a total of 12 per-preset
switches. You will need to add per-preset switch definitions
(see p. 87) for this layout to work. The first few factory
presets include some of these as examples.

Hold the middle switch for the Master Layout Menu.

Layout 7 is an example to accompany a short tutorial. It
represents one possible idea for a simple FM3 performance
layout. There is no switch in this layout to return to the MLM,
though you can easily add one yourself or use the front panel
“E” knob.

Layout 8 contains utilities: Tap Tempo and Tuner.
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TAP & HOLD FUNCTIONS

Every switch in every layout can be programmed with its own individual TAP and/or HOLD functions.

Tap functions have been used throughout history for guitar effects and beyond. They are best for changes that
require tight timing. For example, a tap switch set to select a new Scene so you can change the sound precisely

as a new musical section begins.

Hold functions require a “long press”. They fire after a brief delay, so their timing is less precise. Hold switches
are perfect for functions like opening the Tuner or accessing an alternate layout, but they can also be thought of
as a way to expand the foot switch “real estate” of the FM3, by adding hidden functions beneath each tap.

THE RULES OF SWITCH TIMING

Like every product with “Tap or Hold" footswitches, the FM3 needs to determine whether a switch is being
tapped or held. It accomplishes this by measuring the duration of the switch press. If the press exceeds a certain
“timeout” window, the hold function is triggered. If the switch is released before the timeout, the tap function is
activated. It's crucial to understand that the presence of a hold function causes the tap function to be triggered
upon release of the switch, rather than when initially pressed.

TIMING FOR A TAP FUNCTI
WITH NO HOLD FUNCTION

v

The Tap function fires at the
moment the footswitch is
depressed.

TIMING FOR A TAP FUNCTION
WITH A HOLD FUNCTION

Press and Hold Timeout
(0.50 seconds by default)
—

VA

The Tap function fires when
you release the switch, as long
as this happens before the
Press and Hold Timeout.

If not, the Hold function
eventually fires when the
timeout is reached.

If you need tight timing from

a Tap switch that has a Hold
function, tap and release
quickly—even a fraction of a
second early, knowing that the
change will occur as your foot
comes up.

TIMING FOR ANY
HOLD FUNCTION

Press and Hold Timeout
(0.50 seconds by default)
—

% A

When you hold a switch, its HOLD
function fires once the Press and
Hold Timeout runs out—whether or
not the switch has a Tap function.
The Tap function does not fire.

You can change the duration of
this timeout under SETUP: FC
Controllers...: Config. The default
is 0.5 seconds. he default duration
is 0.5 seconds. If you find that
you're unintentionally activating
Hold functions when you're trying
to activate Tap functions, increase
this duration. Conversely, if you
want to activate Hold functions
more quickly, decrease this
duration. You can also set this
parameter to only activate once
you release the switch, giving you
precise control over the timing of
Hold functions.
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EASY (“EZ") EDITS

As you use the FM3, you may find that you wish to customize or even completely replace the factory footswitch
layouts. There are various ways to do this, but perhaps the easiest is the “EZ" edit page. With the EZ edit page,
you can easily modify the Tap or Hold functions for any switch, and even customize the ring color or label. To use
this feature, you don't need to delve through menus or layouts -- simply tap the switch you want to edit and begin!

IMPORTANT: To avoid annoying screen jumps and sonic mishaps, all footswitches are DISABLED
while you are on the EZ page. To test switch edits, change to a different menu page or press EXIT.

TO USE THE EZ EDIT PAGE:
» Open SETUP: FC Controllers/Onboard Switches and page to the “EZ” tab if it isn't already selected.
» Tap the footswitch you want to edit.

» An onscreen graphic shows which footswitch you have selected.

FC Controllers EZ

Tap any footswitch to see its settings below.

Layout 1: PRESETS
View 1
Switch Ring Color Default

Category Preset
Function Select by #
Preset 1
Mini-Display Label Name

Category Unassigned
Function =

C Nav Value
RESET SWITCH | COPY SWITCH | | PASTE SWITCH

» You can edit both TAP and HOLD functions for any switch.
» Use the A knob or NAV buttons to navigate the list or parameters and C or VALUE knobs to make changes.
= Set the desired Category and the Function.

= Set any parameters for the selected Function as desired. For example, when you select Category: Preset
and Function: Select by #, a “Preset” parameter appears to let you dial in the desired preset number.

* You can also customize the ring color for an individual switch, overriding the defaults for the Category.
* You can also select from different automatic “labels” for the Mini-Display, or even enter custom text.

» The EZ page also provides buttons to RESET (Clear with confirmation), and COPY/PASTE switches.

» Press another footswitch to move on, or press EXIT when you are finished.

&= Reminder: All changes in the FC Controllers/Onboard Switches menu take effect with no need to store.

For more information on the various footswitch functions, please see “The Footswitch Functions Guide”.
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THE LAYOUTS LIST

EZ editing is (you guessed it...) easy, but the FM3 also provides a deeper way to manually edit layouts and
switches. The Edit Layout page of the Foot Controllers menu provides an overview of 12 switches, and also
allows deep editing of individual footswitches, with all of the settings from EZ page and more.

On the FM3, open the Setup: Foot Controllers and page to the “Layouts” tab.
» Use the A knob or NAV buttons to select the desired layout.

FC Controllers Layouts
LAYOUT NAME

Layout 1 PRESETS
Layout 2 SCENES
Layout 3 EFFECTS
Layout 4 CHANNELS
Layout 5 LOOPER
Layout 6 PER-PRESET

Layout 7 PERFORM 1
Layout 8 PERFORM 2
Layout 9 MasterlLayout

C Nav
RESET ALL EDIT LAYOUT EDIT NAME COPY LAYOUT | PASTE LAYOUT

» The push-knobs offer additional functions:
= RESET ALL sets all functions for all switches in all layouts to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)
= EDIT NAME allows you to rename the layout (see “Naming Layouts” on p. 84).
= COPY LAYOUT and PASTE LAYOUT provide a means to replicate a layout to a new location.

» Select any layout and press ENTER or the EDIT LAYOUT button (push-
knob B) to open that layout for deeper editing.

Number 9... As you review or edit layouts, you may notice “Layout 9" in the list.
@ Layout 9 is in fact the special Master Layout Menu used to access other layouts.
Do not edit this layout unless you understand what it is, what you're changing, and how it works.
If you modify the Master Layout Menu — intentionally or otherwise — you can easily reset it to factory default

settings without resetting anything else. Just use the “RESET LAYOUT” button on the Edit Layout page
(see p. 83). Unlike all other layouts, #9 reverts to factory settings instead of being completely cleared.

As you get deeper in to the FM3, you may find the ability to modify the MLM quite useful, with options like “Layout
Link” or the ability to add functions instead of unused menus.



EDIT A LAYOUT

Select any layout on the Layouts page (p. 82) and press EDIT LAYOUT

or ENTER to open the selected layout for deeper editing.
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The Edit Layout view has two pages: one for the Tap function and one for the Hold function. Each shows the
Category and the Function for all 12 switches, plus values for the first two parameters of the current function.

» UsetheA, B, C,D, and E knobs, or the NAV buttons and VALUE knob to make changes.

Edit Layout 1: PRESETS

1Tap
2 Tap
3 Tap
4 Tap
o Tap
6 Tap
7 Tap
8 Tap
9 Tap
10 Tap
11 Tap
12 Tap

C Nav
RESET LAYOUT

» The push-knobs offer additional functions:

CATEGORY

Preset
Preset
Preset
Preset
Preset
Bank
Preset
Preset
Prese
Preset
Preset
Bank

Category
EDIT SWITCH

FUNCTION

Select in Bank
Select in Bank
Select in Bank
Select in Bank
Select in Bank
Inc / Dec
Select in Bank
Select in Bank
Select in Bank
Select in Bank
Select in Bank
Inc / Dec

Function

Notice the Tap and Hold pages

Tap
VALUE 1 VALUE 2

Value 1 Value 1

RESET SWITCH) | COPY SWITCH | |PASTE SWITCH

= RESET LAYOUT sets all switches in the current layout to “Unassigned” and clears all customization.
(A confirmation screen requires you to press ENTER first.)

= EDIT SWITCH opens a single switch for deeper editing.
= COPY LAYOUT and PASTE LAYOUT provide a means to replicate a layout to a new location.

» Select any switch and press ENTER or the EDIT SWITCH button (push-
knob B) to open that switch for deeper editing.

& On the FM3, the middle switch in every layout has its Hold function assigned to the Master Layout Menu.
It is certainly possible that you won't need this, but think carefully before changing it.

@ See “The Footswitch Functions Guide” for information on all categories, functions, and parameters.
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NAMING LAYOUTS

Layout Names appear in the Master Layout Menu and can also appear on dedicated Layout footswitches.
Changing the name of any layout is simple with the same interface used to name presets and scenes.

NAME A LAYOUT:

» On the FM3, open the “Layouts” page of the FC Controllers/Onboard Switches menu under SETUP.
» Use the A knob or NAV buttons to select the desired layout.

» Push the EDIT NAME button (push-knob C).

» Enter the desired name, up to ten characters:

= Turn the B knob or use NAV buttons to move the cursor.
The C knob selects upper case letters.

The D knob selects lower case letters.

The E knob selects numbers.

The VALUE knob selects ALL characters, including symbols.
Press D or E for INSERT and DELETE functions.

= Press ENTER to commit the name or EXIT to cancel.

&= Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

STARTUP LAYOUTS

The FM3 itself and each connected FC Controller have their own default layout which load automatically when you
power on. You can change the default layout as follows.

SET DEFAULT LAYOUTS:

» Onthe FM3, open the “Devices” page of the FC Controllers/Onboard Switches menu under SETUP.
» Use the C knob or NAV buttons and VALUE wheel to set the desired Default Layout.

» You can also manually change the Current Layout and Current View (p. 85)
for both the FM3 itself and any connected FC controllers.

The Devices page also allows you to set up Mirroring the FM3 to an FC controller.

See the FC Controller Owner’s Manual for more on mirroring.

BACKING UP LAYOUTS

FM3 layouts are included when you do a complete system backup
(See p._111) but you can also back up or restore layouts using FM3-
Edit (p._15). Find these options in FM3-Edit in the FC Controllers
area, Layouts pane, Edit menu dropdown. (shown at right).

LAYOUTS
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LAYOUT VIEWS

As you've learned, every layout contains up to 12 footswitch definitions, even though devices like the FM3
have fewer than 12 switches. Layout Views allow you to access those extra definitions on devices with fewer
footswitches - like an FM3 or FC-6.

Think of the FM3 as a “window” that shows the first three defintions in a layout. Special footswitch functions
allow you to change the view. This shifts this window to a different set of three switches — from 1-2-3 to 4-5-6,
for instance, (and so on). This allows you to make use of the whole layout instead of “wasting” its extra space.

Several of the FM3 factory default layouts use Views. For example, in the Scenes layout (#2), pressing and
holding the left or right footswitches on the FM3 changes the view to access different set of scenes. Similarly, in
the Effects layout, pressing and holding the outer two switches changes the view to show different effects. This
allows you to make the most of three footswitches and eight layouts.

Here is anillustration representing how the FM3 normally shows VIEW 1,
displaying the first 3 of 12 switches in a given layout.

0 00O

- - Imagine that the right switch is set up to change to the next view
L. J when you press and hold. (“View: Inc/Dec: +1")

(Switch 1 Iswitch 2 ISwitch 3 ) | | l | | |

“View 1"

O G ] When you change to View 2, the FM3 shows switches
L 4,5, and 6 from the same layout.

(Switch 4 ISwitch 5 ISwitch 6 ) | | | |
O 0 0O

| “View 2" |
L "
0 oo

| | | | (SWitch 7ISwitch BISwitch 9) | |

When you change to View 3, the FM3 shows | “View 3" |
switches 7, 8, and 9 from the same layout.

I I | I l | (Switch 1OISwitch 11ISwitch 12)
When you change to View 4, the FM3 shows switches 10, 11, and 12. | “View 4" |

This example above shows a forward progression from View 1 through View 4.
However, you can change views in all kinds of ways — forward, backward, a la carte, and more.
See “The Footswitch Functions Guide” for more information on functions related to Views.
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EDIT A SWITCH

Select any switch on the Edit Layout page (see p. 83) and press
EDIT SWITCH or ENTER to open the selected switch for deeper editing.

The Edit Switch view has two pages: one for its Tap function and one for its Hold function.
Each page shows the current Category and the Function for the switch, plus any and all parameters for the
current function.

» UsetheA,B,C,D,and E knobs or the NAV buttons and VALUE wheel to make changes.

» On the Tap page, you can also change the Switch Ring Color for an
individual switch, overriding the usual default Category color.

» You can also select from different automatic “labels” for the Mini-Display, or even enter custom text.
Details on the various label options can be found in “The Footswitch Functions Guide”

Notice the Tap and Hold pages

Edit Layout 5: PRESETS / Switch 5

Category Preset
Function Select in Bank
Preset S
Mini-Display Label Name

Switch Ring Color Default

FC#1
FC#2
FC#3
FC#4

RESET TAP

» The LAYOUT LINK parameters allow the Tap or Hold function of the switch to also change the Layout on the
FM3 and up to two connected FC units. See “The Footswitch Functions Guide” for more on Layout Links.

» The RESET button (Push-knob A) clears the function and all customization from the current page.
(A confirmation screen requires you to press ENTER first.)

A NOTE ON PRESS & HOLD LABELS IN THE MINI DISPLAYS

The Mini-Display for each switch normally shows the label for the Tap function. When a switch is pressed down —
even briefly for a normal “tap” — it changes to show the label of the Hold function, even if you don't keep holding
the switch down until its Hold function fires.

A special “Reveal Hold" utility switch can also cause all mini-displays to persistently show the Hold functions for
their switches. See "The Footswitch Functions Guide” for more on this.
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PER-PRESET SWITCHES

The current lineup of Fractal Audio products support two ways of doing Per-Preset footswitches.

Placeholder switches, like those in FM3 factory layout 6, look through the current preset and automatically place
its custom switch definitions on the floor. For example, the first switch in Layout 6 will always show the first Per-
Preset switch definition (“PP#1") from the current preset.

Overrides happen when a preset takes over one of the switches on a connected controller, effectively clobbering
whatever global definition you have given a switch and instead showing the override instead. For example, a given
preset may be set to force Layout 1, Switch 1 to show “Tap Tempo” instead of its normal function.

Learn more about Per-Preset Switches in the Footswitch Functions Guide available on our web site:

https://www.fractalaudio.com/fas-ffg

Here is a quick introduction covering how to create the definitions used with Per-Preset switches.

CREATING PER-PRESET SWITCH DEFINITIONS

1. Load the desired preset and navigate to its list of per-preset switch footswitch definitions as follows:

= Press HOME, then use Push-knob D to open the FC Per-Preset menu.
= Page to the Per-Preset FC tab if it isn't already selected.

2. Turn the VALUE knob to select your choice of per-preset switch definition “slots” (numbered “PP# 1-24.).
The first twelve per-preset definitions are used by FM3 layout 6.

3. Define the switch. The interface is basically identical to that used by the “EZ” footswitch page.
= You can set Tap Function, Hold Function, LED ring color, Mini-Display settings, and Layout Links.

4. Repeat this process for any other switches you wish to define.

5. Press Home when finished.


https://www.fractalaudio.com/fas-ffg
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STAND-IN SWITCHES

This section requires you to have one or more external switches. These can be connected directly to the FM3
(see p. 14) or to an FC Controller (see your FC Owner’s Manual).

Without the Stand-In Switch feature, the capabilities of an external switch are more limited than the onboard
switches of the FM3. Modifiers and global functions, for instance don’t have any press-and-hold capabilities, and
they can't, for instance, change a BANK, switch a layout, or show the tuner.

To make external switches more powerful, we created Stand-In Switches. This feature allows a connected
external switch to operate like a remote control for any switch that you have already programmed in a layout on
your FM3.

For example, you might normally have Layout 3, Switch 12 set to bypass/engage the Trem Pan 1 block on tap,
and toggle the block’s channel from A to B on hold. When you set up an external switch Stand-In for Layout 3,
Switch 12, it now performs these functions. This even allows an external switch to perform per-preset functions
as described on the previous page. Be aware that the stand-in is just a pointer. If you change the switch it is
remote controlling, its function will change too.

TO CREATE A STAND-IN SWITCH:

From the Home page, open SETUP: FC Controllers/Onboard Switches
Page to the Stand-In Switches tab.

Navigate up or down to the switch you want to set up. For example, “FM3 SW2 Tip”
Select the desired Layout and Switch using the B and C or Value knobs.
Set up any other Stand-In Switches and press Home when finished.

o gk wDd =

Test your switch.
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USING THE FM3 WITH AN FC CONTROLLER

The FM3 has a FASLINK port to connect a Fractal Audio FC-6 or FC-12. Using an FC controller expands the
number of footswitches to increase your options on the floor — including jacks for 4 additional expression pedals
and 4 external switches per FC. No special configuration is required; simply connect the FC to the FM3 and it
begins working.

Up to two FC controllers can also be daisy chained from the FM3, increasing the total maximum number of
simultaneous footswitches to 27!

Remember that when daisy-chaining, the second FC Controller will require an AC adapter. It is not powered by the
FASLINK “thru” connector on the first FC Controller.

When adding an FC, you will need to customize all FM3 layouts, which have been designed around three
footswitches. The usual way to do this will be to have some layouts dedicated to the FM3 and others dedicated to
the FC-6 or FC-12.

The Layout Link feature becomes especially important in this type of setup, since it allows one foot controller to
change the layout on another controller. See “The Footswitch Functions Guide” for more on this feature.

Similarly, Layout Views (p. 85) can help you get the most from each layout, especially in combination with
Layout Links.

An additional benefit
of using the FM3 with
an FC Controller is
that each attached
controller supports
an additional four
expression pedals
and four external
switches!
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FM3 FOOTSWITCH FAQ

As mentioned many times thoughout this manual, the “The Footswitch Functions Guide” covers everything there
is to know about the many categories and functions that can be assign to Tap or Hold on any switch.

Here is a quick summary of common questions.

Q:
A:

Q

Q

What do the LED rings show for EFFECT footswitches?

The LED Rings show up-to-the-moment information about the assigned effect. If the ring is DIM, the effect
is OFF. If the ring is BRIGHT, the effect is ON. If the ring is completely OFF, then the assigned effect is NOT
AVAILABLE in the current preset.

TIP: One of the most common uses for “Per Preset Footswitches” is to override an
unused effect switch with one for an effect that is used in that preset.

How do | assign presets to footswitches?

This can be done using the PRESET: SELECT function, but this approach is really only appropriate if you use
very few presets in total. Instead, BANKS make it easy to get to get to many presets using few switches.

In fact, the preset Footswitches in the default FM3 layouts use the function “PRESET: SELECT IN BANK".
Banks show presets in the order in which they are located on the FM3. It is easy to re-order presets

using the Manage Presets area of FM3-Edit, where you can copy/paste or use drag-and-drop to swap

preset locations. TIP: While using this tool, turn on the “FC Banks” option at the top of the manager

so you can easily see which presets will map to which footswitches. Press “Save” when finished.

The FM3 includes many empty preset memories, providing room for you to store additional creations. Why
do the preset and bank switches of layout 1 allow me to enter these “Emtpy” preset banks areas of the FM3?

The two press and hold BANK function switches in Layout 1 have options for Upper Limit and Lower Limit.
By default, these step through ALL of the preset memory locations on the FM3. In some cases, you may want
to set these differently. Remember that these limits show BANK numbers and not preset numbers, so you'll
need to do a little mental math. To limit your FM3 to presets in 000-383, set the “Upper Limit" of both bank
switches to “127". (384 presets + 3 presets per bank = 127 banks).

If you want to use only, say, 15 gigging presets, you might set these limits to 5. (15 + 3 = 5).

Help! I can no longer press and hold the middle switch to get to the Master Layout Menu!

Don't panic. You may have accidentally changed this function, and it is easy to re-assign if you know which
switch is misbehaving. The middle switch of almost every Factory layout has its hold function set to Layout:
Select: 9, View 1. (Layout 9, as you may recall, is the Master Layout Menu.) If you changed a switch and want
to set it back, open EZ Edit (p. 81 ), tap the desired switch, then navigate down and set its Hold function

back to Category: Layout, Function: Select, Layout:9, View:1.

FM3-Edit makes this even easier. Use the “FC Controllers” area to make these changes.

A more “Brute Force” way of doing this would be to reset the factory layouts (See p. 81).

A: Can | back up, share, or restore my Footswitch Layouts?

A: Yes. Perhaps the most common way to back up is to receive a backup of your SYSTEM using Fractal-

Bot (p._15). The system file contains all of the layouts and FC settings. Another way is to use
FM3-Edit, which includes options to export or import one or all of your layouts. Find these choices
in the Edit menu dropdown located in the LAYOUTS panel of the FC Controllers area of FM3-Edit.
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11 TEMPO

Tempo is used in electronic music for synchronizing different rates and times, whether inside one machine or
across several. Tempo on the FM3 allows for both internal and external synchronization, providing effects with
a central BPM clock that can stand alone or follow MIDI Beat Clock from a connected device. The FM3 does not
transmit MIDI Clock itself. The Tempo can be set to any whole number value in the range 20-250 BPM. The FM3
flashes its current tempo on a front-panel LED.

THE GLOBAL TEMPO

The Global Tempo value is a system setting outside of any presets, scenes or channels.
You can change it in any of several ways:

1. Tap two or more times on the front panel TEMPO button.
NOTE: By default, the tempo averages across ten taps, but you can set it to use only two taps with an option
found under SETUP: Global: Config: Tap Tempo.

Tap an onboard or FC footswitch assigned to the Utility: Tempo function.
Tap the TEMPO button once and use the Tempo knob (B).
Use an external MIDI device to transmit MIDI Clock to the MIDI IN port of the FM3.

o &~ N

Use a MIDI CC# or external switch assigned to Tempo Tap, located on the Other page of the MIDI/Remote
menu under SETUP. (See NOTE under #1 above).

Be aware that whenever you change the Global Tempo, you are also changing the current Preset Tempo, which will
be saved if you store the current preset (see below). Be on guard not to over-write saved tempos.

PRESET TEMPO

By default, a given preset will ignore the Global Tempo and use its own saved Preset Tempo instead. Notice that a
preset's Tempo page contains two parameters: one is an actual Tempo (BPM) value, and the other is a setting called
Tempo To Use, which determines what will happen when that preset is loaded.

When you load a preset whose Tempo To Use is “PRESET,” the saved Preset Tempo takes over: the tempo LED

flashes accordingly and all tempo-dependent time/rate parameters are re-calculated. In fact the Global Tempo
has not changed; it remains in the background and will be used when you load a different preset with Tempo to
Use set to “GLOBAL".

Be aware that whenever you alter a preset's own Tempo, you are also updating the Global Tempo.

Remember that each of the four channels of the Controllers menu has its own settings for both Tempo (BPM) and
Tempo to Use. You can use this to have some Scenes or Channels change the tempo while others do not.

TO SET “TEMPO TO USE”"...
1. Load the preset.
2. Tap once on the TEMPO button.
3. Change TEMPO TO USE as desired to either “GLOBAL" or “PRESET".
4. STORE the preset.
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SYNCHRONIZING SOUND PARAMETERS

Rates and times in a preset can be set to sync rhythmically to the Tempo by setting their corresponding Tempo
parameters. This is done by selecting from a list of values, ranging from 1/64-note-triplets to double whole notes,
with 76+ options in all. For example, to set the Time of a Delay block to follow the quarter note pulse of the
tempo, find the Tempo parameter on the Config page of the Delay block’s Edit menu and set this value to “1/4.”

The moment you assign a value for Tempo (other than “NONE”), its associated rate or time parameter is
overridden and may not be changed manually — as indicated by its appearance in parentheses. To regain control
of an overridden parameter, set its corresponding Tempo parameter back to “NONE".

Almost every LFO rate and delay time parameter on the FM3 can be synced to the tempo.

TO SYNCHRONIZE A DELAY TO THE TEMPO...

» Navigate to any type of Delay block and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it to “1/4". Feel free to choose/explore
other options. “1/8th dot” is also very useful and popular.

» STORE the preset.

Remember that once a Tempo has been set, you will be unable to adjust Time manually or with a Modifier.

TO SYNCHRONIZE A TREMOLO OR OTHER RATE TO THE TEMPO...

» Navigate to the effect and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it as desired. A typical value here might be
“1/8th" or “1/16th". Feel free to choose/explore other options.

» STORE the preset.
Remember that once a Tempo has been set, you will be unable to adjust Rate manually or with a Modifier.

Note that syncing an LFO to the tempo does not align the phase of that LFO to the Tempo LED, to MIDI song
position pointer, or to other synchronized LFOs. You can synchronize various LFOs together by setting their RATE
knobs fully counterclockwise to “LFO1 SYNC" and then syncing the LFO1 Controller to the Tempo (p. 73).
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12 TUNER

The FM3 has a built-in Tuner, an essential tool for the performing or recording musician. The tuner is easy to use
and has high-resolution automatic pitch detection, a calibration control, offsets for modified tuning schemes, and
the option to mute audio while tuning. Find the Tuner on the Home page by pressing TUNER (Push-knob A) or by
pressing and holding the front panel TEMPO button.

The tuner features a note name display, a “zero-center” meter, a spinning “strobe” type display and triangular
indicators for sharp and flat.

ADVANCED TUNER FUNCTIONS

The actual tuner is on the Tune page of the Tuner menu.
The Config and Offsets pages provide options for advanced tuner functions.

Configuration Parameters

OFF/INPUT/OUTPUT

PARAMETER Description.
Source Selects which physical input the tuner should listen at.
Mute Determines how the tuner mute function works.

= OFF: No mute. All signal is passed as usual when the tuner is engaged.
= QUTPUT: The signal is muted at the output. Tails are silenced.
= INPUT: The signal is muted at the noise gate. Tails ring out.

Display Mode

MIXED/ALL FLATS/
ALL SHARPS

Determines whether the tuner shows note names for accidentals as Sharps, Flats, or a
mix of both.

Calibration
430.0 - 450.0 Hz

Calibrates the tuner by setting the frequency of A4 (in the octave above middle C).
The tuner defaults to A440.

Downtune

0 - 4 Semitones

The Downtune control allows for simplified tuning when tuning down one to four
semitones. The Tuner display will read the non-downtuned equivalent note, i.e. if tuning
down two semitones, the D will still show E. While Downtune is set to any value other
than None, any blocks that utilize pitch information will also be transposed accordingly.

Use Offsets Determines whether the Offset settings (see below) are applied or ignored.
OFF/ON

OFFSET PARAMETERS
PARAMETER Description
E1, B2, G3, D4, A5, E6 | Offsets allow the tuner to be calibrated so individual notes diverge from standard
+/-25.00 Cts concert tuning by a defined amount. Use this for example for Buzz Feiten tuning.
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MINI TUNERS » —=

For convenience, mini-tuners appear throughout the FM3. These consist of two green triangles to indicate when a
note is flat (left lit), sharp (right lit) or in tune (both lit).
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13 SETUP MENU

Open the menu by pressing the SETUP button (Push-knob E) on the Home page. The current Firmware Version
is shown at the top of the page. To enter a menu, select it with NAV and press ENTER. All changes take effect
immediately without needing to be stored. The settings for Setup parameters are included in a backup of the
System (see "Fractal-Bot" on p. 111)

&= Reminder: All changes in the FC Controllers menu take effect immediately with no need to store.

FC CONTROLLERS/ONBOARD SWITCHES MENU

Most of the pages and functions of the FC Controller menu are detailed elsewhere in this manual:

FC: EZ PAGE
"Easy (“EZ") Edits" on p. 81

FC: DEVICES PAGE

"Startup Layouts” on p. 84
See also "Mirroring” in the FC Controllers manual.

FC: LAYOUTS PAGE

"Edit a Layout" on p. 83

FC: RING COLORS PAGE

"Footswitches" on p. 11

FC: STAND-IN SWITCHES PAGE

FC: CONTROL SWITCH MIDI

See "The Footswitch Functions Guide"

FC: CONFIG PAGE

(See next page)
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FC CONTROLLERS: CONFIG PAGE

PARAMETER Description

Bank Size Several of the available FC functions will automatically map presets

1-12 dynamically in “Banks” across footswitches. The FM3 defaults to 3 presets
per bank but you can change this setting for use with custom layouts. The
Bank Size number should correspond directly to the number of “Preset:
Select in Bank” switches used.

Bank Switch Limits "Bank Inc/Dec" footswitches have "Upper Limit" and "Lower Limit" settings

DISABLED, ENABLED (detailed in "The Footswitph Functions (_5uide"). Setting this to DISABLED
causes these limits to be ignored, allowing access to all banks.

MLM Switch Combo The Master Layout Menu (aka “MLM”, aka “Layout 9”) provides access to

ENABLED, DISABLED

Hold Function Timeout
0.25-2.00 seconds

Hold Function Mode

AUTOMATIC,
SWITCH UP

Per-Preset Overrides
ENABLED/DISABLED

Footswitch Tuner Mode
ENABLED, DISABLED
FC-6 Layout Mode

FC MAIN DISPLAY:
Show Preset Numbers,
Show Scene Numbers

ON/OFF

other layouts. This setting disables or enables the special "foot rocking”
switch combination used to display this menu on the FM3 and any connected
FC controllers.

This sets the time limit before a Hold function is automatically fired,
beginning from the moment the switch is depressed. When a Hold function is
assigned, a Tap function fires if the switch is released before the press and
hold timeout elapses. See also "The Rules of Switch Timing" on p. 80
Normally, Hold functions fire automatically after a timeout (above). With this
setting changed from AUTOMATIC to SWITCH UP, they wait for the switch

to be released, granting precise control over the timing of a hold function.
Now, you can use HOLD, for example, to change a Scene precisely on the
downbeat.

Any FM3 preset can override the function of any footswitch in any layout.
This offers extreme flexibility, making it possible to handle exceptions easily
in a system where everything is normally global. This setting allows you to
DISABLE Per-Preset overrides so only the global switch functions appear.
See "The Footswitch Functions Guide" for more on per-preset functions.

Turn this feature ON to enable a special mode where the first three
footswitches visually enhance the tuning process.

This changes how layouts are displayed on a connected FC-6. Normally, the
FC-6 shows switches 1-6 from any layout — just as you would expect. If you
design layouts on an FC-12 and then load them on an FC-6, however, this
results in things being arranged differently, especially when Views are used.
To counter this, you can enable FC-12 mode on the FC-6 (Formerly called "FC-
6/FC-12 Compatibility Mode"), illustrated below:

FC-6 Default Mode FC-6 in FC-12 Mode

o ]RGS wen ) EE8 e I e ]RGS
4 5 6 10 11 12 7 8 9 0 11 12
1 2 3 7 8 9 2 3 4 5 6
View 1 View 2 View 1 View 2

The main display of a connected FC controller shows the name and number
of the current preset and current scene. These two options allows you to
individually hide the numbers so a greater number of characters can be

dedicated to the names. This has no effect except on a connected FC.
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PARAMETER Description

Main LCD Display Mode Can be used to force a connected FC to show preset/scene names instead of
Song/Section names when using the Setlist/Song feature.

Message Hold This determines the duration for special footswitch messages to be shown

Ring Intensity Bright,

Ring Intensity Dim

25-100%, 1-50%,
Mini-Display Contrast
Mini-Display + Ring Brightness
Invert Mini Displays

CS1 Exclusive, etc.

in the main display of the FM3 or the display of a connected FC controller.
Example: Effect BYPASSED or ENGAGED)

Each FC footswitch has its own LED ring. These rings change between off,
dim, and bright to show switch states. The Ring Intensity parameters allow
you to independently adjust the brightness of dim and bright states.

This sets the contrast in the onboard mini-displays.

This sets the master brightness of the onboard mini-displays and LED rings.
Turning this ON causes the mini displays to show light text on a dark
background.

Six options allow you to add each of the six Control Switches to a mutually
exclusive group. Any switch with Exclusivity enabled becomes a member of a
group in which only ONE switch can be turned on at once. Turning any switch
in the group ON will turn all others in the group OFF automatically.

For more on Control Switches, see the "The Footswitch Functions Guide")
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FC SETLISTS/SONGS MENU

The Setlists/Songs feature is accessed via the FC Setlists/Songs menu.

NOTE: Setlists, Songs and Sections are like other areas of “Setup” in that all changes take effect immediately and
they do not need to be stored. They are also included in a Fractal-Bot “System” backup.

This topic is covered in a separate section, XXXX on p. xx.
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THE GLOBAL SETTINGS MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

GLOBAL SETTINGS: CONFIG PAGE

PARAMETER

Description

Output 1 EQ Type
Output 2 EQ Type
Power Amp Modeling

ON/OFF

Cabinet Modeling
ON/OFF

Tone Control Display
AUTHENTIC/IDEAL

Speaker Impedance Curve

Spillover
OFF/DELAY/REVERB/BOTH

Reverb Mix
+/- 50%

This setting determines whether each of the global EQs (p._101) will operate in
Graphic or Parametric mode.

This parameter globally enables or disables power amp simulation in all Amp
blocks in all presets. This capability is provided for cases when the FM3 is used
with a guitar-oriented/tube power amp that contributes significantly to tone

and dynamics. Having these characteristics applied twice to the sound—once

in the virtual power amp and once in the real power amp—would result in an
over-processed sound. All those Amp block parameters that are NOT part of
the virtual power amp continue to work normally while Power Amp Modeling is
turned off. Presence and Depth are disabled, and Master Volume becomes a
simple volume control. Remember that like a real amp, the FM3 has separate
preamp and power amp sections. When you disable Power Amp Modeling, the
Amp block still models the preamp, which includes distortion, the tone stack,
and more.

This parameter conveniently enables or disables Cab block processing in all
presets. The Cab block will not physically appear to be bypassed, but acts
exactly as if it had been replaced a shunt. Use this when you are using the FM3
with an amp powering a traditional guitar speaker cabinet, or the sound will be
muffled, muddy, and boomy.

This parameter governs the "Tone" page of the amp block. When set to
Authentic (default) only those controls present on the actual amp are displayed.
When set to Ideal all tone controls are displayed. Also, when set to Authentic,
the Bass, Mid and Treble controls are reset to default values when changing
models to ensure accuracy for models that may not have these controls.
Determines how the Speaker Impedance Curve is set when changing Type in
the Amp Block. When set to "DEFAULT “, the corresponding impedance curve for
the new Type is automatically applied. When any other value is set here, it will
be pre-selected whenever the Amp Type is changed.

Allows delay and reverb “tails” to ring out or spill over across Preset changes.
You can select whether “DELAY”, “REVERB", or “BOTH" effects will spill over.
Setting to “OFF” causes effect tails to be cleared upon preset change. Spillover
when switching Scenes or using “IA” Switches is not affected by this parameter.
See also "Spillover” on p. 133

This boosts or cuts the MIX for ALL Reverb blocks in all presets. Note that

this offset is NOT reflected in the value shown for the actual Reverb block MIX
parameter. This feature is provided because certain dead or lively performance
spaces may require more or less reverb across all presets.

Remember that MIX generally applies only to Reverb blocks which are wired in
series. (Parallel reverbs typically run with MIX at 100%.)
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PARAMETER Description
Effects Mix Boosts or cuts the MIX of all blocks for which the GLOBAL MIX parameter is
+/- 50% set to “ON". This switch must be enabled on a per-block/per-preset basis and is
’ available on the Mix page of the Edit menu for these block types:
Chorus Formant Pitch Ring Mod
Delay Multitap Delay Plex Delay Rotary
Flanger Phaser Reverb Ten-Tap Delay
This feature is provided because certain performance spaces may require more
or less of certain effects across all presets.
Noisegate Offset Globally raises or lowers the THRESHOLD of the Noise Gate for all Input blocks.
+/-40.00 dB If the THRESHOLD for a given preset is set to “OFF”, the global Offset will have

Prompt on Edited Preset
Change

Indicate Edited on Scene
Change
OFF/ON

Display Offset
0,1

Default Scene
AS SAVED, SCENES 1-8

Tap Tempo
AVERAGE, LASTTWO

AC Line Frequency

no effect. See "The Fractal Audio Blocks Guide" for more on the noise gate.
When set to ON the unit will prompt before changing presets if the current
preset has been edited. This spares you from accidentally losing your edits.
NOTE: Be sure to change this to OFF before performing!

This determines whether or not the EDITED top panel LED (and corresponding
graphic in the editor) is triggered by Scene changes or not. Even if the LED is
disabled, the current scene will still be saved whenever you store a preset.

(Also appears in the MIDI/Remote menu) Causes presets numbers to begin
at 001 instead of 000. This only offsets the display, meaning that it does not
change which preset is actually loaded by a given footswitch or MIDI message.

When set to “As Saved” the scene selected when recalling a preset is the scene
that was active when the preset was last saved. When set to a particular scene
value that scene will always be selected when any preset is recalled.
Determines how the tempo changes when tapping the front panel TEMPO
button or an external tap tempo controller (see p. 108). “AVERAGE" sets the
tempo based on the average of ten taps, meaning taps are more forgiving

but changes are more gradual. “LAST TWO" considers only the time interval
between the last two taps, which means taps must be more precise but
changes occur more quickly.

The “Intelligent” Noise Gate type found in the Input Block provides smart EMI
filtering which reduces hum and buzz. For best results, set this parameter to
match the power line frequency of your country (i.e. 60 Hz for North America,
50 Hz for EU, etc.).

—
o
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GLOBAL SETTINGS: OUT 1 EQ PAGE

OUT 1 EQ provides a 10-band graphic EQ, plus a master GAIN adjustment control. Use these to make global
adjustments to the tone or level of ALL presets. This is convenient when you need to compensate for using a
different amp or speakers, or if a particular performance space seems overly bright or boomy. The master GAIN
fader should be used with care as it can cause clipping, and lowering it can affect the signal-to-noise ratio. This
EQs affect ONLY the Analog outputs. SPDIF and USB are not affected.

Output 1 Global EQ settings apply to all instances of the Output 1 mix signal, including the Output 1 balanced
jacks, unbalanced jacks, headphones jack, and signal which might be routed to USB or digital outs.

GLOBAL SETTINGS: CUSTOM SCALES PAGE

The Scales page is used to configure scales for the Custom Shifter type in the Pitch block.

See "The Fractal Audio Blocks Guide" for more on this effect.

PARAMETER Description

Custom Scale Number Selects from among the 32 global custom scales available to edit using the 12
1-32 parameters which follow.

__SHIFT (+/- 24) These 12 parameters are used to set the shift amount for each of the 12 steps

of the chromatic scale. Range is +/-24 semitones (+/- two octaves). To set up
a custom scale, select its number in the field above and then set each of the
12 pitch values as desired. Changes take effect immediately, with no need to
STORE. Soft-buttons provide options to reset a selected value or all values in
the current scale to the default value of +/- 0 semitones.

—
—
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THE 1/0 MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

1/0: AUDIO PAGE
PARAMETER Description

SPDIF Out Source This allows you to specify which signal should be transmitted at the SPDIF
Output 1, Output 2, Input 2 digital output.

USB 3,4 Record Source This determines whether USB 3+4 in a connected computer will record the

Input 1, Input 2, Output 2

USB 1,2 Playback Destination
Output 2, Output 2

USB 3,4 Playback Destination
Input 1, Output 1, Output 2

USB Buffer Size

Input 1 Source

ANALOG
USB [CHANNELS 3/4]

Input 1 Pad
0,6dB,12dB, 18 dB

Input 2 Pad
0,10dB, 18 dB

signal from FM3 Input 1 or Input 2.

This allows computer audio from USB 1/2 to be sent to either Output 1 L+R
(the default) or Output 2 L+R. This allows for the easy separation of processed
guitar to Output 1 while computer audio is sent to Output 2 when this option is
not offered in your DAW or software.

If you use only Output 2, you can set the FM3 so you hear both processed
guitar and USB audio at those jacks by using the following settings:
Output 2 Copy: OUTPUT 1, USB 1/2 Playback Destination: OUTPUT 2.

This determines how the FM3 routes playback from USB 3/4 of a connected
computer. The default option of "INPUT 1" is designed for re-amping.

Set this to lower values for less latency with USB Audio, set to higher values
if you are experiencing performance issues such as crackles or distorted
audio. After making changes, allow the buffer to reset by closing your audio
applications, or disconnect/reconnect the USB cable.

This selects which signal is routed to the Input 1 block on the grid. “ANALOG"
selects the onboard In 1/Instrument jack. “USB (CHANNELS 3/4)" selects the
signal from FM3 USB 3/4 on a connected computer so you can perform re-
amping or other types of signal processing.

This pads the signal from IN 1 [INSTRUMENT] jack before it reaches the

A/D converter to prevent clipping. The pad is offset by a corresponding but
opposite boost at the output of the converter, so “what you hear” remains the
same at all settings.

Run this at the lowest possible setting for your guitar, starting at 0 dB and
increasing padding if required to eliminate Input 1 clipping as indicated on the
front panel LEDs.

This pads the signal at INPUT 2 jacks before it reaches the A/D converter to
prevent clipping. Run this at the lowest possible value for your setup, starting
at 0 dB and increasing padding if required to eliminate Input 2 clipping as
indicated on the front panel LEDs.

—
NS
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PARAMETER Description

Output 1 Mode These determines how signals are processed at the corresponding outputs.

Output 2 Mode This control makes it easy to use the same presets in a variety of stereo and
mono performance or recording environments. See also "Mono vs. Stereo” on

STEREQ, p. 8 for more information.

gL(J)'\I;IYLIJ_rER USB Audio goes directly to the converters and is NOT affected by this setting.

MUTE The option "MUTE" is available for Output 1 only in case you want to eliminate

Output 1 Level
Output 2 Level

-10dBV
+4 dBu

Output 1 Phase
Output 2 Phase

NORMAL, INVERT

Output 2 Type

UNITY GAIN
LINE LEVEL

Output 2 Boost/Pad

0/6/12/18 dB

Output 2 Copy
INPUT 1,
OUTPUT 1,
NONE

direct audio from the FM3 while using it with a DAW.
See the diagram in "Option: USB Input Monitoring Only" on p. 26

These set the nominal levels at the corresponding analog output jacks.

Use “-10 dBV" for consumer-grade equipment including many guitar products.
Use “+4 dBu“ with professional audio equipment.

The product manual for your connected device should indicate whether it
operates at +4 dBu or -10 dBV (Default). (Some devices are switchable.)

For Qut 2, this option is available only when the "LINE LEVEL' type is selected.

Determines whether signal at the corresponding outputs will be normal
or phase-inverted relative to the actual output of the grid. This lets you
compensate for unwanted inversions elsewhere in the signal chain.

This determines whether output 2 operates in Unity Gain or Line Level mode.
Unity Gain is useful, for example, when connecting Out 2 to the input of a tube
amp, or when capturing an analog DI. This is the default setting.

Line Level is useful when connecting Out 2 to a mixer, PA, or the inputs of
FRFR speakers.

See also XXX on p. xx

This setting engages a boost/pad which can help lower the noise floor of
Output 2. This can be used when outputting to a tube amp in a unity gain
setup. This option is available only when Output 2 Type is set to "Unity Gain".

Boost/Pad helps optimize D/A performance without affecting levels. A boost
at the converter’s input is paired with a corresponding cut at its output. Be
watchful, however, as boosting makes it easier to clip the converters. Watch
the meters and if clipping occurs, reduce levels within your preset or lower the
Boost/Pad setting.

This allows you to create a duplicate of the Out 1 or In 1 signal at Out 2.
By copying Out 1 to Out 2, you can easily send the same signal to Front of
House and your stage monitors with independent Global EQs, plus separate

front panel level knobs for each. Without this global option, you would need to
modify every preset by adding the Out 2 block.

Copy In 1 to create an easy analog DI signal at Out 2.

IMPORTANT: This setting works only when the Out 2 block is NOT present on
the grid for the current preset.

—
(Ob]
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1/0: USB PAGE

The USB 1/2 and USB 3/4 parameters adjust USB playback levels from -40 to +20 dB. Normally you would set
computer audio playback levels in the computer, but these controls are handy when you need a boost or cut.

1/0: PEDAL PAGE

The Pedal page of the I/0 menu contains parameters to set up expression pedals or a switches connected to the
Pedal jacks on the rear panel. Expression pedals should have a linear resistance taper and max resistance in the
range 10k-100kQ. The Fractal Audio EV-1 and EV-2 pedals are recommended. One or two switches may also be

used at each jack. See "Expression Pedals" on p. 12 and "External Switches" on p. 14.

PARAMETER Description
Pedal 1 Setup Set this according to the what you have connected.
Pedal 2 Setup

EXPRESSION PEDAL
1 SWITCH (TIP)
2 SWITCHES (TIP + RING)

Calibrate PEDAL 1
Calibrate PEDAL 2

Switch 1 Tip Behavior
Switch 1 Ring Behavior
Switch 2 Tip Behavior
Switch 2 Ring Behavior

FOLLOW HARDWARE
VIRTUAL TOGGLE

Switch 1 Tip Polarity
Switch 1 Ring Polarity,
Switch 1 Tip Polarity
Switch 1 Ring Polarity

NORMAL
REVERSE

For 1 expression pedal, choose EXPRESSION PEDAL

For 1 switch, connect the switch to the TIP and SLEEVE of a TRS connector.
With this setting active, the RING function is disabled as a Modifier/External
source to avoid mishaps.

For 2 switches, connect one to Tip and Sleeve and the other to Ring and sleeve.
Calibrate expression pedals connected to an on-board Pedal jack.

First select this menu choice, then:

» Press ENTER.
» Move the pedal through its full range of motion several times.

» Press ENTER again when finished.
Switches, unlike pedals, do not need to be calibrated.

A switch with the default setting of "Follow Hardware" behaves exactly as you
might expect: a latching switch latches, and a momentary switch is momentary.
If you want a momentary switch to behave like a latching/toggle switch instead,
use the "Virtual Toggle" option. Now, every time you tap the switch, its state on
the FM3 will flip from ON to OFF, or OFF to ON.

So for example, imagine a momentary switch mapped to EXTERNAL 1 and
assigned to the Rate of a Rotary. While you press down on the switch, the
Rotary rate increases. When you step off the switch, the rate slows. With the
Behavior changed to "Virtual Toggle", you would tap once for a fast rate, and
then tap again to toggle the rate to slow.

Note that if you accidentally apply the Virtual Toggle setting to a physical
latching switch, you'll need to tap the switch twice (or more) for it to toggle.

The FM3 offers the option to reverse the polarity of any connected switch.
The option “Normal” assumes a “momentary make” switch. Use the option
“Reverse” when using a “momentary break” switch, or for creative applications.

—
-~
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THE MIDI/REMOTE MENU

The MIDI/Remote menu contains global MIDI-related settings, and allows you to make assignments for Global
Controller functions including Block Bypass, Block Channel, the Looper, External Controllers, and more.

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

LEARN MODE

The MIDI Remote menu features a hidden Learn Mode function. Rather than using the knobs to assign a pedal, switch,
or MIDI CC, you can use Learn Mode. This is quick and also potentially saves you from needing to know which MIDI CC
is assigned to a button or pedal on a remote device. Here's how it works:

Navigate to the entry you want to assign: for example, "External Control 1" or "Tempo Tap".

1. Press ENTER to activate Learn Mode.
2. Move the remote pedal, knob, switch, etc. so Learn Mode can detect its activity.

3. The controller will be assigned automatically to your function.
If not, try again, troubleshooting the remote device as necessary, or press Exit to cancel.

MIDI/REMOTE: GENERAL PAGE

PARAMETER Description

MIDI Channel Sets the channel on which the FM3 will receive MIDI messages.

1-16, OMNI OMNI” causes the unit to respond to incoming messages on all channels.

MIDI Thru This enables or disables MIDI thru, which causes messages received at the

Off, On 5-pin MIDI In port to be merged with any internally generated MIDI data at the
MIDI out/Thru port.

Display Offset (Also appears in the Global menu) Causes presets numbers to begin at 001

0.1 instead of 000. This only offsets the display, meaning that it does not change

Scene Revert
ON/OFF

Effect Bypass Mode
VALUE/TOGGLE

Send Realtime Sysex

which preset is actually loaded by a given MIDI message.

Selects between two different ways for scenes to work when you change them
via a Footswitch or MIDI:

“OFF” (Default): Scene edits are RETAINED across Scene changes as long as
you do not change PRESETS. So if you tweak Scene 1, switch to Scene 2, then
switch back to Scene 1, your tweaks will still be intact.

“ON": Scene edits are LOST if you change the Scene without saving. So if you
tweak Scene 1, switch to Scene 2, then back to Scene 1, Scene 1 will have
reverted to its previously saved state. This makes Scene changes feel more like
traditional preset changes.

See also "Scene Revert" on p. 58

This setting determines how MIDI messages set the Bypass State of a block.
When set to “Value” the bypass state is controlled by the CC value (0-63=0FF,
64-127=0N). When set to “Toggle” the bypass state toggles whenever the CC
message is received, regardless of the value (0-127).

Causes the FM3 to transmit MIDI messages for Tap Tempo and Tuner so a 3rd
party MIDI controller can display this information.
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PARAMETER

Description

Program Change

ON/OFF
Ignore Redundant PC

ON/OFF

Send MIDI PC

1-16
OMN|
OFF

MIDI PC Offset

PC Mapping

INITIAL VALUE:
External Control 1-16

Determines whether the FM3 will process or ignore incoming MIDI Program
Change messages.

This setting determines whether the FM3 should re-process or ignore a Program
Change message that corresponding to the current preset. With this setting
“OFF”, a preset will be reloaded—all changes discarded—when it is selected
again via PC. This allows you, for instance, to load a preset, use various
“Instant Access” switches to bypass effects, and then stomp the footswitch
that originally selected the preset to have it revert to its saved state. With this
setting “ON”", redundant PC messages are ignored. When PC mapping is used, if
the current Scene has changed, the preset will not reload but the Scene will still
revert to that set in the map.

Determines whether or not the FM3 will automatically transmit a MIDI Program
Change message at its MIDI OUT port when a new preset is loaded.

This is the easiest way for most people to operate a single connected MIDI
device while changing presets on the FM3. Any custom MIDI mapping is left to
the downstream device. To use this feature you simply select which channel
you want the message to be transmitted on. The “OMNI” setting transmits the
message on all channels.

Adds a specified value to all incoming MIDI Program Change requests before
they are processed. This makes it possible, for instance, to address alternate
presets in different “registers.” You might use the same MIDI messages to
access presets 1-16 for a gig with one guitar, and —by specifying an offset
of +16— use presets 17-32 for a different guitar without re-programming your
controller.

PC Mapping determines whether incoming MIDI Program Change messages
load presets 1-for-1, or load other presets and scenes instead. With PC
Mapping turned “OFF”", presets are loaded 1:1 based on incoming MIDI bank
Select and Program Change messages. With custom PC Mapping enabled,
incoming Program Change messages are re-mapped according to the values in
the table on the Custom page of the MIDI/Remote menu (see below).

These sixteen parameters specify the initial value to be used for each of the

16 External Controllers (p.75) when the FM3 is powered on. This value

persists until data is received from the MIDI controller. This is especially useful
when an external MIDI controller is absent. For example, if you normally use an
expression pedal to control the volume in your presets, a missing pedal might
make the preset get “stuck” in a muted position. Setting an initial value of 100%
for the External Controller mapped to that pedal would ensure that when the
pedal is not connected, the volume will stay at 100% instead of 0%. This setting
is only for controllers with a MIDI CC# assignment. It does not apply to local or
FC pedals or switches.

—
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MIDI/REMOTE: MAPPING PAGE

With PC Mapping enabled (see above), incoming Program Change messages are re-mapped according to the
values in the table in this section.

PARAMETER Description
Map to Preset When PC Mapping (above) is turned “ON”", the parameters in this table specify
Map to Scene which preset and scene are loaded for each incoming MIDI PC message.

See also "Program Change Mapping" on p. 56

MIDI/REMOTE: BYPASS PAGE

The Bypass page of the MIDI menu allows you to map MIDI CC messages—or connected pedals and switches—
to bypass or engage blocks. CC messages can be sent by a MIDI controller or computer connected to the MIDI
IN jack. Each of these settings is global. In every case, the method for mapping a controller to one of these
functions is the same:

1. Use the NAV knob to select the desired function.
2. Use the VALUE knob to assign a controller to the function:

= Select "NONE" to remove all assignments from the selected item.
= The following assignments work with a pedal or switch connected
to the on-board expression jacks of the FM3:
= PEDAL 1 or 2 (EXP/SW TIP) - for an expression pedal or a switch connected to the tip of a TRS cable.

= PEDAL 1 or 2 (SW RING) - for an external switch connected to the ring of a TRS cable.

» FC__ PEDAL 1-4 to assign a pedal connected to the corresponding pedal jack of the designated FC controller.
» FC__ SW 1-4 to assign a switch connected to the corresponding switch jack of the designated FC controller.
= 1-127 to assign a MIDI CC#.

MIDI/REMOTE: CHANNEL PAGE

The Channel page works exactly like the Bypass page except the entries are used to set the Channel of each
block instead of its bypass state. The value of the CC message sets the channel as follows:

0 =ChannelA 1=ChannelB 2=ChannelC 3=ChannelD

The series continues, repeating A, B, C, D for values up to 127 (D).
For additional information, see "Selecting Scenes & Channels Remotely" on p. 55

MIDI/REMOTE: EXTERNAL PAGE

Controller assignments for the sixteen External Controllers used in Modifiers (See Section 9: Modifiers).

MIDI/REMOTE: LOOPER PAGE

Controller assignments for the functions of the Looper.

—
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MIDI/REMOTE: OTHER PAGE

Controller assignments for various other functions of the FM3.

PARAMETER Description
Tempo Tap Provides the ability to tap the tempo using an external controller.
Learn more in Section 11
Tuner Provides a way to remotely enter or exit the Tuner. Learn more in Section 12

Preset Inc/Dec
Preset Inc/Dec Start/Stop

Scene Select

Scene Increment
Scene Decrement

Input 1,2 Volume

Output 1,2 Volume

Output 1 Volume Increment,
Output 1 Volume Decrement,

Output 2 Volume Increment,
Output 2 Volume Decrement

These allow you to step up or down through a sequence of presets with pre-
defined start and end/wrap points. Preset mapping and offsets are ignored.

Don't confuse this with the Preset Inc/Dec function of the FM3's onboard
footswitches. These switches have their own settings and ignore this value,
which is used only for changing presets via MIDI.

Selects specific Scenes. The controller value (NOT the CC number) determines
which Scene is loaded:

2 =Scene 3 4 =Scene 5 6 = Scene 7
3 =Scene 4 5=Scene 6 7 =Scene 8

The series continues, cycling through scenes 1-8 for values up to 127 (Scene 8).

0 = Scene 1
1=Scene 2

For more, see "Selecting Scenes & Channels Remotely" on p. 55

The Scene Increment and Decrement functions allow you to step up or down
through scenes. These functions are triggered by CC data values above 63.

Four individual parameters allow you to globally control the levels of the
corresponding Input or Output blocks.

These options provide a convenient way to permanently increase or decrease the
MAIN output volume for the Out 1 or Out 2 Blocks in the currently loaded preset.
Each time Volume Increment is triggered, the MAIN is increased by 1.0 dB and
the preset is saved. This is the same for Volume Decrement, except it decreases
volume.

A IMPORTANT! Any unsaved changes such as altered effect parameters or
bypass states will also be stored when either of these functions is triggered!

&These functions are designed for use with momentary footswitches set up to
send a CC# value of 127 for “ON” and 0 for “OFF." Do not use an expression pedal
or you may change levels +/-20 dB with a single sweep!

—
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THE UTILITIES MENU

UTILITIES: DISPLAY PAGE
Brightness - Provides a slider to adjust the built-in LCD display.

UTILITIES: ADC LEVELS PAGE

Shows Analog-to-Digital Converter levels for the front panel Level knobs and rear panel Expression jacks for
troubleshooting. You can set the output level here at an exact percentage.

UTILITIES: RESET PAGE

Be very careful with these options. Resetting/erasing is PERMANENT!
Before using these functions, make a complete backup of your unit if it contains any important data.

Reset System Parameters - This page provides a tool to set parameters in the SETUP menu back to factory
default values. This is often one of the first recommended steps during troubleshooting. It never deletes or
modifies your presets. You will be prompted to press ENTER to confirm.

Clear All Presets - A second utility provides the ability to Clear all Presets. You will be prompted to press ENTER
to confirm. This erases every factory preset, leaving them all <EMPTY>.

Erase All User Cabs - This clears all user cabs and is useful, for instance, if you want a fresh start. You will be
prompted to press ENTER to confirm. This erases every user cab, leaving them all <EMPTY>.

UTILITIES: FIRMWARE PAGE

This page indicates which firmware version the FM3 is running, the date that the current firmware was built, how
long the FM3 has been powered on ("Uptime") and the current internal temperature.

UTILITIES: PRESETS PAGE

When executed, all presets stored ion the FM3 will be upgraded to the currently installed firmware version and
automatically re-saved. This process can take up to 20 minutes but will speed up preset changes in some cases.

—
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14 ADDITIONAL TOPICS
FRACTAL-BOT

Fractal-Bot is a handy utility that makes it possible to send and receive presets, cabs,
settings, firmware and other files, both to and from your FM3. The program is simple
and intuitive, with built-in instructions, and an easy “1-2-3" routine. Fractal-Bot can
even keep itself up to date.

Computers running Windows need a driver to connect the FM3.

This driver is available at https:/www.fractalaudio.com/fm3-downloads/
Computers running Mac 0S do not require a driver.
Fractal-Bot is built in to FM3-Edit: https:/www.fractalaudio.com/fm3-edit

A standalone version is also available on our web site at: https:/www.fractalaudio.com/fractal-bot
Updating Firmware (p. 112) Installing User Cabs (p. 118) are covered elsewhere in this manual.

BACKING UP & RESTORING

Backing up your FM3 is crucial to preserving your personalized settings. In the event of any unforeseen mishap,
a recent backup ensures that you can restore your device quickly and easily. Fractal-Bot simplifies this process.
Just switch to its RECEIVE tab and proceed through the three steps. Here are a few considerations:

» When creating backups, Fractal-Bot will prompt you to designate a location for the backup
files. Preparing this location beforehand can streamline the process. Many professionals
adopt a consistent naming system for their backup folders, such as “yymmdd - FM3” (two
digit year, two digit month, two digit day). For future reference, it's also helpful to create
a text file noting the firmware version installed when the backup was created.

» Behind the scenes, FM3 Presets are actually divided into “banks” of 128 presets each. To backup all
of your presets, backup all of the banks. You'll also find an option to back up an individual preset.

» User Cabs are also backed up as a “bank” containing up to 1024 cabs.
You'll also find an option to back up an individual cab.

» A backup of the SYSTEM includes all of the custom settings in the SETUP menu
AND all of the FC related settings. It does NOT contain Preset or Cab data.

RESTORING

Fractal-Bot is also used to restore backup files to your FM3. In this case, the process is less automated but

still very easy. You will need to send over all of the files from your backup set individually. Once the first file
completes, send the next file over, and so on, until they are all finished. Remember to reboot the FM3 immediately
if a System file has been transmitted to it! (Fractal-Bot will remind you.)

You can use the same process to install presets or cab files you download.

MIDI

On the FM3, backup and dumping are NOT supported over 5-pin MIDI. You can transmit backup files to the unit
this way, but because the transfer rate is so slow, this can take a LONG time and is advised against.
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FIRMWARE UPDATES

Firmware is like the operating system of your FM3. It is tracked using version numbers like 1.00, 2.00, etc. Every
FM3 is shipped from the factory with the latest firmware version installed. You can check your version by pressing
the SETUP button (Push-knob E) on the Home page. The version is displayed at the top left of the Setup menu.

UPDATING

NOTE: Before performing a firmware update, it is wise to back up your unit (see previous page).

Fractal-Bot makes firmware updates easy. Before you begin, please QUIT any other audio or MIDI software
applications such as a DAW (Digital Audio Workstation), Cab-Lab, MIDI utilities, etc. Then follow these steps:

1. Launch Fractal-Bot (see previous page.) It is recommended to make a backup before updating.
2. When you select your device in Step 1, Fractal-Bot checks for new firmware and guides you through installation.

3. Please read any included Release Notes. These will let you know what’s new and alert you to anything to be
aware of before upgrading to the new version.

4. After file transmission is complete, the FM3 still needs time to process the update. Watch the FM3 front panel
display, which will eventually instruct you to power off, wait 5 seconds, and then power on again.

5. You can verify that the upgrade worked by checking the installed version. Press the SETUP button
(Push-knob E) on the Home page. The version is displayed at the top of the Setup menu.

NOTE: Firmware updates will occasionally be accompanied by new versions of the Axe-Fx Factory Presets.
These will be available separately and can also be installed using Fractal-Bot.

OPTIONAL MANUAL INSTALLATION: Besides automatic updates, you can also manually download firmware from https:/www.fractalaudio.
com/axe-fx-iii-downloads. The firmware itself is a MIDI System Exclusive or “SysEx” file but will be will typically be in a zip archive also
containing various documents. Extract the .syx file to a location you can easily find. Do not double-click the .syx file. Instead, go through the
three steps of Fractal-Bot and browse to the extracted .syx file during step 2, “Choose a File to Send”. Send the file and then see Step 4 above.

FORCING REINSTALLATION: In you already have the latest version installed but want to re-install it for any reason, hold Cmd (Mac) or
Ctrl (Win) while selecting your device in Fractal-Bot. Similarly, if you Comd/Ctrl click the blue “Ready to Install” prompt, you can save the
dowloaded file to a location of your choosing.

FIRMWARE Q&A

Q: Can | skip versions to go from a very old firmware version to a much newer one?
: Yes. It can be important to read the Release Notes for versions that you skipped (always included).

A
Q: Can | downgrade from a newer firmware to an older one?
A

: Yes, but newer presets are not compatible with older firmware. You'll need to restore a backup of presets
compatible with the older firmware version you're installing, or find the older factory preset files.

Q

Will updating my Axe-Fx firmware erase my custom presets or user cabs?

No, updating firmware never erases your presets or cabs but we still recommend making a backup before you
update. Also, updates may alter the sound of existing presets. Always read the Release Notes when updating.

>

Q

The firmware update failed mysteriously. What should | do?

A: If the Axe-Fx still boots normally, just try the update again. If successive failures occur, please delete and
re-download the update file before trying again. Trying a different USB port or cable can also solve issues.

Q

After updating, my Axe-Fx will no longer boot normally.
A: Check the RECOVERY processes detailed on the next page.
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RECOVERY

PROBLEMS DURING/AFTER FIRMWARE UPDATE

The FM3 has a built-in recovery system known as the “Emergency Boot Loader” to protect you against mishaps
during firmware update. To boot from the emergency boot loader:

1. Power down the unit and wait five seconds.
2. Power on holding both PAGE LEFT and PAGE RIGHT buttons until the Emergency Utility page appears.
3. Update as normal using Fractal-Bot.

PROBLEMS WITH A SINGLE PRESET

If your FM3 will not boot normally, the problem may just be the current preset. You can force the unit to load an
empty initialized preset as follows:

4. Power down the unit and wait five seconds.
5. Power on holding HOME until the boot-up progress bar first appears.

The FM3 will boot with an empty initialized preset in location “000". You can STORE this to any other location to
overwrite a problematic preset.

PROBLEMS WITH GLOBAL SETTINGS OR PARAMETERS

In the very unlikely event that a problematic system parameter prevents the FM3 from booting normally, you may
use the following procedure to recover:

1. Power down the unit and wait five seconds.

2. Power on holding EDIT until the boot-up progress bar first appears.

3. Enter SETUP, open the Utilities menu, and page to Reset.
4

Execute Reset System Parameters as indicated on-screen (Push-knob A followed by ENTER).
WARNING! Do NOT accidentally perform CLEAR ALL PRESETS!!!

5. Follow the on-screen instructions to execute. Press HOME when finished.

You can in fact hold both HOME and EDIT at once to reset the current preset and prevent the loading of
global settings and parameters.

GETTING HELP

Our forum is a source of great help ranging from product Q&A to tutorials and more. Fractal Audio staff
participate in the conversation, and response times can be very fast. Find it at https://forum.fractalaudio.com

Our wiki, maintained by members of the Fractal Audio community, is also an excellent resource:

https://wiki.fractalaudio.com

You can get support directly from Fractal Audio Systems at: https:/support.fractalaudio.com
or internationally via our dealers listed at https://www.fractalaudio.com/international-ordering.

—
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FOOT CONTROL TUTORIAL

The following tutorial explores the factory default layout #7, named “Perform” because it is intended to show one
possible very simple way to use the FM3 while performing. This tutorial will use FM3-Edit but you could perform
all of these operations from the front panel just as easily.

To begin, load preset 382: Performance Tutorial and set up FM3-Edit as shown below.

[ 1) “FC Controllers” Edit mode is turned on.j

prmr s 2) “Show Edits on FM3" is enabled.
S FM3-EDIT

4) Show As “FM3” and select
“View 1" and “LCDs"

Remember that under Windows, you will need to install drivers before using FM3-Edit.
See Section 3: USB.

Continued on next page.
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UNDERSTANDING VIEWS

This layout uses four different views, each set up like a self-contained mini layout.

Views are detailed on p. 85 but here’s a simple summary.
» The FM3 is based on “Layouts”, each containing programming for twelve footswitches.
» Unlike the larger FC-12 controller, the FM3 can only show three of these “Switch Definitions” at once.

» The view determines WHICH three switches are shown on the FM3.

View 3 View 4 ) ) )
In FM3-Edit, switches are shown in two rows of
O 0 00 0 O six. Views are arranged as shown.
O O O O O O Try using FM3-Edit to change the view now.

View 1 View 2
ABOUT LAYOUT 7: PERFORM _

Layout 7 is designed as a “minimal” performance controller. Each view has its own purpose:

= View 1 selects three scenes. Our example preset contains Clean/Crunch/Lead.

= View 2 allows you to change presets. (The idea is that you might use one preset per song.)

= View 3 contains Tap Tempo and Tuner.

= View 4 is set to toggle three different effects on or off. By default, these are Drive 1, Delay 1 and Reverb

CHANGING VIEWS

View 1 changes the Scene. This layout is based on the idea that you might rely mostly on scene changes for
different sound settings within a song. Here, three switches are forced to Green, Yellow, and Red, making it
easy to recognize this layout. (See also “LED Ring Colors” on p. 11).

View 1
Select Scenes

From within View 1, you can

O O O O O O O O O Press and Hold any switch to
View 2 View 3 View 4 change the view as shown.
Change Presets  Tap/Tune Toggle FX
aka “UTILS”
View 2 View 3 View 4
Change Presets  Tap/Tune Toggle Effects
O O 'O O O O From any other view, Press
CE ? and Hold the middle switch
to go back to View 1
“Home").
O O O (‘Home?)
View 1 Try changing views with your feet now.

Select Scenes
Continued on next page.
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Continued from previous page.

MAKING A CHANGE FROM THE FM3

In this next section, we'll use EZ Edit on the FM3 to make a change to one of the footswitches. We're going to
change the Reverb footswitch to one for Chorus. EZ Mode allows us to tap the footswitch we want to change
and make simple edits on the spot, but remember that while you're in EZ mode, the normal functions of the
footswitches won't work! Therefore, if you want to test a switch you first need to exit from EZ Mode!

1. To begin, use your feet to change to the Effects View as shown on the previous page. (You should see three
footswitches labeled “Drive 1" “Delay 1" and “Reverb 1")

On the FM3, open the SETUP Menu (Push Knob E).
NAV to the FC Controllers/Onboard Switches menu choice and press ENTER.
Make sure the “EZ" page tab is selected. If not, use the << PAGE >> buttons to select it.

On the FM3, tap the Reverb 1 footswitch. Notice the “TAP” settings for this switch in the FM3 main display:
Category is set to “Effect”, Function is set to “Bypass”, and Effect is set to “Reverb 1"

6. Nav to Effect and turn the VALUE knob until “Reverb 1" changes to “Chorus 1”.
(Remember that you never need to STORE changes in any SETUP area. They take effect immediately.)

a B w DN

7. Press EXIT twice and test your new Chorus Footswitch on the FM3.

MAKING A CHANGE IN FM3-EDIT

Now we'll use FM3-Edit to change the Chorus switch back into a reverb switch.
1. In FM3 Edit, change to View 4.

Click the upper right switch (which is now set to “Chorus 1" if you did the steps above).

2
3. Inthe “TAP” section of the lower panel, change the Effect from “Chorus 1" back to “Reverb 1”.
4

. As when using the FM3 front panel, there is no need to STORE. Test your switch on the FM3.

The “Show As” and “View” controls in FM3-Edit are visual aids. They help you focus on those
switches that you need to see. Be aware however, that when you select “FC6" , the order of
switches on the screen is different from the order for “FM3" or “FC12". This is indicated with

small numbers shown inside the LED rings in FM3-Edit.
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CONCLUSION

»

In this tutorial, you learned about Layout 7: Perform. We covered how it
uses VIEWS to create different sets of controls on the FM3.

You learned to change the view in an “out and back” arrangement.

You used EZ Mode to make a change on the FM3 itself, followed by a similar change through FM3-Edit.

ABOUT THE TUTORIAL PRESET

»
»

The tutorial preset is set up with three scenes: 1: Clean, 2: Crunch, and 3: Lead

These scenes are set up in such a way that you can dial in the amp, cab and drive pedal sounds

fully independently. This provides one possible model for designing your own FM3 presets.

= Scene 1 uses Amp Channel A, Cab Channel A and Drive Channel A.

= Scene 2 uses Amp Channel B, Cab Channel B and Drive Channel B.

= Scene 3 uses Amp Channel C, Cab Channel C and Drive Channel C.

Delay and Reverb are set so that the tail will spill over between

scenes, or when you turn these effects on or off.

» The Lead sound uses Delay Channel C, which is a copy of channel A with different mix levels.

= Differences across channels can sometimes alter spillover — changing the Delay Type or the Reverb Size,
for example. See “Spillover” on p. 133.

Other blocks and settings in this preset are shared across all scenes. This replicates

the way real pedals work. A phaser, for instance, will be either on or off and any change
to its knobs will be heard no matter which amp channel you are using.

A nice “Clyde” Wah pedal is included. It uses External 1 as described in “Global Expression Setup” on p. 13.

The LOOPER is included in this preset so that you can try it out. Just remember that the
Performance layout does not include an “Exit” to the Master Layout Menu, so you will
need to press HOME and then change the layout Manually to operate the looper.

If you wanted to add a switch in Layout 7 to show the Master Layout Menu, you could place it
on the un-used Tap function of the middle switch in View 2 or View 3. Follow the steps on the
previous page of this tutorial, choosing Category: Layout, Function: Select, Layout: 9.

NEXT STEPS...

»

Once you have completed this tutorial, we recommend that you
explore the other topics presented in Section 10.

“The Footswitch Functions Guide” is an essential companion to making the most of the FM3.

As you learn more, use your imagination to decide how you want the FM3 to work for you.
= |f you need help, our forum is a great resource. Fractal Audio staff members participate in the
conversation, and response times can be very fast. Find it at https:/forum.fractalaudio.com

= You can also get support directly from Fractal Audio Systems at: https://support.fractalaudio.com
or internationally via our dealers listed at https:/www.fractalaudio.com/international-ordering

—
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LOADING USER CABS

In addition to thousands of onboard cabs in its factory banks, the FM3 allows you to store up to 1,024 cabs in
user memories. These “User Cabs” allow you to personalize your FM3 with unique tones.

User Cabs — also know as “Impulse Responses (IRs)” — may be transferred to the FM3 as follows:
1. First, you'll need an impulse response file in SysEx format (.syx).

» Fractal Audio Systems offers various professional Cab Packs at https://shop.fractalaudio.com
These include creations by Fractal Audio as well as third-party producers.

= Axe-Change, our file sharing site, is a great resource for FREE cabs. https://axechange.fractalaudio.com
= Don't confuse the newer “.IR" file format, which is intended for re-mixing in Cab-Lab (see below).

2. Using Fractal-Bot or FM3-Edit, transmit the file to your FM3, noting which numbered Slot you are sending it
to. (Example: #215.)

» Fractal-Bot - This basic utility can send individual cabs to any location or transmit entire banks. To import
a single IR, open a Cab block on the grid and set Cab 1 to the Bank and Number you want to transmit a cab
to. Then send the sysex file to the FM3 using Fractal-Bot and the unit will save the IR to that location.

= FM3-Edit - The Manage Cabs tool allows you to drag and drop user cab files into memory slots. Don't
forget to press SAVE! You can also manage entries already in the memory of the FM3 with operations like
copy, paste, rename, and drag-and-drop re-ordering. When you purchase a Cab Pack, this is the best and
easiest way to load multiple IRs at once into your FM3, audition the results, and organize your favorites.

3. Once the IR has been transmitted to your FM3, select the Cab block in your preset and press EDIT.
4. Change the cab to the User Bank and Number that your IR was transmitted to. (Example: “USER, #215").

NOTE: In comparison to older Fractal Audio systems products, user cabs are NOT included in a backup of the
SYSTEM area of the FM3. Conversely, restoring a System backup will never overwrite user cabs.

Cab-Lab is a full-featured 8-channel
IR mixer and toolbox in standalone
and plug-in formats.

For decades, artists, producers
and engineers have created tones
using a mixer to blend the sounds
of different mics or speakers.
While the FM3 provides two mixer
slots, Cab-Lab has EIGHT, and has
additional options and tools, with
the ability to export Cab files and
save mix sessions.

Learn more at:
www.fractalaudio.com/cab-lab-3
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AXE-CHANGE

Axe-Change is the official source for sharing Preset and Cab files for Fractal Audio Systems products. You can
upload your own FM3 presets or browse what others have contributed including some high profile artists (though
regrettably many artists treat their presets as guarded secrets). Axe-Change is also a great source for free Cabs!

Find Axe-Change at https://axechange.fractalaudio.com
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FM3 + FC6 = OMGI!
INTRODUCTION

“OMG9” (named after a tongue-in-cheek comment on our forum) is a set of custom layouts for the FM3 designed
for use with a single Fractal Audio FC-6 Controller. A single XLR/FASLINK™ cable connects the two units for
two-way communication, simultaneously providing power to the FC-6 without the need for an external AC adapter.
External switches and expression pedals, such as the Fractal Audio EV-1 or EV-2, can be connected as required.

Once the OMG9 layouts are loaded, the FM3 itself remains “parked” on a special layout which changes what the
FC-6 does. For example, when you tap the left switch of the FM3, the FC-6 changes to “Presets Mode”. When
you tap the center FM3 switch, the FC-6 switches to “Scenes Mode”, and so on. The “Master Layout Menu” is
no longer used once OMGY is loaded. OMG9 provides everything that most players need, but of course all of its
settings can be changed or customized to suit your personal needs.

Despite its power, the OMG9 is remarkably user-friendly. There are few “press and hold” functions, reducing the
need to memorize operations, and sound changes fire on the switch “downstroke” for precise musical timing. The
use of color minimizes the need for reading, embodying the dictum, “Don’t make me think!”

This brief guide covers setup and how to use the OMG9 layouts.

=)
| Em AMP MODELER / FX PROCESSOR HOME corr sToRe TEMPO
U o DAD SrracTar FC-6
VALUE D FOOT CONTROLLER
4|:] NAV [:]>
] ] ] L]
" 8 c o & om_ET wwew 2N 172\ 172\
] OO0 00 0O g =g
] L] L] L] ] L]
2N 2N N 2N 2N 2N
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Using the OMG9

When you use the OMG9, you tap the three switches on the FM3 to toggle the FC6 between selecting Presets
mode, Scenes Mode, and Effects Mode. You press and hold switches on the FM3 to access the Tuner, go to
an extended Scenes mode, or enter Looper control mode. Illustrations below and on the next page provide a
complete guide to the functions and layouts.

SWITCHES ON THE FM3
Except for the Tuner, FM3 footswitches change what the FC-6 does.

FC-6 PRESETS MODE FC-6 SCENES MODE FC-6 EFFECTS MODE
Hold for TUNER Hold for MORE SCENES Hold for LOOPER MODE

FC-6 in PRESETS MODE

Presets Mode allows you to select presets and change preset banks.

(1

Hold for Bank Down Hold for Bank Up

—
—
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FC-6 in SCENES MODE FC-6: MORE SCENES

Scenes Mode is used to select Scenes. Extra switches contain Tempo and “Per-Preset” functions 1-3.
( scenes J ( Scene S ) % Scene6 ) (  PP#1 J ( pr2 ) g PP#3 |
il 4
\[ ******* % ....... ]/ Tap FM3 Switch 2 to :
change the FC-6 to

“Scenes”.

Hold FM3 Switch 2
—3 — —

—3 —3 —
; %ﬁ @\ to change the FC-6 to /@ iﬁﬁ @\

“More Scenes”.

( scenet 6( Scene2 )(R Scene3 ) ( Scene7 6( Scene 8 )(X \Tempo )

FC-6 in EFFECTS MODE FC-6: MORE EFFECTS

Effects Mode is used to switch effects on or off. A “More” switch toggles between two views.

( Phaser 1 J( Chorus1 )%MORE >> ) ( Rotary 1 J( Pitch 1 )g« MORE )
i, ( \\\ i'. C- //

The “<<MORE>>" — — =
switches toggle be- © e ©
(—] — tween these two views. N
ll \\

( Drive 1 6( Delay1 ﬁ\Reverb1 ) ( Comp 1 6( Trem';’an1 )6FIanger1 )

FC-6: LOOPER MODE

Remember that the Looper Block needs to be present in your presets before it can be used.

( Once \J( Reverse )%Half Speed )

N\

/4

( Record
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OMG9 LAYOUT DETAILS

FM3: Layout 8, OMG9Y: Left Switch FC-6: Layout 1: Presets

Tap the first FM3 switch to select Preset Mode on the FC-6, where six
footswitches select six presets, and the bottom left and right switches have

Bank Down and Up functions on press-and-hold. (TAP: P4 "TAPZ P5 "TAPZ P6
Hold the left switch of the FM3 to enter the Tuner. Tap any switch to exit. HOLD: - JlHOLD: . JlHOLD: N
TAP: PRESETS TAP:SCENES1  |(TAP:EFFECTS | = [TAP:P1 |(7AP: P2 )[7AP: P3
HOLD: Tuner HOLD: SCENES2 ~ J|HOLD:LOOPER | |HOLD:Bank-1  J\HOLD:- J(HOLD: Bank +1
FM3: Layout 8, OMGY: Center Switch FC-6: Layout 2: Scenes, View 1

Tap the FM3 center switch to enter Scenes Mode on the FC-6, where six

switches select scenes 1-6. Hold the FM3 center switch for the “More Scenes” (

view on the FC-6, where you will find the remaining scenes 7 and 8, plus TAP: Scene 4 "TAP' Scene 5 "TAP‘ Scene 6
“bonus” functions: Tap Tempo and three Per-Preset placeholders. HOLD: - JlHOLD: - JlHOLD: -

[ TAP: PRESETS TAP: SCENES V1 |[ TAP: EFFECTS ] [7AP:Scene1 |[AP: Scene 2 ) TAP: Scene 3
| HOLD: Tuner HOLD: SCENES V2 J\HOLD: LOOPER | |HOLD: - J{HoLD: - J(HoLD: -

FC-6: Layout 2: Scenes, View 2

EXPERT TIP: This setup relies on a simple trick. The FM3 itself stays “parked” on

only Layout 8. Aside from the tuner, none of the switches in layout 8 do anything (TAP: PP#1 "TAP: PP#2 "TAP: PP#3
on the FM3. You might imagine that they would therefore use the “Unassigned” HOLD: — JlHOLD‘ B JlHOLD‘ B
function, but this would disable their custom colors, custom names, and the \ ‘ ’ ‘
essential “Layout Links” used to switch the FC-6. Instead, the FM3 switches (TAP: Scene 7 "TAP: Scene 8 "TAP: Tap Tempo
change the View in Layout 8 — the very layout they are contained in! This also - - -
allows the FM3 to use bright/dim LED rings to show the state of the FC-6. (HOLD: - JlHOLD' - JlHOLD' _
FM3: Layout 8, OMGY: Right Switch [Tap] FC-6: Layout 3: Effects, View 1
Tap the FM3 right switch to enter Effects Mode. Five switches on the FC6 are >
assigned to bypass/engage different effects. The “MORE” switch toggles out TAP: Phaser 1, Byp "TAPI Chorus 1, Byp "TAP3 MORE>>
to a view containing five different effects (and back). HOLD: - JlHOLD: - JlHOLD: -
(TAP: PRESETS  )(TAP:SCENESV1  |[TAP: EFFECTS (TAP: Drive 1,Byp  |(TAP: Delay 1,Byp  |[TAP: Reverb 1, Byp
{ HOLD: Tuner J{HOLD: SCENES V2 J|HOLD: LOOPER [ HOLD: - J{HoLD: - J(HoLD: -

FFC-6 Layout 2: Scenes, View 2
NOTE: Almost all of the switches on the FC-6 in this setup have the HOLD

functions UNASSIGNEP. This gllows t'heir tap functions to fire on the switch (TAP: Rotary 1, Byp "TAP: Pitch 1, Byp "TAP: << MORE

downstroke” for precise musical timing. HoL: - JlHOLD: B JlHOLD: B ‘
(TAP: Comp 1,Byp  |(TAP: Trem 1,Byp  |[TAP: Flanger 1,Byp |
[ HOLD: - J{HoLD: - J(HoLD: -

FM3: Layout 8, OMG9: Right Switch [Hold] FC-6: Layout 5: Looper

Hold the FM3 right switch to enter Looper Mode. Remember that the Looper .

block must be present in your presets in order for this layout to work. TAP: Once "TAP: Reverse "TAP3 Half-Speed
| HOLD: - J{HoLD: - J(HoLD: -

(TAP: PRESETS  ][TAP: SCENES 1 TAP: EFFECTS TAP: Record |[TAP: Play |[7AP: Erase

| HOLD: Tuner J{HOLD: SCENES 2 J{HOLD: LOOPER [ HOLD: - J{HoLD: - J(HoLD: -

Layouts 4 and 7 are completely un-used in the OMGY setup.
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PERFORMANCE CONTROL PAGES

INTRODUCTION

It is easy to edit the FM3 using its intuitive system of menu pages and parameters, but you can't always do this
mid-performance.

Musicians do sometimes adjust their equipment while playing, however (during a break or even mid-song).
Traditional analog gear is very accommodating: amp knobs are at arm’s length, and you can easily reach down
and tweak a pedalboard effect.

The Performance control pages of the FM3 allow exactly this kind of easy, direct adjustment without menu-
diving. Each of the two Performance Control Pages (aka “Perform Pages”) hosts ten controls of your choice. The
five “ABCDE" knobs provide instant access to one row, and the next is just a button tap away. You can even add
custom labels. Performance Control pages stay conveniently “parked” on the screen as you change presets or
scenes, creating an experience just like that you get from dedicated hardware.

One performance page (Perform-Gbl) is global, meaning its controls stay the same as you change presets.

The second performance page (Perform-PP) is per preset, meaning that the controls displayed there are based on
settings in the current preset. One preset might show ten different “Mix” controls, for instance, while another has
assorted options like drive pedal level, delay time, chorus rate, and so on. It's totally up to you.

DISPLAYING A PERFORMANCE PAGE

Displaying a Performance page is easy: just press Home followed by Page Right to your choice of the Per-Preset
or Global perform page. These pages stay “parked” on the screen until you manually change to another page, so
you can change presets or scenes and still have your custom Performance Control options ready to use.

In summary, Performance Control pages provide an easy and intuitive way to interact with your FM3 just as you
would with traditional analog gear.

ADJUSTING PERFORMANCE PAGE CONTROLS

Using these controls is easy. They behave exactly like the knobs, switches and selectors of the normal edit pages.
While displaying a Performance Page, just use the A,B,C,D or E knobs or NAV and VALUE to make changes. Use
the NAV up or down keys to change rows.

A control on one of the performance pages is a linked stand-in or “alias” for the same control in its usual place.
For example, adjusting Amp Level on the global performance control page is the same as adjusting Amp Level
wherever else it may be found in the edit menu of the amp block. If you make a change on a Perform page and
then store the preset, the change is saved. If you make a change on a Perform page and then change the preset
without saving, the change is discarded.

—
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TUTORIAL: HOW TO SET UP PERFORMANCE PAGES

Performance Pages must be set up using FM3-Edit, the companion editor/librarian software for the FM3. In the
following tutorial, we will set do two examples.

1.

o g~ W

7.

In this tutorial, we'll edit the Global Performance page. To display it, tap Home, then tap Page Right twice.
Notice that the factory default settings place the basic knobs of the AMP block here: Drive, Bass, Mid, Treble,
Presence, Depth, Master Volume, Level. There are also two empty spots. We'll fill one of them here with the
Delay Mix control so you can quickly adjust delay levels when you play.

Connect your FM3 over USB to a compatible Mac or Windows computer and Launch FM3-Edit (see p. 15).
(Remember, you will need a driver if you are running Windows. See Section 3: USB).

In FM3 Edit, load Factory Preset 001 or any preset that contains the Delay 1 block.
Once this preset loads, click on the delay block to select it in the grid.
Switch to the Performance Page editor in FM3 Edit by clicking the Perform button above the grid.

Drag and Drop the Mix parameter of the delay block to the empty slot in the top row of the Global
Performance Controls area. IMPORTANT: You must drag controls by their LABEL! If you drag on the knob, you
will change its value. Don't panic if this happens, just UNDO by pressing Command + Z (Mac) / Control + Z
(Win) and then try again.

That's it! You can exit the Perform Page editor now by clicking again on the Perform button above the grid

NOTE: Since we've only changed a Global Performance Control, there is no need to store anything.
In comparison, when you edit the Per-Preset Performance page you must save the preset to commit changes.

8.

10.

Let's add Reverb Mix to the remaining empty slot on the Perform-Gbl page. We must first change to the
reverb block so we can drag-and-drop from its edit menu. Of course we could momentarily return to the grid,
but there’s a way to change the current block without doing this. A dropdown menu in
FM3-Edit lists every block in the current preset. Find it left of the large block icon in the
lower panel of FM3-Edit (shown at right, highlighted in green). Select the reverb from
this list and then drag the Mix parameter to the Performance Page editor as you did
with the Delay Mix.

You can also use drag-and-drop to rearrange controls on performance pages. Drag one
control onto another to swap them. Try this out on the Reverb Mix and Delay controls.
Decide how you like this and then move on.

TIP: To remove a control, click it and then press Delete/Backspace on your keyboard.

You can change the two line label for any control by double-clicking on the existing name. Type your desired
text and then press Enter/Return on your keyboard to confirm. Test this by changing the first line of the delay
control to “DELAY” instead of “DLY1".

You have reached the end of this tutorial. Test your changes on the FM3.

—
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SETLISTS & SONGS

INTRODUCTION

In the world of musical performance, a “Setlist” is a list of songs to be performed in a specific order. A setlist
creates the structure for a show, letting you plan ahead how to start strong, avoid lulls, and finish memorably. A
setlist also helps band members and crew to be ready for what comes next, instead of stopping to ask questions
or search for the needed settings. A short “singer/songwriter” Setlist might contain 4 songs. A typical modern
rock/pop concert setlist might have from 12-25 entries. A hard working cover band might play four different sets
covering a total of 100+ songs!

The Fractal Audio Setlist/Song feature provides a way to prepare an ordered Setlist of named Songs. FC
footswitches can then change songs in order and present the various sounds needed for their named Song
Sections (intro, verse, solo, etc.). Like FC Layouts, Setlists and Songs can be edited through the Axe-Fx Il front
panel or in Axe-Edit, which also includes convenient utilities for import, export, and more.

The Setlist Songs feature requires an FC-6 or FC-12 Foot Controller. On the FC, Song footswitches allow you to
select songs. Section footswitches load sections from the current song. Setlist footswitches allow you to choose
different Setlists.

CREATING SONGS & SETLISTS

The Setlists/Songs feature is accessed through a new area of the global SETUP menu called FC Setlists/Songs.
To use this feature, first create one or more songs, then add them to a Setlist in any order. Assign FC Switches to
any layout to access the desired features. Setlists, Songs and Sections are like other areas under Setup in that all
changes take effect immediately and they do not need to be stored.

SONGS & SECTIONS

= Each song has a number, a name (10 chars) and contains six numbered Sections.

= Each section has a number, a name (10 chars), and a designation
of one Preset and one Scene (1-8 or DEFAULT

= Upto 128 songs can be created in total.

For Example, imagine Song 1, named “All | Want”

» Section 1: named “Intro” loads Preset 1, Scene 1

» Section 2: named “Verse” loads Preset 1, Scene 2

» Section 3: named “B-Section” loads Preset 3, Scene 1

» Section 4: named “Chorus” loads Preset 510, “Default Scene”
» Section 5: named “Solo” loads Preset 1022, Scene 6

» Section 6: is not used in this song. Its “Preset” is “NONE", which disables the section.

—
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TO CREATE A SONG:

4
4

SETLISTS/SONGS

SONG 1
SONG 2
SONG 3
SONG 4
SONG 5
SONG 6
SONG 7
SONG 8
SONG 9
SONG 10
SONG 11
SONG 12

(> Nav

RESET SONG

All | Want
Astray

So Blind
Astray
Back 2 Zero
In My Mind
Meters

In Love w U
Leader
Play It Loud
Set Me Free
Dreaming

EDIT SONG

EDIT SONG 1: All | Want

(» Nav
RESET SECT

PRESET
1
1
3

Preset
EXIT

Open SETUP: FC Setlists/Songs and page right to “Songs”.

Press Exit when finished to return to the master Songs list.

NAME SONG

DEFAULT
1
6
DEFAULT

14 ADDITIONAL TOPICS

Navigate to any Song and press NAME SONG (push knob C). Enter a name using
controls that work identically to those for presets and scenes.

Next, press Enter or EDIT SONG (push knob B). Define each of up to six Sections by using
the controls to enter a PRESET number, a SCENE number, and a section NAME.

Setlists

Fig 1: The Songs page of the Setlists/Songs menu, aka the “Master Songs List”

Sections

NAME
Intro
Verse
B-Section
Chorus
Solo

NAME SECTION

Fig 2: The Edit Song page of the Setlists/Songs menu, where Song Sections are created.

12
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ABOUT SETLISTS

Each of the four Setlists contains up to 32 songs in numbered positions. A particular song can appear more than
once in the list. Empty slots are permitted only at the end.

* Each Setlist has a number and a name (10 chars).

= The “ACTIVE!" designation serves to select a specific setlist, indicating which song list will
populate the FC footswitches. While many performers may only need one setlist, others
could use different setlists for various bands or gigs. Some might even perform extensive
shows that require activating different setlists as the performance progresses.

» To change the active Setlist, open SETUP/FC Setlists/Songs, and turn Knob C
to move the “ACTIVE!” marker, or use FC “Setlist” footswitches.

SETLISTS/SONGS Setlists

Songs

SETLIST 1 Active Set!
SETLIST 2
SETLIST 3

SETLIST 4

Bar Gig
Church Gig
Jamming
Setlist 04

(> Nav -
RESET SET EDIT SET

Active Set
NAME SETLIST

Fig 3: The Setlists page of the Setlists/Songs menu, where you can access setlists for editing or change the Active Setlist.

EDIT SET 1: SET NAME

SLOT1 001: | Want
SLOT 2 022: Last Time
SLOT 3 014: You Gave
SLOT 4 002: Astray
SLOT S5 009: Leader
SLOT 6 016: Rewind
SLOT 7 027: Rust

SLOT 8 067: On the Run
SLOT 9 005: Back 2 Zero

SLOT 10
SLOT 11
SLOT 12

0le:
089:
090:

Dreaming
Shine
Madrigal

(> Nav

Select Song
-- EDIT SONG

Move Song S
INSERT DELETE

Fig 4: The Edit Setlist page of the Setlists/Songs menu allows you to easily insert, remove, or re-order the songs in a Setlist.
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FC SETLIST/SONG FUNCTIONS

The Setlist/Song feature uses three new categories of FC footswitch functions: SETLIST, SONG, and SECTION.

Each function has one or more self-explanatory parameters, plus various options for the FC footswitch “Mini-
Display”. For an introduction to footswitch functions, see “Tap & Hold Functions” on p. 80

For complete details on these new functions, see the Fractal Audio Footswitch Functions Guide.

As of this writing, none of the FM3 factory layouts contain Setlist or Song/Section footswitches.

SETLIST FUNCTIONS

Three “SETLIST” functions change the Active Setlist:

=  SETLIST: SELECT : This makes the designated Setlist “Active” by its number, 1-4.
= SETLIST: TOGGLE : This toggles between two setlists, making them “Active”.

= SETLIST: INC/DEC. : This incrementally steps through the Setlists to select one as Active.
*  You can also change the Active Setlist on the Setlists page of SETUP: FC Setlists/Songs, or in Axe-/FM9-Edit.

SONG FUNCTIONS

Three “SONG” functions load Songs based on their numbered positions within the Active Setlist.

= SONG: SELECT IN SET : This loads a song by its numbered position (1-32) in the Active Setlist.

= SONG: TOGGLE IN SET : This toggles between two songs by their numbered positions in the Active Setlist.

= SONG: INC/DEC IN SET : This incrementally steps forward or backward through all of the
non-empty songs in the Active Setlist. (Empty songs are skipped automatically, and any
empty songs at the beginning or end of the list are skipped when the list “wraps.”)

SECTION FUNCTIONS

Three “SECTION” functions load sections from the current song. Whenever a Song Section is loaded, the main
display of the FC changes to show the name of the current song, and the name of the current section.

Three functions select songs from within the current Active Setlist.
= SONG SECTION: SELECT : This loads a Section by its number in the current Song.
= SONG SECTION: TOGGLE : This toggles between two Sections of the current Song.

= SONG SECTION: INC/DEC : This incrementally steps forward or backward through all of the
Sections in the current Song. (Empty Sections are skipped automatically, and any empty
Sections at the beginning or end of the list are skipped when the list “wraps.”)

—
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FREQUENTLY ASKED QUESTIONS

Q:
A:

Q

2R =R

Q

Why all the technical terminology?

The language of the FM3 is for the most part the universal language of professional audio. This allows the
FM3 to be used by casual and professional players, producers, engineers, and beyond. The terminology
and concepts you will use and learn are accordingly not unique to the FM3. Understanding them will help
you to master the craft of pro audio and to communicate with others. At the same time, the FM3 is easier
than ever, with dedicated controls and a clear interface that doesn't distract or disrupt the creative flow.

What is “FRFR"?

FRFR stands for “full-range, flat response.” This acronym is used to describe a “neutral”
speaker or speaker system that is designed to reproduce the entire audible spectrum of
20 Hz - 20kHz without emphasis. Examples of FRFR systems would include high-quality
studio monitors and properly designed PA systems or monitors. Many manufacturers are
also now offering FRFR systems designed specifically for direct guitar applications.

How do | upgrade the firmware of my FM3?
Use Fractal-Bot. See p. 111.

Can | load my presets from the Axe-Fx IIl into the FM3 (or vice versa)?

Yes! Axe-Edit and FM3 Edit have both been updated for cross compatibility. The FM3 will do
its best to interpret larger Axe-Fx Il presets but you should always check the results.

= The top 4 rows and first 12 columns of an Axe-Fx Il preset are imported first. This aligns the top-left of the
FM3 grid with the Axe-Fx Ill grid. Any incompatible block will be replaced by a shunt.

= Blocks in rows 5 and 6 as well as columns 13 and 14 of the Axe-Fx Il preset are added to the first available
spaces of the FM3 preset. Incompatible blocks will not be imported.

= When converting an Axe-Fx Il preset to an FM3 preset it is possible to have more blocks than the CPU
can handle. If this happens, the FM3 device will display a blinking red banner in the top-left of the HOME
screen that reads “CPU Limit - Muted”. The FM3 will stop processing audio but allow you to delete and/or
reconfigure the blocks as needed.

= |n regards to the CAB block, an Axe-Fx Ill preset that has bank USER 2 selected will be changed to USER 1
as the FM3 does not have a User 2 bank. Also note, that only “Cab 1" and “Cab 2" selections from the Axe-
Fx Ill preset will be imported as the FM3 only has two selectable cabinets.

What about presets from the Axe-Fx Il, AX8 or FX8?

No, these presets are not cross-compatible, but you can generally transfer parameter settings
by hand with good results. As of this writing, all of the same amp models are present, and
“factory” speaker cabs of the older products are present in the “Legacy” bank on the FM3.

Q: My expression pedal isn't working. What should | do?

>

=R =R

Expression pedals need to be calibrated and assigned to a parameter, controller or remote function. See
“Expression Pedals” on p. 12 for a basic overview. Are you using a TRS cable? Is it connected to the correct
port on the FM3? Is it actually an expression pedal? Did you set up a Modifier as described in Section 9?

My FM3 won't start up correctly.
Please see “Recovery” on p. 113.

My FM3 seems quiet at default settings.

By default, analog outputs 1 is set to -10dBV. To change to +4dBu, use the Output
Level parameters for Out 1 on the Audio page of the I/0 menu under SETUP.
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Can | use a computer or external MIDI controller to remote control the FM3?

The FM3 has a rich MIDI spec which allows it to be remote controlled. Any 3rd party MIDI
controller can be used, but please note that an FC-6 or FC-12 connected via FASLINK offers many
advantages over traditional 5-pin MIDI. The FM3 is not a computer USB MIDI Interface. A third-
party MIDI interface is required for a DAW or other computer application to control the FM3.

I'm hearing click and pops.

First, check all cables. You'd be surprised by how often a short can be found in a brand new or trusted cable.
Then, check to see whether you are clipping the FM3 inputs or outputs (p. 7).

Excessive CPU usage may also be to blame. Is the CPU meter at or near 80%? If so, you've overloaded

the current preset. Try removing one block and review “Preset CPU Limits” on p. 50 for useful tips.

One or more of my presets produces no sound.
This might be any one (or several) of a number of things.

= Are the top panel OUT level knobs turned up?

= |s every other component in your rig working correctly? Most of the time, the problem is a faulty or
disconnected cable. Checking the FM3 with headphones can help rule out this possibility.

= Does the preset rely on a user cab that isn’t loaded? Check the cab block and try a factory cab.

= |f your preset complete? Make sure it has a complete path from the input to the output with no breaks. Try
a different preset.

= Are you using the correct output block or settings? By default, the FM3 factory presets are set to use Out 1
L/R. If you want to use Out 2 at the same time, or only Out 2, see the notes on “Front-Of-House + Personal
FRFR Monitor” on p. 34

= |s there a Modifier assigned to a volume or level set to a pedal or switch that’s either not present or
different from the one you normally use. Check the modifier or change the INITIAL VALUE for a missing

external controller from 0% to 100% (see “MIDI/Remote: General Page” on p. 105).

Why would | place certain effects before or after an Amp and Cab?

Sonically speaking, the main reason to care about effect placement is that a given
effect will sound different when placed before or after distortion.

How does this difference sound? If you've ever switched the sequence of traditional drive and wah pedals,
you've heard an excellent example. In the case of wah before overdrive, the resonant filter of the wah
“excites” the overdrive in a cool way while still retaining a natural overall tone. When the wah follows
distortion, you might hear a more dramatic sweep that almost sounds synth-like and might be considered
less “classic.” It's not surprising then that wah would traditionally be a run as a “pre” effect between
guitar and amp. The amp’s distortion follows the wah. Many other effects fall in this same category.

A different example is found in overdrive with reverb or delay. In the natural world, reverb and echo occur
because of open spaces around your guitar amp - like a club or concert hall. These effects would therefore
NOT be heard before a distorted amp, but after it. Recording studios often add these kinds of effects “post”,
i.e. at the console—after the mic has picked up the distorted sound from the guitar amp. If you wanted

to simulate this natural sounding reverb or delay these effects would likely be run “post.” This is not to

say that delay or reverb before distortion is a “no-no.” Many “legendary” tones came from echo units in
front of an amp—but this is very different from “post” delay, both tonally, but also in terms of dynamics.

The good news is that the FM3 allows you to experiment easily and find what combinations
of pre- and post-effects work best for you. Creativity begins where conformity ends.

Anything else | should know?
The Layouts and Footswitches section includes its own FAQ. Check out the “EM3 Footswitch FAQ” on p. 90
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SHORTCUTS

The FM3 has several shortcuts and hidden features. These are summarized below.

IN GENERAL

= Press EDIT to jump to the Edit menu for the currently selected
block. Press repeatedly to step through all blocks.

ON THE HOME PAGE
= Press ENTER to show the Layout Grid for the current preset.
= Use NAV LEFT/RIGHT to select presets and press NAV UP/DOWN or turn knob A to select scenes.

* Double tap A to jump to editing the Amp
Double tap B to jump to editing Driive 1 (think “boost”)
Double tap C to jump to editing the Cab
Double tap D to jump to editing Delay 1
Double tap E to jump to editing Reverb (“think reeeverb”

IN THE AMP BLOCK
= Onthe Output EQ page, press ENTER to flatten the EQ.
»  Onthe Output EQ page, press NAV UP/DOWN to change the number of bands.

IN THE CAB BLOCK
= NAV to the Cab Number field and press ENTER to enter the Cab Picker for the selected.

ON THE GRID

= With any block selected, press-and-hold ENTER to create a series of shunts and cables to bridge
empty space to the right. This will also CLEAR existing connectors between a series of blocks.

TO OPEN THE CONTROLLERS MENU
= Press the TEMPO button once.

ON THE SEQUENCER PAGE OF THE CONTROLLERS MENU

=  With any Stage selected, press ENTER to randomize the values of all stages.

—
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SPILLOVER

Spillover allows delay and reverb tails to “ring out” when an effect is bypassed or when you change channels,
scenes, or presets. This section covers how to set up spillover in different scenarios.

WHEN BYPASSING AN EFFECT...

Effect block spillover is easy and requires only a particular setting in the block. For tails to ring out when an
individual block is bypassed, set that block’s Bypass Mode to “MUTE FX IN”. If an effect is running in parallel, use
“MUTE IN" instead. Be aware that different channels share effect memory, so changes to delay time, reverb size,
etc, may cause a “sweep” in the tail.

WHEN SWITCHING SCENES...

Switching Scenes provides one of the best ways for sound changes to have perfect spillover. Since Scenes simply
bypass or engage blocks one-by-one or in groups, just refer to the instructions above for all blocks in your preset.

WHEN CHANGING PRESETS...

Spillover across different presets is a bit more involved. The first step is to open the SETUP: Global Settings:
Config and set the Spillover parameter to determine whether “DELAY”, “REVERB", or “BOTH" will spill over when
you change presets. This setting is OFF by default.

You must also ensure that the same Delay or Reverb blocks exist in each of your presets where you want spillover.
These need to be the same block and the same number (i.e. Delay 1 spills over only through Delay 1, Delay 2
through Delay 2, etc.).

For spillover to work perfectly, the blocks must also have similar settings and placement on the grid. The moment
you change to a new preset, the parameter settings can change. For example, if you change from a preset where
Delay 1 has a time of 500 ms to a preset where Delay 1 time is 100 ms, the tails will suddenly be heard as 100

ms echoes instead. You would likewise hear a difference in the tail, for instance, if that delay was placed after a
clean amp block in one preset, and before an overdriven amp block in another! Bypass states and Bypass Mode
settings must also be considered.

For a simple preset spillover experiment, create a preset, then save an exact copy to a new location and
test spillover. Then begin making changes as needed to settings outside of those blocks that you want
to spill over. FM3-Edit also makes it easy to copy and paste a block from one preset to another.

—
(Ob]



14 ADDITIONAL TOPICS

SENDING AND RECEIVING MIDI

MIDI Messages are received at the MIDI In port and transmitted at the MIDI OUT/THRU port of the FM3. Use 5-pin
MIDI cables between the FM3 and the MIDI ports of other devices.

RECEIVING MIDI

The FM3 responds to MIDI Program Change Messages, MIDI CC messages — which can be used for a wide variety
of purposes including Scene Select, Effect Bypass/Engage, Modifier Control, and more — and will sync internal
tempo to MIDI clock messages for use with delay time, LFO rates, etc.

The FM3 is NOT a USB MIDI Device. It uses COM ports over USB for Fractal-Bot and FM3-Edit, and will not appear
as a MIDI device in a DAW or other MIDI program.

MIDI THRU

The FM3 MIDI Qut port also features a soft “MIDI Thru” capability. This merges any data received at the MIDI In
port with any generated MIDI messages at the MIDI Out port. This option must be enabled. See “MIDI/Remote:

General Page” on p. 105

SEND MIDI PC

The simplest MIDI capability of the FM3 is transmitting a single MIDI program change message (“PC”) each
time a new Preset is loaded—whether via the front panel, using an FC Footswitch, or in any other way. To enable
this, open the SETUP | MIDI/Remote menu and page to the “General” tab. Set Send MIDI PC to the desired MIDI
channel.

THE SCENE MIDI BLOCK

A more sophisticated MIDI tool is the Scene MIDI Block. Once you place this block on the grid, it transmits MIDI
messages automatically whenever a new scene is loaded—whether via the front panel, with a footswitch, or by
any other means. The Scene MIDI block can transmit up to eight total custom PC or CC messages. Remember
that a “default scene” loads automatically when you select a new preset, so any FC footswitch that selects a new
Preset or a new Scene can also cause the FM3 to send a burst of MIDI messages. See the “The Fractal Audio
Blocks Guide” for more on the Scene MIDI Block.

—
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CONTROL SWITCH MIDI

Another way for the FM3 to transmit MIDI messages using Control Switches. The primary function of a Control
Switch is to operate as a Modifier source to control FM3 parameters. Beyond this, however, each of the six
Control Switches has the capability to transmit a custom “payload” of MIDI data every time the switch is turned on
ON or OFF. Because this isn't tied to another event such as a Preset or Scene change, Control Switch MIDI is more
flexible and dynamic.

Because Control Switches can be momentary or latching (and even mutually exclusive), the CS MIDI system
is very versatile. You might change a connected MIDI-controlled amp, operate a remote processor, control a
sequencer, switch a lighting system, and more.

Here is a summary of the MIDI Capabilities of a Control Switch:
» The Control Switch function can be placed in any FC Layout.

» Control Switches 1-6 appear in the list of Modifier sources on the FM3. The role of a switch as
a modifier source is not compromised if you also use it to transmit MIDI. The same switch can
simultaneously control the FM3 and a connected device. See Section 9: Modifiers to learn more.

» Each Control Switch has its own global MIDI Payload containing up to four Program
Change (“PC") or Control Change (“CC) messages on any MIDI Channels, with custom
values from 0-127, or disabled (“-") for both the ON and OFF states of the switch.

» Each MIDI Payload also has a “master switch” allowing it to be enabled or disabled.

SETTING UP THE MIDI PAYLOAD FOR A CONTROL SWITCH:

» Open the SETUP | FC Controllers/External Switches menu and page to the “CS MIDI" tab.
» Use NAV buttons and the VALUE wheel to get around the page.

» Select the desired control switch at the top of the menu. (CS1, CS2, etc.)

» Make sure ENABLED is set to “YES” if you want the switch to send MIDI.

» NAV through the table and create your desired MIDI Payload of up to
four commands, with different values for ON and OFF

= For each command, select whether you want a Program Change (PC) or Control Change (CC) message.
Set the MIDI Channel for that command as desired from 1-16.

If you chose a CC Command, set the CC Number.

Set the desired Values for when the switch is ON and when it is OFF.

You can select values from 0-127, or “-" which means “send nothing.”

» There is no need to save CS MIDI settings. They take effect immediately.

See the “The Footswitch Functions Guide” for more on Control Switches.

@ Remember, Control Switches can be switched manually using a footswitch, or automatically by Scenes.
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MIDI REFERENCE TABLES

MIDI BANK & PROGRAM CHANGE

The following table lists the MIDI Bank and Program Change messages required to select FM3 presets.
MIDI Bank Select (CC#0) Value , Midi Program Change = FM3 Preset Number.

0,0 =0 0,42 = 42 0,84 = 84 0,126 = 126 1,40 = 168
0,1 =1 0,43 = 43 0,85 = 85 0,127 = 127 1,41 = 169
0,2 =2 0,44 = 44 0,86 = 86 1,0 = 128 1,42 = 170
0,3 =3 0,45 = 45 0,87 = 87 1,1 =129 1,43 = 17
0,4 =4 0,46 = 46 0,88 = 88 1,2 = 130 1,44 = 172
0,5 =5 0,47 = 47 0,89 = 89 1,3 = 131 1,45 = 173
0,6 =6 0,48 = 48 0,90 = 90 1,4 = 132 1,46 = 174
07 =17 0,49 = 49 0,91 = 9 1,5 = 133 1,47 = 175
0,8 =38 0,50 = 50 0,92 = 92 1,6 = 134 1,48 = 176
0,9 =9 0,51 = 51 0,93 = 93 1,7 =135 1,49 = 177
0,170 = 10 0,52 = 52 0,94 = 94 1,8 = 136 1,50 = 178
0,11 =M 0,53 = 53 0,95 = 95 1,9 = 137 1,51 = 179
0,12 = 12 0,54 = 54 0,96 = 96 1,10 = 138 1,52 = 180
0,13 = 13 0,55 = 55 0,97 = 97 1,11 = 139 1,53 = 181
0,14 = 14 0,56 = 56 0,98 = 98 1,12 = 140 1,54 = 182
0,15 = 15 0,57 = 57 0,99 = 99 1,13 = 1M 1,55 = 183
0,16 = 16 0,58 = 58 0,700 = 100 1,14 = 142 1,56 = 184
0,177 = 17 0,59 = 59 0,101 = 101 1,15 = 143 1,57 = 185
0,18 = 18 0,60 = 60 0,102 = 102 1,16 = 144 1,58 = 186
0,19 =19 0,61 = 61 0,703 = 103 1,17 = 145 1,59 = 187
0,20 = 20 0,62 = 62 0,104 = 104 1,18 = 146 1,60 = 188
0,21 = 21 0,63 = 63 0,105 = 105 1,19 = 147 1,61 = 189
0,22 = 22 0,64 = 64 0,706 = 106 1,20 = 148 1,62 = 190
0,23 = 23 0,65 = 65 0,107 = 107 1,21 = 149 1,63 = 191
0,24 = 24 0,66 = 66 0,108 = 108 1,22 = 150 1,64 = 192
0,25 = 25 0,67 = 67 0,709 = 109 1,23 = 151 1,65 = 193
0,26 = 26 0,68 = 68 0,110 = 110 1,24 = 152 1,66 = 194
0,27 = 27 0,69 = 69 0,111 = 111 1,25 = 153 1,67 = 195
0,28 = 28 0,70 = 70 0,112 = 112 1,26 = 154 1,68 = 196
0,29 = 29 0,71 =T 0,113 = 113 1,27 = 155 1,69 = 197
0,30 = 30 0,72 = 72 0,114 = 114 1,28 = 156 1,70 = 198
0,31 = 31 0,73 =73 0,115 = 115 1,29 = 157 1,71 = 199
0,32 = 32 0,74 = 74 0,116 = 116 1,30 = 158 1,72 = 200
0,33 = 33 0,75 =75 0,117 = 117 1,31 = 159 1,73 = 201
0,34 = 34 0,76 = 76 0,118 = 118 1,32 = 160 1,74 = 202
0,35 = 35 0,77 =77 0,119 = 119 1,33 = 161 1,75 = 203
0,36 = 36 0,78 = 78 0,120 = 120 1,34 = 162 1,76 = 204
0,37 = 37 0,79 =79 0,121 = 121 1,35 = 163 1,77 = 205
0,38 = 38 0,80 = 80 0,122 = 122 1,36 = 164 1,78 = 206
0,39 = 39 0,81 = 81 0,123 = 123 1,37 = 165 1,79 = 207
0,40 = 40 0,82 = 82 0,124 = 124 1,38 = 166 1,80 = 208
0,41 = 41 0,83 = 83 0,125 = 125 1,39 = 167 1,81 = 209
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1,82 = 210 2,6 = 262 2,58 = 314 2,110 = 366 3,34 = 418 3,86 = 470
1,83 = 21 2,7 = 263 2,59 = 315 2,111 = 367 3,35 = 419 3,87 = 471
1,84 = 212 2,8 = 264 2,60 = 316 2,112 = 368 3,36 = 420 3,88 = 472
1,8 = 213 2,9 = 265 2,61 = 317 2,113 = 369 3,37 = 421 3,80 = 473
1,86 = 214 2,10 = 266 2,62 = 318 2,114 = 370 3,38 = 422 3,90 = 474
1,87 = 215 2,11 = 267 2,63 = 319 2,115 = 371 3,39 = 423 3,91 = 475
1,88 = 216 2,12 = 268 2,64 = 320 2,116 = 372 3,40 = 424 3,92 = 476
1,8 = 217 2,13 = 269 2,65 = 321 2,117 = 373 3,41 = 425 3,93 = 477
1,90 = 218 2,14 = 270 2,66 = 322 2,118 = 374 3,42 = 426 3,94 = 478
1,91 = 219 2,15 = 271 2,67 = 323 2,119 = 375 3,43 = 427 3,95 = 479
1,92 = 220 2,16 = 272 2,68 = 324 2,120 = 376 3,44 = 428 3,96 = 480
1,93 = 221 2,17 = 273 2,69 = 325 2,121 = 377 3,45 = 429 3,97 = 481
1,94 = 222 2,18 = 274 2,70 = 326 2,122 = 378 3,46 = 430 3,98 = 482
1,95 = 223 2,19 = 275 2,71 = 327 2,123 = 379 3,47 = 431 3,99 = 483
1,96 = 224 2,20 = 276 2,72 = 328 2,124 = 380 3,48 = 432 3,100 = 484
1,97 = 225 2,217 =271 2,73 = 329 2,125 = 381 3,49 = 433 3,101 = 485
1,98 = 226 2,22 = 278 2,74 = 330 2,126 = 382 3,50 = 434 3,102 = 486
1,99 = 227 2,23 =279 2,75 = 331 2,127 = 383 3,51 = 435 3,103 = 487
1,100 = 228 2,24 = 280 2,76 = 332 3,0 = 384 3,52 = 436 3,104 = 488
1,101 = 229 2,25 = 281 2,77 = 333 3,1 = 385 3,53 = 437 3,105 = 489
1,102 = 230 2,26 = 282 2,78 = 334 3,2 = 386 3,54 = 438 3,106 = 490
1,103 = 231 2,27 = 283 2,79 = 335 3,3 = 387 3,55 = 439 3,107 = 491

1,104 = 232 2,28 = 284 2,80 = 336 3,4 = 388 3,56 = 440 3,108 = 492
1,106 = 233 2,29 = 285 2,81 = 337 3,5 = 389 3,57 = 441 3,109 = 493
1,106 = 234 2,30 = 286 2,82 = 338 3,6 = 390 3,58 = 442 3,110 = 494
1,107 = 235 2,31 = 287 2,83 = 339 3,7 = 391 3,59 = 443 3,111 = 495
1,108 = 236 2,32 = 288 2,84 = 340 3,8 = 392 3,60 = 444 3,112 = 496
1,109 = 237 2,33 = 289 2,85 = 341 3,9 = 393 3,61 = 445 3,113 = 497
1,110 = 238 2,34 = 290 2,86 = 342 3,10 = 394 3,62 = 446 3,114 = 498
1,111 = 239 2,35 = 291 2,87 = 343 3,11 = 395 3,63 = 447 3,115 = 499
1,112 = 240 2,36 = 292 2,88 = 344 3,12 = 39 3,64 = 448 3,116 = 500
1,113 = 241 2,37 = 293 2,89 = 345 3,13 = 397 3,65 = 449 3,117 = 501
1,114 = 242 2,38 = 294 2,90 = 346 3,14 = 398 3,66 = 450 3,118 = 502
1,115 = 243 2,39 = 295 2,91 = 347 3,15 = 399 3,67 = 451 3,119 = 503
1,116 = 244 2,40 = 296 2,92 = 348 3,16 = 400 3,68 = 452 3,120 = 504
1,117 = 245 2,41 = 297 2,93 = 349 3,17 = 401 3,69 = 453 3,121 = 505
1,118 = 246 2,42 = 298 2,94 = 350 3,18 = 402 3,70 = 454 3,122 = 506
1,119 = 247 2,43 = 299 2,95 = 351 3,19 = 403 3,71 = 455 3,123 = 507
1,120 = 248 2,44 = 300 2,96 = 352 3,20 = 404 3,72 = 456 3,124 = 508
1,121 = 249 2,45 = 301 2,97 = 353 3,21 = 405 3,73 = 457 3,125 = 509
1,122 = 250 2,46 = 302 2,98 = 354 3,22 = 406 3,74 = 458 3,126 = 510
1,123 = 251 2,47 = 303 2,99 = 355 3,23 = 407 3,75 = 459 3,127 = 511
1,124 = 252 2,48 = 304 2,100 = 356 3,24 = 408 3,76 = 460

1,125 = 253 2,49 = 305 2,101 = 357 3,25 = 409 3,77 = 461

1,126 = 254 2,50 = 306 2,102 = 358 3,26 = 410 3,78 = 462

1,127 = 255 2,51 = 307 2,103 = 359 3,27 = 411 3,79 = 463

2,0 = 256 2,52 = 308 2,104 = 360 3,28 = 412 3,80 = 464

2,1 = 257 2,53 = 309 2,105 = 361 3,29 = 413 3,81 = 465
2,2 = 258 2,54 = 310 2,106 = 362 3,30 = 414 3,82 = 466
2,3 =259 2,55 = 311 2,107 = 363 3,31 = 415 3,83 = 467

2,4 = 260 2,56 = 312 2,108 = 364 3,32 = 416 3,84 = 468
2,5 = 261 2,57 = 313 2,109 = 365 3,33 = 417 3,85 = 469
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CC VALUE TO SCENE

When selecting Scenes using the global options found on the Other page of the MIDI/Remote menu under SETUP,
the value of the designated CC# determines the Scene:

0........ 1 16....... 1 32....... 1 48....... 1 64....... 1 80....... 1T 96....... 1T 1M2...... 1
T 2 17....... 2 33....... 2 49....... 2 65...... 2 81....... 2 97....... 2 1M3...... 2
2........ 3 18....... 3 34....... 3 50....... 3 66....... 3 82....... 3 98....... 3 114...... 3
3. 4 19....... 4 35....... 4 51....... 4 67....... 4 83....... 4 99....... 4 115...... 4
4........ 5 20....... 5 36....... 5 52....... 5 68....... 5 84....... 5 100...... 5 116...... 5
S5 ... 6 21....... 6 37....... 6 53....... 6 69....... 6 85...... 6 101...... 6 117...... 6
6........ 7 22....... 7 38....... 7 54....... 7 70....... 7 86....... 7 102...... 7 118...... 7
7.0 .. 8 23....... 8§ 39....... 8 55....... 8 T71....... 8 87....... 8§ 103...... 8 119...... 8
8........ 1T 24....... 1 40....... 1 56....... 1 72....... 1 88....... 1 104...... 1 120...... 1
9........ 2 25....... 2 4. 2 57....... 2 T73....... 2 89....... 2 105...... 2 121...... 2
10....... 3 26....... 3 42....... 3 58....... 3 T4....... 3 90....... 3 106...... 3 122...... 3
Mmoo 4 27....... 4 43....... 4 59....... 4  T75....... 4 91....... 4 107...... 4 123...... 4
12....... 5 28....... 5 44 ... 5 60....... 5 76....... 5 92....... 5 108...... 5 124...... 5
13....... 6 29....... 6 45....... 6 61....... 6 77....... 6 93....... 6 109...... 6 126...... 6
14....... 7 30....... 7 46....... 7 62....... 7 78....... 7 94....... 7 110...... 7 126...... 7
15....... 8 31....... 8 47....... 8 63....... 8 79....... 8 95...... 8 111...... 8 127...... 8
CC VALUE TO CHANNEL

When changing Channels using the global options found on the Channel page of the MIDI/Remote menu under
SETUP, the value of the designated CC# determines the Channel:

0........ A T6....... A 32....... A 48....... A 64...... A 80....... A 96....... A 112...... A
T B 17....... B 33...... B 49....... B 65....... B 81....... B 97....... B 113...... B
2. C 18....... C 34...... C 50....... C 66....... C 82....... C 98...... C 14...... C
3. D 19....... D 35...... D 51....... D 67....... D 83...... D 99....... D 15...... D
4........ A 20....... A 36....... A 52....... A 68....... A 84....... A 100...... A 116...... A
S B 21....... B 37....... B 583....... B 69....... B 85...... B 101...... B 117...... B
6........ C 22....... C 38...... C b54...... C 70....... C 86....... c 102..... C 18...... C
7........ D 23....... D 30....... D 55...... D 71....... D 87....... D 103...... D 119...... D
8........ A 24...... A 40....... A 56....... A T72....... A 88....... A 104...... A 120...... A
9........ B 25....... B 41....... B 57....... B 73....... B 89....... B 105...... B 121...... B
10....... C 26....... C 42....... C 58...... C 74...... C 90....... C 106...... C 122...... C
M. D 27....... D 43....... D 59....... D 75....... D 91....... D 107...... D 123...... D
12....... A 28....... A 44....... A 60....... A T76....... A 92....... A 108...... A 124...... A
13....... B 29....... B 45....... B 61....... B 77....... B 93....... B 109...... B 125...... B
14....... C 30....... C 46....... C 62....... C 78....... C 94...... C 110...... C 126...... C
15....... D 31....... D 47....... D 63....... D 79....... D 95....... D 11...... D 127...... D
138
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INSTRUMENT INPUTS

Connectors: Rear 1/4" phone jack, unbalanced, with “Secret Sauce”
Impedance: 1MQ
Max. Input Level: +16 dBu

ANALOG INPUT 2

Connectors: (2) 1/4" phone jack balanced (TRS)
Impedance: 1 MQ

Max. Input Level: +20 dBu

A/D CONVERSION

Bit Depth: 24 bits

Sample Rate: 48 kHz

Dynamic Range: 114 dB

Frequency Response:
Crosstalk:

20 - 20kHz,-0.01 to +0.01 dB
110dB (typ.) Interchannel Isolation

ANALOG OUTPUT 1
Connectors: (2) XLR balanced with Ground Lift
Selectable between -10 dBV and +4 dBu in software
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 2
Connectors: (2) 1/4" phone jack unbalanced (Humbuster™)
Impedance: 600 Q
Max Output Level: +20 dBu
HEADPHONE OUTPUT
Connector: 1/4" stereo phone jack
Impedance: 35Q
D/A CONVERSION
Dynamic Range: 114 dB

Frequency Response:

20 - 20kHz, +0 /-1 dB

DIGITAL OUTPUT

Connectors: RCA Coaxial Type for S/PDIF
Format: Uncompressed PCM

Sample Rate: 48 kHz fixed

USB AUDIO

Format: USB Audio Class 2.0 compliant
Channels: 4 input, 4 output

USB Audio Clock: 48 kHz fixed

MIDI INTERFACE

Input Connector: (1) 5-pin DIN

Out/Thru Connector: (1) 5-pin DIN

—
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PEDAL INTERFACE
Connectors: (2) 1/4" TRS phone jack
Format: Pedal: 10-100 kQ max
Tip-Ring Switch: make/break; momentary or latching
Sleeve-Ring Switch: make/break; momentary or latching
FASLINK Il INTERFACE
Connectors: (1) XLR-F
WARNING: Connect ONLY to the FASLINK Il connector on a Fractal Audio FC Series controller
GENERAL
Finish: Powder-coated steel chassis
Controls: 12 buttons, 8 knobs (5 with additional “push” functions)
Display: 800x480 high contrast color LCD
Dimensions: 11.1"W. x 4.05"H.x9.3"D.
281Tmm W. x 103mm H. x 236mm D.
Weight: 7 Ibs 1.6 0z (3.22 kg)
Input Voltage: 90-264 VAC, 47 - 63 Hz (universal input)
Power Consumption: <40 W
Backup Battery Life: >10 years
Backup Battery Type: CR-2032
Ventilation: Onboard fan with side and bottom venting. WARNING: Do not block vent holes!
ENVIRONMENTAL

Operating Temperature:

Storage Temperature:
Humidity:

320122 °F (0 to 50 °C)
-22't0 167 °F (-30to 70 °C)
Max. 90% non-condensing

e
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The FM3 features a robust MIDI implementation detailed below.

Function Tx Rx | Remarks
Basic Channel Default 1 1
Changed 1-16 | 1-16
Note Number True Voice X X
Velocity Note ON X X
Note OFF X X
After Touch Keys X X
Channels X X
Pitch Bend X X
Control Change 0 0 Receivable CCs are globally soft-assigned to
functions via the MIDI/Remote menu under SETUP.
These include Input and Output volumes, Tap Tempo,
Tuner, 16 “External Controllers” (assignable as
modifiers to one or more parameters on a per-preset
basis), some Scene functions, all Looper functions,
and all block BYPASS and CHANNEL switches.
MIDI CC Transmit is performed using the Scene MIDI
Block or Control Switch MIDI.
Program Change True Number 0 0 The FM3 can transmit PC messages upon preset
Bank Select X 0 | change, or via the Scene MIDI Block or Control
Switch MIDI.
System Exclusive Fractal Audio 0 0 | SysExis used extensively for FM3-Edit.
Real time 0 X
Non-Real time X X
System Common Song Position X X
Song Select X X
Tune Request X X
System Real time Clock X 0 FM3 Global Tempo syncs automatically to MIDI Beat
Commands X x | Clock. FM3 does not transmit MIDI clock.
Auxiliary Messages | Local ON/OFF X X
All Notes OFF X X
Active Sense X X
Reset X X
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WARRANTY

WARRANTY

Fractal Audio Systems warrants that your new Fractal Audio Systems product shall be free of defects in materials
and workmanship for a period of one (1) year from the original date of purchase.

During the warranty period, Fractal Audio Systems shall, at its sole option, either repair or replace any product that
proves to be defective upon inspection by Fractal Audio Systems.

Fractal Audio Systems reserves the right to update any unit returned for repair and to change or improve the
design of the product at any time without notice. Fractal Audio Systems reserves the right to use reconditioned
parts and assemblies as warranty replacements for authorized repairs. This warranty is extended to the original
retail purchaser for units purchased directly from Fractal Audio Systems or one of its authorized distributors or
resellers.

This is your sole warranty. Fractal Audio Systems does not authorize any third party, including any dealer or sales
representative, to assume any liability on behalf of Fractal Audio Systems or to make any warranty for Fractal
Audio Systems. Fractal Audio Systems may, at its option, require proof of original purchase date in the form of a
dated copy of original authorized dealer’s invoice or sales receipt. Service and repairs of Fractal Audio Systems
products are to be performed only at the Fractal Audio Systems factory or a Fractal Audio Systems authorized
service center. Fractal Audio Systems may require advanced authorization of repairs to authorized service
centers. Unauthorized service, repair or modification will void this warranty.

DISCLAIMER AND LIMITATION OF WARRANTY

THE FOREGOING WARRANTY IS THE ONLY WARRANTY GIVEN BY FRACTAL AUDIO SYSTEMS AND IS IN LIEU OF
ALL OTHER WARRANTIES. ALL IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR ANY PARTICULAR PURPOSE, EXCEEDING THE SPECIFIC PROVISIONS OF THIS WARRANTY ARE
HEREBY DISCLAIMED AND EXCLUDED FROM THIS WARRANTY. UPON EXPIRATION OF THE APPLICABLE EXPRESS
WARRANTY PERIOD (1 YEAR), FRACTAL AUDIO SYSTEMS SHALL HAVE NO FURTHER WARRANTY OBLIGATION OF
ANY KIND, EXPRESS OR IMPLIED. FRACTAL AUDIO SYSTEMS SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES SUFFERED BY THE PURCHASER OR ANY THIRD PARTY, INCLUDING
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS OR BUSINESS, OR DAMAGES RESULTING FROM USE OR
PERFORMANCE OF THE PRODUCT, WHETHER IN CONTRACT OR IN TORT. FRACTAL AUDIO SYSTEMS SHALL NOT
BE LIABLE FOR ANY EXPENSES, CLAIMS, OR SUITS ARISING OUT OF OR RELATING TO ANY OF THE FOREGOING.
Some states do not allow the exclusion or limitation of implied warranties so some of the above limitations and
exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights,
which vary, from state to state. This warranty only applies to products sold and used in the USA and Canada.
Fractal Audio Systems shall not be liable for damages or loss resulting from the negligent or intentional acts of
the shipper or its contracted affiliates. You should contact the shipper for proper claims procedures in the event
of damage or loss resulting from shipment.
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EULA

EULA

BY ACCEPTING, INSTALLING OR USING ANY PART OF THIS PRODUCT YOU ARE CONSENTING TO ALL OF THE TERMS AND CONDITIONS OF THIS ENTIRE END USER LICENSE AGREEMENT (“EULA"). IF YOU
DO NOT AGREE TO ALL THE TERMS AND CONDITIONS OF THIS ENTIRE AGREEMENT, ARE UNABLE OR UNWILLING COMPLY WITH THESE TERMS AND CONDITIONS, YOU MUST DISCONTINUE USE OF THE
PRODUCT IMMEDIATELY AS YOU HAVE NO AUTHORITY OR LICENSE TO USE THE PRODUCT.

TERMS AND CONDITIONS
1) GRANT OF LICENSE FOR PRE INSTALLED OR USER UPGRADED FIRMWARE (“THE SOFTWARE")

Subject to the terms and conditions set forth herein, Fractal Audio Systems, (“FAS”) grants you an individual, personal, non-sub licensable, nonexclusive license to use this product in accordance with the
applicable end user documentation, if any (the “License”). The user will not, directly or indirectly, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code or underlying
ideas or algorithms of the Software; modify, translate, or create derivative works based on the Software; or copy (except for archival purposes), rent, lease, distribute, assign, or otherwise transfer rights to the
Software (except as expressly authorized by this Agreement); remove any proprietary notices, comments, terms and conditions and or labels on or in the Software. As between the parties, you acknowledge
that FAS and its licensors retain their respective ownership of the Software, any portions or copies thereof, and all rights therein throughout the world. Upon termination of this Agreement for any reason, the
License and all rights granted to you under this Agreement will terminate and you will cease to use the Software. You may permanently transfer the limited rights of use of the Software granted to you under
this Agreement only as part of a permanent sale or transfer of the hardware device containing the software, and only if the recipient agrees to be bound by the terms and conditions of this Agreement. You
acknowledge that you have no rights in or to, and may not transfer or otherwise authorize the use of, any “beta” or “preview” software of FAS and its licensors. THIS LIMITED LICENSE TO USE AND TRANSFER
THE SOFTWARE IS PROVIDED AS-IS AND IS SUBJECT TO THE RESTRICTIONS, INDEMNITY AND WARRANTY DISCLAIMERS AND LIMITATIONS OF LIABILITY SET FORTH BELOW.

2) RESTRICTIONS, WARRANTY DISCLAIMERS AND INDEMNITY OBLIGATION AGREED TO BY YOU IN EXCHANGE FOR LIMITED GRANT OF LICENSE.

YOU WILL ONLY USE THE SOFTWARE FOR LAWFUL PURPOSES AND IN COMPLIANCE WITH ALL APPLICABLE LAWS. YOU HEREBY AGREE TO DEFEND AND INDEMNIFY FAS AND ITS LICENSORS AGAINST ANY
CLAIM OR ACTION THAT ARISES FROM YOUR USE OF THE SOFTWARE IN AN UNLAWFUL MANNER (INCLUDING, WITHOUT LIMITATION, ANY CLAIM OR ACTION ALLEGING INFRINGEMENT OF ANY PATENT,
COPYRIGHT, TRADEMARK, TRADE SECRET, OR OTHER INTELLECTUAL PROPERTY; UNFAIR COMPETITION; VIOLATION OF GENERAL BUSINESS LAWS; OR VIOLATION OF ANY OTHER LAWS OR RIGHTS) OR ANY
OTHER USE OF THE SOFTWARE NOT EXPRESSLY AUTHORIZED PURSUANT TO THIS AGREEMENT.

3) IMPULSE RESPONSE EXPORT FOR COMMERCIAL USE

Offering for sale any Impulse Response data (e.g. “Tone Match Export/Save/Dump”, “User Cab Export/Save/Dump”) created, converted or modified using Fractal Audio Systems hardware and/or software
requires a commercial use license. Recording studios, consultants, and other commercial entities may use these features in conjunction with work performed for their commercial customers, but the resulting
data files created may not be offered for sale or gifted to their commercial customers or other third parties without a commercial license from FAS and its licensors where applicable. Contact sales@
fractalaudio.com to obtain a commercial license.

4) IMPULSE RESPONSE DATA EXPORT FOR NON-COMMERCIAL USE

You are free to export Impulse Response data for non-commercial use. This includes producing, converting, or modifying Impulse Response data for yourself, or offering/distributing such data at no charge to
third parties. Files created without a commercial license cannot be included for free with another product or package that is offered for sale. Contact sales@fractalaudio.com to obtain a commercial license.

5) SUPPORT

Subject to the terms hereof, FAS will provide you with e-mail support services for the Software. Under no circumstances will FAS have any obligation to provide you with hard-copy documentation, upgrades,
enhancements, modifications, or telephone support for the Software.

6) TERMINATION

This Agreement is effective until terminated. Either party may terminate this Agreement upon written notice to the other party. FAS may also terminate this Agreement immediately, without prior notice or
liability, if you breach any of the terms or conditions of this Agreement. All sections of this Agreement which by their nature should survive termination will survive termination, including, without limitation,
warranty disclaimers and limitations of liability and limitations of use and transfer of the Software.

7) WARRANTY DISCLAIMER

The software is provided as is without warranty of any kind. FAS disclaim all warranties, expressed or implied, including but not limited to implied warranties, fitness for a particular purpose, and non-
infringement. Some states do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

8) LIMITATION OF LIABILITY

NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT OR OTHERWISE, YOU AGREE THAT FAS AND ITS LICENSORS WILL NOT BE LIABLE WITH RESPECT TO THE SUBJECT MATTER OF THIS
AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY, INFRINGEMENT OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE
DAMAGES OF ANY KIND. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE MAY NOT APPLY TO YOU.

9) EXPORT RESTRICTIONS

You acknowledge that the Software, or any part thereof, or any process or service that is the direct product of the Software (the foregoing collectively referred to as the “Restricted Components”) are of U.S.
origin. You agree to comply with all applicable international and national laws that apply to these products, including the U.S. Export Administration Regulations, as well as end-user, end-use and destination
restrictions issued by U.S. and other governments.

10) MISCELLANEOUS

The failure of either party to exercise in any respect any right provided for herein will not be deemed a waiver of any further rights hereunder of FAS and or its licensors. If any provision of this Agreement

is found to be unenforceable or invalid, that provision will be limited or eliminated to the minimum extent necessary so that this Agreement will otherwise remain in full force and effect and enforceable.

This Agreement will be governed by and construed in accordance with the laws of the state of New Hampshire without regard to the conflict of laws provisions thereof. You agree that this Agreement is the
complete and exclusive statement of the mutual understanding of the parties and supersedes and cancels all previous written and oral agreements, communications and other understandings relating to the
subject matter of this Agreement, and that all modifications to this EULA, or any commercial license that you may have obtained from FAS and or its licensors must be in a writing signed by you, FAS and or its
licensors, where applicable, except as otherwise provided herein. No agency, partnership, joint venture, or employment is created as a result of this Agreement and you do not have any authority of any kind to
bind FAS and or its licensors in any respect whatsoever. In any action or proceeding to enforce rights under this Agreement, the prevailing party will be entitled to recover costs and attorneys’ fees. All notices
under this Agreement will be in writing and will be deemed to have been duly given when received, if personally delivered; when receipt is electronically confirmed, if transmitted by facsimile or e-mail; the day
after it is sent, if sent for next day delivery by recognized overnight delivery service; and upon receipt, if sent by certified or registered mail, return receipt requested.
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